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KATA PENGANTAR

Kurikulum 2013 dirancang untuk memperkuat kompetensi peserta didik dari sisi
pengetahuan, keterampilan, dan sikap secara utuh. Keutuhan tersebut menjadi
dasar dalam perumusan kompetensi dasar tiap mata pelajaran, sehingga
kompetensi dasar tiap mata pelajaran mencakup kompetensi dasar kelompok
sikap, kompetensi dasar kelompok pengetahuan, dan kompetensi dasar kelompok
keterampilan. Semua mata pelajaran dirancang mengikuti rumusan tersebut.

Pembelajaran Dasar-dasar Perbankan untuk Kelas X jenjang SMK Program
Keahlian Keuangan yang disajikan dalam buku ini juga tunduk pada ketentuan
tersebut. Dasar-dasar Perbankan bukan berisi materi pembelajaran yang
dirancang hanya untuk mengasah kompetensi pengetahuan peserta didik. Dasar-
dasar Perbankan adalah mata pelajaran yang membekali peserta didik dengan
pengetahuan tentang dunia perbankan di Indonesia, keterampilan dalam
menyajikan pengetahuan yang dikuasainya secara konkret dan abstrak, serta
dunia perbankan sebagai usaha berdasarkan kepercayaan masyarakat menuntut
sikap hemat, cermat, disiplin dan jujur. Sehingga dengan belajar dasar-dasar
perbankan diharapkan terbentuk pola pikir peserta didik yang hemat, cermat,
disiplin dan jujur.
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Akun (account)
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GLOSARIUM

Disebut juga rekening atau perkiraan adalah
formulir untuk mencatat secara indivual tentang
penambahan atau pengurangan tiap jenis harta,
kewajiban, dan ekuitas.

Account
Receivable (Trade
Debtor)

Account Payable
(Trade Creditor)

Akuntansi

Aplikasi Komputer
Akuntansi

Asset

Bagan akun (chart
of account)
Balance Sheet
Building

Buku besar
(ledger)

Cash Flow
Statement

Cash on Hand
Card File

Cheque Book

Current Asset

Current Liabilities

Piutang Dagang, yaitu tagihan kepada para
pelanggan karena adanya trasaksi penjualan

Utang Dagang, yaitu kewajiban perusahaan yang
harus dibayar perusahaan karena danya transaksi
pembelian.

Suatu proses yang meliputi kegiatan
pengidentifikasian, pencatatan, pengikhtisaran dan
pelaporan data keuangan.

Program terintegrasi yang disusun untuk penerapan
sistem komputerisasi di bidang akuntansi.

Aset atau Aktiva, yaitu seluruh kekayaan yang
dimiliki oleh perusahaan

Daftar akun dan nomor kodenya yang
mengidentifikasi tempatnya dalam buku besar.
Neraca, yaitu merupakan salah satu laporan

keuangan yang memberikan informasi mengenai
aset, kewajiban dan ekuitas.

Gedung (Bangunan), yaitu salah satu aset tetap
yang dimiliki oleh perusahaan.

Buku yang berisi akun-akun harta, kewajiban, dan
ekuitas atau kumpulan dari kartu-kartu akun.
Laporan Arus Kas, vyaitu salah satu laporan
keuangan yang memberikan informasi tentang
aliran kas masuk dan kas keluar dari kegiatan
operasi, investasi dan pendanaan.

Jumlah kas yang dimiliki oleh perusahaan.

File Kartu, yaitu kartu untuk mencatat informasi
setiap pelanggan dan pemasok (Customers and
Suppliers)

Buku Cek, kumpulan cek yang siap untuk diisi dan
digunakan untuk pembayaran.

Aktiva Lancar, vyaitu kelompok aset yang
perputarannya dalam jangka pendek (kurang dari
satu tahun).

Kewajiban Lancar (Utang Lancar), yaitu salah satu
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Command Centre
Account

Command Centre
Banking

Command Centre
Sales

Command Centre
Purchases

Command Centre
Inventory

Command Centre
Card

Debit
Deposit paid

Double entry
system

Electric Expense
Equipment
Equity
Expenses

Fixed Asset

bentuk kewajiban yang harus dituaikan dalam waktu
satu tahun atau kurang.

Pusat kendali pada MYOB yang berfungsi untuk
pembuatan daftar akun, pencatatan saldo awal
buku besar, pembuatan jurnal umum, posting dan
laporan keuangan.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat penerimaan uang yang bukan bersumber
dari pelunasan piutang dan pengeluaran cek yang
bukan untuk pembayaran utang.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat, menampilkan/mencetak transaksi
penjualan, retur penjualan dan pelunasan piutang
serta menyajikan laporan yang berhubungan
dengan penjualan, misalnya rekap penjualan per
item atau per costumer, analisis piutang dan
sebagainya.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat, menampilkan/mencetak transaksi
pembelian, retur pembelian dan pembayaran utang
serta menyajikan laporan yang berhubungan
dengan pembelian, misalnya rekap pembelian per
item atau per supplier.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat item barang yang dibeli untuk dijual,
penggabungan komponen menjadi satu unit barang
baru atau sebaliknya, menyajikan laporan yang
berkaitan dengan persediaan.

Pusat kendali pada MYOB yang berfungsi untuk
mencatat data pelanggan (customer) dan pemasok
(supplier) baik yang berkaiatan dengan nama,
alamat, saldo awal piutang, utang, dan informasi
lainnya.

Sisi sebelah kiri suatu akun.

Uang Muka atau uang panjar yang dibayarkan
kepada supplier

Sistem pencatatan dari efek ganda (dual effect) dari
tiap transaksi secara tepat.

Beban Listrik

Peralatan, salah satu jenis aset tetap.

Ekuitas atau modal

Beban-beban operasi atau non operasi perusahaan.
Aktiva Tetap, yaitu aset yang umurn pemakaiannya

Xii
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Furniture
General Ledger

General Journal
Entry

Income
Interest Expense
Interest Revenue

Jurnal

Jurnal umum
Kredit (credit)
Laporan Keuangan
Liability

MYOB

Neraca saldo (trial
balance)

Motor vehicle
Office supplies

Other Expense
Payroll Check

Periode Akuntansi

Perusahaan Jasa

Komputer Akuntansi Jilid 1

lebih dari satu tahun.

Meubel, yaitu termasuk salah satu jenis aset tetap
perusahaan.

Buku Besar, yaitu kumpulan akun-akun.
Formulir untuk mencatat Jurnal Umum

Penghasilan (Pendapatan)

Beban Bunga, yaitu beban non operasi perusahaan
Pendapatan Bunga, salah satu pendapatan yang
termasuk dalam non operasi

Buku catatan akuntansi yang digunakan untuk
mencatat transaksi-transaksi keuangan yang terjadi
setiap hari.

Bentuk jurnal yang paling umum dipakai untuk
mencatat semua jenis transaksi.

Sisi kanan suatu akun.

Merupakan ringkasan
keuangan yang terjadi
akuntansi tertentu
Kewajiban, yaitu sesuatu yang harus ditunaikan
perusahaan.

Salah satu aplikasi komputer akuntansi yang dibuat
oleh salah satu perusahaan di Australia yang
merupakan singkatan dari Mind on Your Own
Business.

Daftar akun-akun buku-buku dan saldo-saldonya
pada saat tertentu.

dari transaksi-transaksi
selama satu periode

Kendaraan Bermotor, yaitu salah satu jenis aset
tetap

Suplies Kantor atau Bahan Habis Pakai (BHP)
Beban lain-lain di luar opersai perusahaan.

Cek Gaiji, yaitu cek yang khusus untuk pembayaran
gaji.

Rentangan waktu akuntansi yang dimulai pada saat
pembuatan neraca awal sampai dengan saat
pembuatan laporan keuangan, biasanya selama
satu tahun.

Entitas bisnis yang usaha pokoknya memperoleh
pendapatan dengan memberikan layanan jasa

Direktorat Pembinaan SMK (2013)
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Posting

Profit and Loss
Report

Provision for
doubtful debt

Telephone
Expense

Transaksi
Keuangan
Transaction
Journal

Trial Balance
Other Income

Rent Expense
Retained Earning
Salaries and Wage

Expenses
Water Expense

Prosedur memasukkan/memindahkan data dari
jurnal ke buku besar.

Laporan Laba Rugi, salah satu jenis laporan yang
memberikan  informasi  tentang  pendapatan
dibandingkan dengan beban-beban perusahaan.
Cadangan kerugian piutang, dana yang disediakan
untuk menutup kerugian akibat piutang yang tidak
tertagih.

Beban Telepon, yaitu pembayaran tagihan rekening
telkom.

Kegiatan  ekonomis yang dilakukan oleh
perusahaan yang secara financial berdampak pada
perubahan posisi keuangannya.

Jurnal Transaksi, yaitu catatan hasil pemrosesan
jurnal transaksi keuangan tertentu.

Neraca Saldo, yaitu selisih antara jumlah debit dan
jumlah kredit akun-akun yang ada dalanm buku
besar.

Penghasilan Lain-lain di luar wusaha pokok
perusahaan.
Beban Sewa, yaitu pembayaran sewa

gedung/peralatan.

Laba Ditahan, yaitu sebagian laba yang tidak
dibagikan kepada pemilik perusahaan.

Beban Gaji dan Upah, yaitu pembayaran gaji/upah
pegawai bulanan.

Beban air, yaitu pembayaran tagihan rekening PAM

Xiv
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BAB |
PENDAHULUAN

[ A. Deskripsi ]
Perkembangan teknologi komputer telah memicu lembaga bisnis untuk

menerapkan sistem informasi di segala bidang, termasuk bidang akuntansi.
Penerapan komputer di bidang akuntansi ini semakin luas berkembang
dikarenakan banyaknya software aplikasi komputer akuntansi yang tersedia di
masyarakat. Justru permasalahan pokok yang dihadapi oleh lembaga bisnis
adalah kurang tersedianya tenaga kerja yang kompeten dalam pengoperasian
komputerisasi akuntansi.

Dalam kurikulum 2013 khususnya
untuk paket keahlian akuntansi peserta
didik dituntut memiliki kemampuan
menerapkan pengetahuan,
keterampilan dan sikap yang konsisten
dari waktu ke waktu dalam
pengoperasian  aplikasi  komputer
akuntansi. Sebagian kompetensi dasar
dalam mata pelajaran Komputer
Akuntansi menuntut peserta diklat
untuk menguasai kompetensi secara
utuh mengoperasikan aplikasi

Gambar: 1. 1 Operator Komputer Akuntansi

Tidak jarang lembaga bisnis harus
mengeluar-kan biaya pelatihan yang

cukup besar untuk menyiapkan tenaga
operator komputer akuntansi. Sekolah
Menengah Kejuru-an (SMK) sebagai

komputer akuntansi pada perusahaan
jasa. Apakah perusahaan jasa itu?
Perusahaan jasa adalah perusahaan
yang usaha pokoknya ditujukan untuk

salah satu lembaga penyedia calon

¢ keria tinakat ht memperoleh pendapatan atau
enaga kerja tingka menengan tanggap penghasilan melalui pelayanan jasa
terha-dap tuntutan industri. tertentu

Keuntungan menerapkan komputer akuntansi pada perusahaan jasa diantaranya
adalah mengurangi penggunaan kertas-kertas (paperless) sehingga pada
gilirannya akan mengurangi beban alat tulis kantor (atk) atau beban perlengkap-an
(supplies). Disamping itu keuntungan penerapan komputer di bidang akuntansi
adalah jaminan untuk kecepatan dan ketepatan.

Gambar: 1. 2 Paperless

Direktorat Pembinaan SMK (2013)
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Kecepatan karena sebagian besar pekerjaan akuntansi diambil alih oleh komputer
dan dikerjakan dengan cepat.

Gambar: 1. 3 Proses Komputer Akuntansi
Tugas operator hanyalah sebatas data entri, sementara tugas selanjutnya
termasuk penyusunan laporan keuangan dikerjakan oleh komputer. Selama data
yang dientri ke komputer data yang benar maka maka hasilnyapun akan benar
atau tepat.

Aktivitas komputer akuntansi perusahaan jasa mengarah pada data entri transaksi
keuangan yang terjadi pada perusahaan jasa sejak awal periode sampai dengan
proses penyiapan laporan keuangan pada akhir periode akuntansi. Aktivitas ini
secara keseluruhan meliputi:

1. Menyiapkan data awal;

Membuat daftar akun;
Menyesuaikan pajak;
Meng-entry saldo awal;
Mencatat Kas Keluar;
Mencatat Kas Masuk;
Mencatat entri penyesuaian;

Menampilkan laporan keuangan.

© ® N o O R DN

Membuat backup file.

[ B. Prasyarat ]

Untuk memudahkan peserta didik dalam mempelajari buku ini,
maka terlebih dahulu dipersyaratkan telah menguasai kompetensi
dasar yang ada dalam mata pelajaran:

1. Pengantar Akuntansi dan Keuangan
2. Akuntansi Perusahaan Jasa.

) Direktorat Pembinaan SMK (2013)
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[ C. Petunjuk Penggunaan Buku Siswa ]

Buku Komputer Akuntansi 1 disusun untuk peserta didik, guna mendukung mata
pelajaran Komputer Akuntansi di kelas Xl semester | pada paket keahlian
Akuntansi.

Dalam buku ini terdapat 9 (sembilan) kegiatan belajar. Disarankan kepada peserta
didik untuk mempelajari buku ini secara urut agar lebih mudah memahaminya.

Agar aktivitas peserta didik lebih terarah dan lebih lancar dalam pencapaian
kompetensi maka disarankan untuk mengikuti petunjuk-petunjuk berikut ini:

1.

2.

8.

Bacalah dengan cermat peta kedudukan modul, prasyarat dan pengertian
dari istilah-istilah penting dalam buku ini.

Untuk setiap kegiatan belajar, bacalah dengan cermat rumusan tujuan
pembelajaran yang memuat pengetahuan dan kinerja yang diharapkan
dalam rangka membentuk kompetensi kerja yang akan dicapai melalui
modul ini.

Pahami dengan baik uraian materi pada setiap kegiatan belajar termasuk
kasus yang diberikan. Diskusikan dengan sesama peserta didik, uraian atau
bagian dari kasus yang sulit dipahami. Bila masih ragu, maka tanyakanlah
pada guru sampai paham.

Ikuti langkah-langkah pemecahan kasus seperti yang tertulis di setiap
kegiatan belajar. Lakukan ini bersama-sama dalam kelompok kecil. Bila
mengalami kesulitan diskusikan dengan anggota kelompok. Jika masih ragu,
maka tanyakanlah pada guru sampai jelas.

Kerjakan tugas-tugas, dan jawablah pertanyaan tes, kemudian cocokkan
dengan kunci jawaban. Lakukan kegiatan ini sampai peserta didik tuntas
menguasai hasil belajar yang diharapkan.

Setelah kamu menuntaskan satu kegiatan belajar selanjutnya pelajari
kegiatan belajar berikutnya secara urut.

Peserta didik tidak dibenarkan melanjutkan pada kegiatan belajar
berikutnya, bila belum menguasai secara tuntas materi pada kegiatan
belajar sebelumnya.

Setelah semua kegiatan belajar tuntas dipelajari maka ajukan diri untuk
melaksanakan evaluasi penyelesaian buku 1.

Pelaksanaan evaluasi ini bisa dikerjakan secara individu atau klasikal. Jika
hasilnya memuaskan dapat melanjutkan kegiatan belajar di buku 2.

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

[ D. Tujuan Akhir ]

Spesifikasi kompetensi yang diharapkan dikuasai
setelah menyelesaikan kegiatan belajar ini adalah
dengan diberikan kasus-kasus akuntansi perusahaan
jasa peserta didik dapat menyelesaikan proses
komputer akuntansi sampai dengan akhir periode,
sehingga dapat menghasilkan laporan keuangan
sesuai dengan permintaan.

[ E. Kompetensi Inti dan Kompetensi Dasar ]

Tabel berikut ini menyajikan kompetensi inti dan kompetensi dasar untuk mata
pelajaran Komputer Akuntansi di kelas XI.

KOMPETENSI INTI

1. Menghayati dan

KOMPETENSI DASAR

1.1 Mensyukuri karunia Tuhan Yang Maha

mengamalkan ajaran agama
yang dianutnya

1.2

Esa, atas pemberian amanah untuk
mengelola administrasi keuangan entitas.
Mengamalkan ajaran agama dalam
memanfaatkan ilmu pengetahuan dan

teknologi untuk menghasilkan informasi

keuangan yang mudah dipahami,
relevan, andal dan dapat
diperbandingkan.

menempatkan diri sebagai
cerminan bangsa dalam
pergaulan dunia

. Menghayati dan 2.1. Memiliki motivasi internal dan
mengamalkan perilaku jujur, menunjukkan rasa ingin tahu dalam
disiplin, tanggungjawab, menemukan dan memahami
peduli (gotong royong, pengetahuan dasar tentang komputer
kerjasama, toleran, damai), akuntansi.
santun, responsif dan pro- 2.2. Menunjukkan perilaku jujur, disiplin,
aktif dan menunjukkan sikap tanggungjawab, santun, responsif dan
sebagai bagian dari solusi pro-aktif dalam berinteraksi secara efektif
atas berbagai permasalahan dalam lingkungan sosial sesuai dengan
dalam berinteraksi secara prinsip etika profesi bidang komputer
efektif dengan lingkungan akuntansi.
sosial dan alam serta dalam | 5 3. Menghargai kerja individu dan kelompok

serta mempunyai kepedulian yang tinggi
dalam menjaga keselarasan lingkungan
sosial, lingkungan kerja dan alam.
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3. Memahami dan menerapkan | 3.1. Mendeskripsikan spesifikasi sistem

pengetahuan faktual, komputer yang diperlukan untuk
konseptual, dan prosedural, menginstal program aplikasi komputer
berdasarkan rasa ingin akuntansi yang dipilih.

tahunya tentang ilmu 3.2. Mendeskripsikan proses pembuatan file
pengetahuan, teknologi, data akuntansi baru untuk perusahaan
seni, budaya, dan humaniora jasa

dengan wawasan 3.3. Menganalisis susunan daftar akun dan
kemanusiaan, kebangsaan, hubungan akun (link accounts) untuk
kenegaraan, dan peradaban komputerisasi akuntansi perusahaan

terkait penyebab fenomena
dan kejadian dalam bidang 34
kerja yang spesifik untuk '
memecahkan masalah.

jasa

. Mendeskripsikan cara penyesuaian
pajak pertambahan nilai (PPN) untuk
perusahaan jasa

3.5. Mendeskripsikan cara pengisian saldo
awal akun buku besar perusahaan jasa

3.6. Menganalisis transaksi-transaksi
pengeluaran kas/bank pada perusahaan
jasa dan cara pengentriannya.

3.7. Menganalisis transaksi-transaksi
penerimaan kas/bank pada perusahaan
jasa dan cara pengentriannya.

3.8. Menjelaskan penyelesaian rekonsiliasi
bank untuk perusahaan jasa

3.9. Menganalisis transaksi umum termasuk
transaksi penyesuaian dan cara
pengentriannya ke dalam buku jurnal
umum perusahaan jasa

3.10.Mendeskripsikan cara penyusunan
laporan keuangan untuk perusahaan
jasa

3.11.Mendeskripsikan cara pembuatan file
backup untuk perusahaan jasa

3.12.Mendeskripsikan proses pembuatan file
data akuntansi baru untuk perusahaan
dagang

3.13.Menganalisis susunan daftar akun dan
hubungan akun (link accounts) untuk
komputerisasi akuntansi perusahaan
dagang

3.14.Mendeskripsikan cara penyesuaian
pajak pertambahan nilai (PPN) untuk
perusahaan dagang
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KOMPETENSI DASAR

KOMPETENSI INTI

3.15.Mendeskripsikan cara pengisian saldo

awal akun buku besar perusahaan
dagang

3.16.Mendeskripsikan cara pembuatan kartu
piutang dan pengisian saldonya untuk
perusahaan dagang

3.17.Mendeskripsikan cara pembuatan kartu
utang dan pengisian saldonya untuk
perusahaan dagang

3.18.Mendeskripsikan cara pembuatan kartu
perlengkapan/persediaan dan pengisian
saldonya untuk perusahaan dagang

3.19.Mendeskripsikan cara pembuatan kartu
aktiva tetap dan pengisian saldonya
untuk perusahaan jasa dan dagang

3.20.Menganalisis transaksi-transaksi
pembelian tunai dan pembelian kredit
pada perusahaan dagang serta cara
pengentriannya.

3.21.Menganalisis transaksi-transaksi
pembayaran utang bagi perusahaan
dagang dan cara pengentriannya.

3.22.Menganalisis transaksi-transaksi
penjualan bagi perusahaan dagang dan
cara pengentriannya.

3.23.Menganalisis transaksi-transaksi
pelunasan piutang bagi perusahaan
dagang dan cara pengentriannya.

3.24 Menganalisis transaksi-transaksi
pengeluaran kas/bank bagi perusahaan
dagang dan cara pengentriannya.

3.25.Menganalisis transaksi-transaksi
penerimaan kas/bank bagi perusahaan
dagang dan cara pengentriannya.

3.26.Mendeskripsikan cara penyelesaian
rekonsiliasi bank untuk perusahaan
dagang

3.27 .Menganalisis transaksi umum termasuk
transaksi penyesuaiann dan cara
pengentriannya ke dalam buku jurnal
umum perusahaan dagang

3.28.Mendeskripsikan cara penyusunan
laporan keuangan untuk perusahaan
dagang
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3.29.Mendeskripsikan cara pembuatan file
backup untuk perusahaan dagang

4. Mengolah, menalar, dan 4.1. Menginstal program aplikasi komputer
menyaji dalam ranah konkret akuntansi pada sistem komputer yang
dan ranah abstrak terkait telah dipersiapkan.
dengan pengembangan dari | 4.2. Membuat file data akuntansi baru untuk
yang dipelajarinya di sekolah perusahaan jasa
secara mandiri, dan mampu | 4 3 Menyusun daftar akun dan hubungan
melaksanakan tugas spesifik akun (link accounts) untuk perusahaan
di bawah pengawasan jasa
langsung. 4.4. Menyesuaikan seting pajak

pertambahan nilai (PPN) untuk
perusahaan jasa

4.5. Mengsisi saldo awal akun buku besar
perusahaan jasa

4.6. Mengentri transaksi-transaksi
pengeluaran kas/bank pada perusahaan
jasa

4.7. Mengentri transaksi-transaksi
penerimaan kas/bank pada perusahaan
jasa

4.8. Membuat rekonsiliasi bank untuk
perusahaan jasa

4.9. Mengentri transaksi umum termasuk
transaksi penyesuaian ke dalam buku
jurnal umum perusahaan jasa

4.10. Membuat laporan keuangan untuk
perusahaan jasa

4.11. Membuat file backup untuk perusahaan
jasa

4.12. Membuat file data akuntansi baru untuk
perusahaan dagang

4.13.Membuat daftar akun dan hubungan
akun buku besar perusahaan dagang.

4.14. Menyesuaikan seting pajak
pertambahan nilai (PPN) untuk
perusahaan dagang

4.15. Mengentri saldo awal akun-akun buku
besar untuk perusahaan dagang

4.16. Membuat kartu piutang dan mengisi
saldonya untuk perusahaan dagang

4.17. Membuat kartu utang dan mengisi
saldonya perusahaan dagang

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

KOMPETENSI INTI

KOMPETENSI DASAR

4.18. Membuat kartu perlengkapan/
persediaan dan mengisi saldonya untuk
perusahaan dagang

4.19. Membuat kartu aktiva tetap dan mengisi
saldonya untuk perusahaan dagang

4.20. Mengentri transaksi-transaksi pembelian
tunai dan kredit bagi perusahaan
dagang

4.21. Mengentri transaksi-transaksi
pembayaran utang bagi perusahaan
dagang

4.22. Mengentri transaksi-transaksi penjualan
bagi perusahaan dagang

4.23. Mengentri transaksi-transaksi pelunasan
piutang bagi perusahaan dagang

4.24. Mengentri transaksi-transaksi
pengeluaran kas/bank bagi perusahaan
dagang

4.25. Mengentri transaksi-transaksi
penerimaan kas/bank bagi perusahaan
jasa dan dagang

4.26. Membuat rekonsiliasi bank untuk
perusahaan dagang

4.27. Mengentri transaksi umum termasuk
transaksi penyesuaian ke dalam jurnal
umum perusahaan dagang

4.28. Membuat laporan keuangan untuk
perusahaan dagang

4.29. Membuat file backup untuk perusahaan
dagang
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[ F. Cek Kemampuan Awal ]

Sebelum kamu memelajari buku ini, kamu diminta untuk menjawab
semua pertanyaan di bawah ini dengan mencontreng kolom YA atau
TIDAK.

BUTIR PERTANYAAN YA TIDAK

Apakah kamu dapat menyiapkan data awal?

Apakah kamu dapat membuat daftar akun?

Apakah kamu dapat menyesuaikan pajak?

Apakah kamu dapat mengentri saldo awal?

Apakah kamu dapat mencatat transaksi kas keluar?

Apakah kamu dapat mencatat transaksi kas masuk?

Apakah kamu dapat mencatat entri penyesuaian?

Apakah kamu dapat menampilkan laporan keuangan?

Apakah kamu dapat membuat file backup?
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BAB I

PEMBELAJARAN

[ A. Deskripsi

J

Proses pembelajaran yang dirancang untuk komputer akuntansi ini,
lebih mengarah pada model pembelajaran berbasis masalah/kasus (Problem
Based Learning), dimana para peserta didik dirangsang dan dilatih untuk mampu
mencari solusi (pemecahan masalah) yang diberikan baik secara individual

maupun kelompok.

Tahapan-tahapan yang akan digunakan adalah sebagai berikut:

FASE AKTIVITAS PESERTA DIDIK

proses pemecahan
kasus.

Fase 1. > lIdentifikasi tujuan pembelajaran.
P > |dentifikasi kelengkapan logistik.
|dentifikasi Kasus. > |dentifikasi kelengkapan informasi/ data
dalam kasus yang diberikan.
Fase 2. » Menentukan alternatif pemecahan kasus.
e > Inventarisasi tugas.
Organisasi Tugas. > Pembagian tugas.
Fase 3. » Mengumpulkan informasi yang sesuai
Pelaksanaan tugas untuk melaksanaan tu_gas.
atau eksperimen » Melaksanakan eksperimen
» Mengatasi kesulitan/kesalahan yang
terjadi dalam pelaksanaan eksperimen
Fase 4. » Membuat laporan
Penyajian hasil tugas. » Menyajikan hasil tugas
Fase 5. » Presentasi individu/kelompok
Analisis dan Evaluasi > Mengevaluas! kasus yang diberikan
» Mengevaluasi proses pemecahan kasus
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[ B. Kegiatan Belajar ]

Penulisan buku Komputer Akuntansi yang diaplikasikan pada
perusahaan jasa ini dijabarkan dalam 8 (delapan) kegiatan belajar

yaitu meliputi :

Kegiatan belajar 1
Kegiatan balajar 2
Kegiatan belajar 3
Kegiatan belajar 4
Kegiatan belajar 5
Kegiatan belajar 6
Kegiatan belajar 7
Kegiatan belajar 8
Kegiatan belajar 9

©CoNoOORLON =

: Menyiapkan data awal perusahaan.
: Membuat daftar akun

: Menyesuaikan Pajak

: Mengentri Saldo Awal

: Mencatat Kas Keluar

: Mencatat Kas Masuk

: Mencatat Entri Penyesuaian

: Menampilkan laporan Keuangan.

: Membuat file backup

Setiap kegiatan belajar dilengkapi dengan tujuan pembelajaran,
uraian materi, rangkuman, tugas-tugas, tes formatif, kunci jawaban
tes formatif, dan lembar kerja peserta didik.
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KEGIATAN BELAJAR 1
MIENYIAPKAN DATA AWAL

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada
akhir sesi ini diharapkan peserta didik dapat:

1. Menginstall program MYOB

2. Menentukan menu untuk mengubah format tanggal dan
simbol mata uang.

3. Menyesuaikan format tanggal dan mata uang
4. Membuat file data baru

5. Mengecek Informasi Perusahaan

{ b. Uraian Materi ]

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:

1. Instalasi Program MYOB
Menu Format Tanggal dan Simbol Mata Uang
Penyesuaian Format Tanggal dan Simbol Mata Uang

Pembuatan File Data Baru

CE

Pengecekan Informasi Perusahaan

Direktorat Pembinaan SMK (2013)
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1. Menginstall Program MYOB

Ada lima unsur penting yang saling terkait dalam sistem komputerisasi di
semua bidang, termasuk di bidang akuntansi, yaitu:

a) Perangkat keras (hardwares), yaitu peralatan komputer dan peralatan
elektronik lainnya yang digunakan untuk otomatisasi akuntansi.

b) Perangkat lunak (softwares), yaitu program komputer dalam hal ini adalah
aplikasi komputer akuntansi. Biasanya untuk menjalankan aplikasi ini
diperlukan spesifikasi hardwares tertentu.

c) Perangkat otak (brainwares), yaitu tenaga manusia yang memprogram dan
mengoperasikan komputer.

d) Data input dan output. Data input adalah data yang dientri dan diproses di
komputer, sedangkan output adalah data yang dihasilkan atau disebut
informasi.

Perangkat lunak yang digunakan untuk komputerisasi akuntansi salah satunya
adalah MYOB. Peralatan komputer yang dibutuhkan untuk pengoperasian
program MYOB minimal mempunyai spesifikasi sebagai berikut:

200MHz Intel Pentium Processor with at least 64 MB RAM.
200 MB of Hardisk space.

16 bit colour, 1024x768 screen resolution.

Microsoft Windows versi 2000, XP, Vista atau yang terbaru
Windows compatible printer, mouse or pointing device.

Untuk menginstall MYOB diperlukan program master, yaitu AccountingPlus 18
versi edukasi yang dirilis oleh MYOB Australia yang tersimpan di dalam CD
atau Flash Disk anda. Program master tersebut memiliki 4 (empat) file seperti
di gambar berikut ini:

Gambar: 2. 1 Program Master MYOB AccountingPlus 18
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Langkah-langkah untuk menginstall program MYOB sebagai berikut:

Langkah Aktivitas-aktivitas
1 Dobel Klik file Setup
2 Pilih Complete instalation, proses instalasi berjalan secara
otomatis
3 Klik Yes setiap ada pertanyaan.
4 Klik Finish, untuk mengakhiri proses instalasi

2. Menu untuk Format Tanggal dan Simbol Mata Uang

Menu yang digunakan untuk menyesuaikan format tanggal dan simbol
mata uang Indonesia adalah langsung dari program Windows yaitu:

3. Penyesuaian Format Tanggal dan Simbol Mata Uang.

Format tanggal pada program MYOB sejak awal diformat (sistem
Amerika) MM/DD/YYYY artinya Bulan/Tanggal/Tahun. Hal ini dapat
menyebabkan kesalahan manakala digunakan oleh user di Indonesia
karena terbiasa dengan format Tanggal/Bulan/Tahun. Oleh sebab itu
sebelum mengaktifkan program MYOB peserta didik perlu mengubahkan
menjadi format tanggal Indonesia dan simbol mata uang Dollar ($)
diubah menjadi simbol mata uang Rupiah (Rp).

Langkah-langkah untuk mengubah format tanggal dan simbol mata uang
sebagai berikut:

Langkah Aktivitas-aktivitas
1 Klik Start > Control Panel > Date, Time, Language and
Regional Options
2 Klik Regional and Language Options
3 Pilih Indonesia dan Klik OK.

Direktorat Pembinaan SMK (2013)
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Gambar: 2. 2 Penyesuaian format tanggal dan simbol mata uang

4. Pembuatan File Data Baru.

File data baru adalah file data akuntansi yang digunakan untuk
menyimpan seluruh data yang dientri ke dalam komputer. File ini dibuat
(hanya sekali) yaitu pada saat perusahaan melakukan konversi dari
sistem manual ke komputer akuntansi dengan menggunakan MYOB.
File ini harus diberi nama oleh user dan secara otomatis program MYOB
akan memberi ekstension MYO, contoh nama file: RID-Syn.myo. File ini
akan digunakan selama perusahaan beroperasi.

Langkah-langkah pembuatan file data baru (didasarkan pada kasus
Renata Interior Design lihat di Lembar Kerja Peserta Didik).

Langkah Aktivitas-aktivitas

1 Aktifkan program MYOB dengan klik Starts>MYOB Accounting Plus
v18ED atau dobel klik pada ikon MYOB dilayar komputer.
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Langkah Aktivitas-aktivitas

Gambar: 2. 3 Mengaktifkan program MYOB

2 Klik Create pada tampilan Menu Awal

Gambar: 2. 4 Menu Utama

3 Klik Next pada tampilan Welcome Windows

4 Ketik identitas perusahaan. Kolom isian yang tidak boleh
dikosongkan adalah nama perusahaan (company name). Jika telah
selesai klik Next

16 Direktorat Pembinaan SMK (2013)
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Langkah Aktivitas-aktivitas

Gambar: 2. 5 Identitas Perusahaan

5 Ketik periode akuntansi, sesuaikan dengan kasus yang ada.
kemudian Kklik Next

Gambar: 2. 6 Periode Akuntansi

6 Periksa kembali periode akuntansi. Bila ada data yang salah, klik

Back dan betulkan data yang salah tersebut. Apabila data sudah
benar, klik Next.

Direktorat Pembinaan SMK (2013)
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Langkah Aktivitas-aktivitas
Gambar: 2. 7 Konfirmasi Periode Akuntansi
e caid A . .' A .- .. B A - . i . e - .' cald
eSaildlla (da dapa aliperoa agliteriga dld dl a PDrose
Pekerjaa allg ela arnda Ia Ci ernjaaq Ci Ci arera a
0, alrng da adWd
Langkah Aktivitas-aktivitas
7 Pada penyusunan daftar akun, pilih cara kedua yaitu mengimport

daftar akun dari sebuah file dan klik Next untuk meneruskan.

Gambar: 2. 7 Pilihan penyusunan Daftar Akun
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Langkah Aktivitas-aktivitas

8 Klik Change untuk mengubah nama file dan nama folder

Gambar: 2. 8 Mengubah nama file dan folder

9 Buat Folder Data MYOB18 dalam folder Documents dan kemudian
klik folder tersebut. Ketik nama file: RID- Namamu masing-masing
dan kemudian klik Save.

. » Libraries » Documents » Data MYOB18 « |43 [l Search Data MYOB18 el

Organize = New folder =~ @

it .
i Favorites 1 Documents library
B Desktop Data MYOB18

El Recent Places Name Date modified Type
18 Downloads

Armrange by:  Folder ~

No items match your search.
4 Libraries
[ Documents
J' Music
[&] Pictures
B videos

m

'8 Computer —
s Windows7_05 (C
& CD Drive (E)

a Lenovo Recoven

File name: .

Save as type: [MVOB Data (".MY0) -]

4 Hide Folders

- q m 3

Gambar: 2. 9 Ubah Nama file dan folder
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Langkah Aktivitas-aktivitas

10 Klik Next untuk memproses penyimpanan file, tunggu beberapa saat,
kemudian klik Command Centre. Maka tampilan Command Centre
akan dimunculkan seperti gambar berikut ini.

Gambar: 2. 10 Command Centre

5. Pengecekan Informasi Perusahaan.

File data baru yang akan digunakan sebagai tempat pencatatan data
akuntansi telah disiapkan. Tapi apakah data yang telah di input ke dalam
komputer itu benar? MYOB menyediakan fasilitas untuk mengecek
kebenaran data, terutama untuk identitas perusahaan dan periode
akuntansi.

Direktorat Pembinaan SMK (2013)
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Langkah-langkah untuk mengecek hasil pembuatan file data baru (kasus
Renata Interior Design):

Langkah Aktivitas-aktivitas

1 Klik menu Setup dan pilih Company Information.

Gambar: 2. 11 Menu Company Information

2 Cek kebenaran informasi perusahaan, terutama identitas dan
periode akuntansi. Jika identitas perusahaan ada yang salah dapat
diedit. Tetapi jika ada data periode akuntansi yang salah maka
proses pembuatan file data baru harus diulang kembali. Klik OK jika
keduanya benar.

Company Information EI [

Company Information

Company Name: |Renata Interior Designer
Address: |Pertokoan Pamulang Square Blok B1417
J1. Situ Bening - Pamulang —
Tangerang S elatan ABMN o TN
AB.MN. Branch
Phare Mumber. | 0217434352 ACN
Fax Mumber: | 0217434352 Sales Taxr Nurnber
Email Address: | go_rid@yahoo.com Payee Mumber
Conrversion Month:  January 2013 Current Financial Year, 2013
Accounting Periods:  Twelve Last Month in Financial Year. December

,?/ - 4 =
5 \:)‘
Help F1 Licenze | BAS Info

Gambar: 2. 12 Company Information RID

Direktorat Pembinaan SMK (2013)
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[ c. Rangkuman ]

e Format tanggal dan simbol mata uang disesuaikan dengan format
Indonesia untuk menghindari kesalahan dalam input data. Hal ini bisa
dilakukan melalui program Windows dengan memanfaatkan fasilitas
Control Panel.

e Tidak boleh ada kesalahan mengisi periode akuntansi, terutama dalam
menentukan bulan akhir periode dan bulan konversi. Bulan akhir periode
adalah bulan dimana akan disusun laporan keuangan selama satu
periode. Bulan konversi (conversion month), adalah bulan dimana
dilakukan pergantian sistem dari akuntansi manual ke sistem komputer
akuntansi atau bulan dimana pencatatan saldo awal akan dilakukan.

e Dalam MYOB ada tiga cara penyusunan daftar akun. Cara yang paling
efektif, sesuai dan cepat adalah dengan mengimport daftar akun. Yang
perlu diingat untuk cara ini adalah penyesuaian linked account untuk
Bank, Sales, Purchase dan Payroll dan menghapus beberapa kaun yang
tidak digunakan.

e MYOB menyediakan 1 (satu) file data digunakan untuk menyimpan
seluruh data akuntansi. File data ini diberi nama unik (tidak ada yang
sama) dan diberi tambahan (ekstension) MYO.
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1.

. Tugas 1, menginstall program MYOB versi 18 di komputer masing-

Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

masing (jika memungkinkan).

Tugas 2, cek format tanggal dan simbol mata uang di komputer
masing-masing, bila formatnya masih default atau menggunakan
format Amerika maka ubahlah ke format Indonesia.

Tugas 3, buatlah file data bisnis baru didasarkan pada kasus Renata
Interior Design (lihat di Lembar Kerja Peserta Didik). Ikuti langkah-
langkah seperti yang tertulis di dalam buku ini.

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:

. Test Pengetahuan dan
. Tes Keterampilan

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Unsur-unsur yang saling mempengaruhi dalam sistem komputerisasi
akuntansi:
a. Softwares, Hardwares, Program Applications, Inputs dan Outputs.
b. Hardwares, Softwares, Input, dan Outputs
c. Softwares, Hardwares, Brainwares, inputs dan Outputs.
d. Input, Hardwares, Softwares, Process, dan Output.
e. Hardwares, Program Aplication, inputs dan Outputs.

2. Program MYOB termasuk kelompok:
a. Input dan Output
b. Hardwares
c. Process
d. Softwares
e. Brainwares

3. Format tanggal program MYOB Sejak awal adalah:
a. YYYY/MM/DD
b. DD/MM/YYYY
c. MM/DD/YYYY
d. YYYY/DD/MM
e. MM/YYYY/DD

4. Menu yang digunakan untuk pembuatan file data bisnis baru:
a. Explore
b. What's New
c. Open
d. Create
e. Exit.

5. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong):
. Serial Number

b. Company Name

c. Address

d. Phone and fax number

e. Email Address.

V]
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6. Yang dimaksudkan dengan Current Financial Year:
a. Periode akuntansi yang sedang berjalan
b. Periode akuntansi yang akan datang
c. Periode akuntansi yang lalu
d. Periode akuntansi selama perusahaan beraktivitas
e. Periode akuntansi tertentu.

7. Yang dimaksud dengan Last Month of Financial Year:
a. Bulan awal dari periode akuntansi
b. Bulan awal dan akhir dari periode akuntansi
c. Bulan akhir dari periode akuntansi
d. Akhir bulan (Desember) dari periode akuntansi
e. Akhir bulan (Januari) dari periode akuntansi

8. Yang dimaksud dengan Conversion Month:

. Bulan saat terjadinya transaksi keuangan

. Bulan pertama digunakan komputer akuntansi
. Bulan awal periode akuntansi yang berjalan

. Bulan akhir periode akuntansi yang berjalan

. Bulan pergantian periode akuntansi

O Q0O TO

9. Jika perusahaan menggunakan jumlah periode 13 bulan, maka bulan
ke-13 khusus untuk:
a. Mencatat transaksi bulan Desember
b. Mencatat transaksi awal periode
c. Mencatat transaksi penyesuaian (adjustment)
d. Mencatat transaksi kesalahan
e. Mencatat rekonsiliasi akun-akun tertentu

10. Nama file data bisnis harus unik, artinya:

. Nama file harus mudah diingat

. Nama file harus mudah ditemukan atau dicari

. Nama file harus spesifik tidak ada yang menyamai
. Nama file harus sama digunakan berkali-kali

. Nama file disimpan di folder khusus

O Q0O TO
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2. Tes Keterampilan.

Buatlah file data baru menggunakan program MYOB versi18 untuk perusahaan
jasa Rio Interior Design (lihat Kasus 2 di Lembar Kerja Peserta Didik), dengan
rincian sebagai berikut:

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan
hasil pekerjaannya dalam bentuk file.

3. Tugas 1, mencatat identitas perusahaan secara lengkap.
4. Tugas 2, menetukan periode akuntansi.

5. Tugas 3, menentukan cara penyusunan daftar akun (dengan cara
mengimport).

6. Tugas 4, menentukan nama folder (My Documents/Data MYOB 18
dan nama file RIOD-nama peserta didik masing-masing.

Direktorat Pembinaan SMK (2013)
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f. Kunci Jawaban Tes Formatif

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
e Kunci Tes Keterampilan

1. Kunci Test Pengetahuan

O OONOO AR WN -
O|0|T|O|v|T|Ia|o|a|o

-
o

2. Kunci Tes Keterampilan

Menu : Setup > Company Information.

Company Information EI

Company Information

Company Mame: |Rio Interior Design

ALddress: |Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening, Pamulang
Tangerang Selatan ABMN or TEN:

A.B.M. Branch:
Phone Number: | 021 7434352 ALCH:
Fan Mumber: | 021 7434352 Sales Tax Mumber:

Email Address: | go_riod@yahoo.com Payes Mumber:

Conversion Month:  January 2014 Current Financial Year: 2074

Accounting Periods:  Twelve Last Month in Financial Year. December

= b -

7 (& =g

7. | ©a EHi
Help F1 Licenze | BAS Info

Gambar: 2. 13 Company Information RIOD
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 1.1 : Pembuatan File Data Baru.

Identitas perusahaan:
Nama : Renata Interior Designer.
Alamat . Pertokoan Pamulang Square Blok B1/17
: JI. Situ Bening, Pamulang, Tangerang Selatan
Telpon/fax : 021 7434352
email-addr : go_rid@yahoo.com

Periode akuntansi:
Current Financial year : 2013
Last month of the year : December,
Conversion Month :January,
Accounting Period : Twelve.

Pembuatan daftar akun (Build your accounts list):
Mengimport daftar akun dari file yang sudah disediakan.
(I would like to import a list of accounts provided by ....)

Penyimpanan file:
Folder : My Documents\Data MYOB18
Nama File : RID-Nama Peserta Didik
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Kasus 1.2 : Pembuatan File Data Baru

Identitas perusahaan:
Nama . Rio Interior Design.
Alamat  : Pertokoan Pamulang Square Blok B1/17
. JI. Situ Bening, Pamulang, Tangerang Selatan
Telpon/fax: 021 7434352
email-addr: go_riod@yahoo.com

Periode akuntansi:
Current Financial year: 2014
Last month of the year: December,
Conversion Month . January,
Accounting Period . Twelve.

Pembuatan daftar akun (Build your accounts list):
Mengimport daftar akun dari file yang sudah disediakan.
(I would like to import a list of accounts provided by ....)

Penyimpanan file:
Folder : My Documents\Data MYOB18
Nama File : RIOD-Nama Peserta Didik
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KEGIATAN BELAJAR 2

MEMBUAT DAFTAR AKUN

[ a. Tujuan Pembelajaran

]

1. Mengidentifikasi tipe-tipe akun.
Memilih menu untuk mengimport akun.
Mengimport daftar akun.
Menyesuaikan linked account.

Menghapus dan mengedit akun-akun

e Pl 2 0e

Mengecek Daftar Akun

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir
kegiatan belajar ini diharapkan peserta didik dapat:

[ b. Uraian Materi

Lingkup materi kegiatan belajar ini meliputi:
1. Tipe-tipe akun

Menu mengimport daftar akun

Langkah Import daftar akun

Penyesuaian linked account

Penghapusan dan edit akun-akun

eyl g 89 Y

Pengecekan Daftar Akun
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1. Tipe-tipe Akun

Dalam MYOB, daftar akun dikelompokkan dalam 8 tipe, yaitu:

Kode Tipe Akun Sub Tipe Akun Sub Tipe Akun
1 Asset Assets dibagi 5: Liabilities dibagi 5:
2 Liability e Bank e Credit card
3 Equity e Accounts e Accounts Payable
4 Income Receivable e Other Current
5  CostofSales °® Other Current Liability
6 Expense A:sset elong Te_rm. _Liability
- o Fixed Asset e Other Liability
7 Tidak ada
e Other Asset
8 Other Income

9 Other Expense
Tabel: 2- 1 Tipe-tipe Akun

Kode Akun
Setiap akun memiliki kode 5 digit:
Digit ke 1 : Kategori Akun.

Digitke 2 -5 : Nomor ID Akun (Unik, tidak boleh ada yang sama).
Kelompok Akun.

a) Akun Header, berfungsi sebagai header, nilainya tidak dapat diposting
(Non Postable). Akun ini biasanya tercetak dengan huruf tebal.

b) Akun Detail, berfungsi sebagai child, nilainya dapat diposting
(Postable). Akun ini tercetak dengan huruf biasa.

2. Menu untuk Mengimport Daftar Akun

Menu yang digunakan untuk mengimport daftar akun dari sebuah file sudah
disiapkan:
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3.

Langkah Import Daftar Akun

Dalam praktik terdahulu, anda telah memilih mengimport daftar akun
yang telah disediakan. Untuk hal tersebut anda harus mempunyai file
yang berisi daftar akun untuk diimport ke dalam MYOB.

Langkah-langkah mengimport daftar akun (Lihat Kasus 2.1. Renata

Interior Designer di Lembar Kerja Peserta Didik) :

1 Klik File, pilih Import Data > Accounts > Account Information
2 Pada window Import File, lihat pada kolom Duplicate Records: pilih
Update Existing Record, kemudian klik Continue.
3 Pilih Folder Data MYOB18 dan file Daftar Akun RID, lalu klik Open.
—‘I*
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1
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Gambar: 2. 14 Mengimport Daftar Akun
4 Pada window Import Data, klik Account Number dalam kolom Import
Fields kemudian bawa ke kanan sejajar dengan Account Number
dan klik pada kolom Matching Import Field. Lakukan cara yang
sama untuk field-field lain.
5 Klik Import dan tunggu beberapa saat untuk proses import
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Langkah Aktivitas-aktivitas
6 Klik OK pada window pemberitahuan hasil import
\\\\ a”"
I AN v
\\\ l,,
VS
v /'
Gambar: 2. 15 Memilih field-field yang diimport

4. Penyesuaian Linked- Accounts

MYOB menyediakan fasilitas untuk menghubungkan akun-akun tertentu (link),
sehingga pada saat mencatat transaksi secara otomatis komputer menjurnal
dan mengisi jumlah untuk akun buku besar atau akun pembantu yang terkait.

a. Langkah-langkah menyesuaikan linked account untuk SALES
(Lihat Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik)

1 Klik Setup, Linked Accounts, Sales Accounts.

2 Sesuaikan linked account untuk Account Receivable dengan BCA
Account seperti gambar 2.16

Direktorat Pembinaan SMK (2013)
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Gambar: 2. 16 Setup linked Sales Accounts
3 Klik OK untuk mengakhiri

b. Langkah-langkah menyesuaikan linked account untuk PURCHASES
(Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik):

1 Klik Setup, Linked Accounts, Purchases Accounts.

2 Sesuaikan linked account untuk Account Payable dengan BCA
Account seperti gambar di bawah ini

-
u

—_—————

N~_____>

&~

Gambar: 2. 17 Linked account untuk Purchases

3 Klik OK untuk mengakhiri

Direktorat Pembinaan SMK (2013)
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c. Langkah-langkah menyesuaikan linked account untuk PAYROLLS:

1 Klik Setup, Linked Accounts, Payroll Accounts.

2 Sesuaikan linked account untuk Cash Payment
Payment dengan BCA Account

dan Cheque

3 Klik OK untuk mengakhiri

S ——p o

Payroll Linked Accounts \

= e ==

Fayroll Linked &ccounts

1
\
v

Bank &ccount for Cash Payments 5+ | 1-1110 =l

 /

Help F1

BCA Account
Bank Account for Cheque Payments £ [1-1110 |8 BCA Account

Bank Account for Electionic Payments 5+ [ 10190 (8] Electionic Clearing Account
Default Employer Expense Account o [6-3040 || ‘Workers' Compensation
Default Wages Expense siccount © [6-3030 || Wages & Salaries

Drefault Tax/D eductions Payable Account £ | 21700 =] Other Current Liabilities

Gambar: 2. 18 Setup linked account untuk payroll
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d. Cek kesesuaian linked account untuk ACCOUNTS & BANKING

(Kasus 2.2. Renata Interior Designer di Lembar Kerja Peserta Didik):

Klik Setup, Linked Accounts, Accounts and Banking Accounts

1

sudah sesuai.

_——,,
I

Y

Cek kesesuaian linked accounts seperti dalam gambar, Klik OK jika

——5\

----- >
\

Accounts & Barking Linked Aclounts

Equity Account for Current Eamings:  3-0800

Bank Account for Undeposited Funds &>

4
o
Help F1

Gambar: 2. 19 Setup linked account untuk Accounts and Banking Accounts

Equity Account for Retained Eamnings:  3-0200 Retained Earmings
E quity Account for Historical Balancing = | 3-9399 5l Historical Balancing
Bank Account for Electronic Payments 2 | 1-1190 = Electronic Clearing Account

1-1180 = Undeposited Funds

Current Year E amings
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5. Penghapusan dan Edit Akun-akun

Program MYOB mempunyai fasilitas Easy Setup Assistant untuk menghapus
akun-akun tertentu yang tidak digunakan oleh perusahaan. Hal ini
dimaksudkan untuk menyederhanakan daftar akun sehingga mudah dicari.

Langkah-langkah menghapus dan mengedit akun-akun
(Lihat Kasus 2.3. Renata Interior Designer di Lembar Kerja Peserta Didik)

1 Klik Setup, Easy Setup assistant, Account dan Next

Gambar: 2. 20 Easy Setup Assistant.

2 Selanjutnya anda dapat dengan mudah untuk menghapus akun.
Misalnya akan menghapus akun 7-0700 Cheque Account maka
anda klik akun tersebut dan klik Delete . Hapus akun-akun sudah
ditentukan.

Gambar: 2. 21 Menghapus akun

Direktorat Pembinaan SMK (2013)
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3

Untuk meng-edit akun 3-0800 Retained Earning maka anda klik akun

tersebut dan klik Edit . Selanjutnya anda mengedit no akun menjadi
3-8000 dst. Edit akun-akun lainnya.

Gambar: 2. 22 Meng-edit akun

Jika sudah selesai menghapus dan mengedit akun, klik Close dua
kali untuk keluar dari Easy Setup assistant.

Direktorat Pembinaan SMK (2013)
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6. Pengecekan Daftar Akun

Untuk melihat atau memeriksa daftar akun vyang tersusun dapat
menggunakan menu dibawah ini:

1 Klik Command Centre Account dan Account List

Gambar: 2. 23 Meng-edit akun

2 Klik Tab Asset, Liability, Equity dst. untuk memeriksa setiap
kelompok daftar akun. Klik Close untuk mengakhiri.

Accounts List E
AE‘?E‘IIH”[S I Asset I Liability I Equity I Income: I ESDQ;' I Expenze I Ir?c”;;ra I EEDU;:[SE
Account Name Type Tax Linked Balance
[J1-0000 Assets B
= 1-1000 Current Assets Asset
= 1-1100 Cash On Hand Agset
= 11110 BCA Account Bank N-T |
= 1-1120  Paproll Cheque Account Bark N-T
= 11130 Cash Drawer Bank M-T
= 1-1140  Petty Cazh Bark N-T
o 11180 Undeposited Funds Bank, N-T ~
= 11190 Electronic Clearing Account Bank N-T '
o 1-1200 Account Receivables [Met] Azzet
= 11210 Account Receivabls Accounts Heceivable  |N-T |~
o 11220 Allowanece for Doubtful Debts Accounts Receivable  |N-T
= 1-1300 Other Current Assets Asset
o 11310 Office Supplies Inwentary Other Cunent Asset N-T
=3 11320 Phatography Supplies Inventory Other Curent Asset N-T
= 11330 Prepaid Insurance Dther Curent Asset N-T
=3 11340 Prepaid Rent Other Curent Aszet N-T
=  1-2000 Fized Assets Agset
o 1-2100 Professional Equipment Aszet
= 1-2110  Prof Equipment at Cost Fized Asset N-T
o 1-2120  Prof Equipment Accum Dep Fived Aszet N-T
= 1-2200 Furniture & Fixtures Agset
= 1-2210 Fumiture & Fistures at Cost Fixed Asset N-T
= 1-2220  Furniture & Fistures Accum Dep Fized Asset N-T
= 1-2300 Motor Vehicles Asset
= 1-2310  Motor Vehicles at Cost Fized Asset N-T |
= 12320 MotorVehicles Amartisation Fined Asset M-T X ¥
o 1-2400 Computer Equipment Asset
[ 1-2410  Computer Equipment at Cast Fixed Asset N-T
=3 1-2420  Computer Equipment Accum Dep Fixed Asset N-T
= 1-3000 Other Assets Asget
= 13100 Goodwil Other Asset N-T
s | g Down | & Combine Accounis
7 o 3
7. = LS
Help F1 Print Budgets

Gambar: 2. 24 Daftar akun kelompok Asset
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Accounts List EI
Al Cost of Other Other
Accounts I Agset I Sales I Expense I Income: Exﬁemse
Account Mame Type Tax Linked Balance

=3

0 20300 Payoll Accruals Payable Other Liability MN-T ~ Rp0,00
=+ 2-1000 Current Liabilities Liability Rp0.00
=3 21100 Credit Cards Liability Fp0.00
=3 21110 Bankcard Credit Card N-T Rp0,00
=3 21120 Visa Credit Card N-T Fp0.00
=3 21200 Account Payable Accounts Papable N-T ~ Rp0,00
=4 2-1300 PPN Liabilities Liability Fpl.00
=3 21310 PPN Collected Other Current Liability N-T Rp0,00
=3 21330 PPN Pad Other Current Liabilty — |M-T Fp0.00
=3 21350 PPN Payable Other Current Liability N-T Rp0,00
=3 21400 Salary Payable Other Current Liabilty — |M-T Fp0.00
=3 21600 Customer Deposits Other Current Liability N-T Rp0,00
=3 21700 Other Curent Liabilties Other Current Liability — |N-T Fp0.00
o i Liability Rp0.00
=3 Long Term Liability N-T Fp0.00
=3 2-2200  Other Long-Term Liabilities Lang Termn Liability N-T Rp0,00

| Ea Combine Accounts

| b Do

=

Help F1

Gambar: 2. 25 Daftar akun kelompok Liability

Help F1 Budgets

Gambar: 2. 26 Daftar akun kelompok Equity

Accounts List EI
All 5 Cost of Other Other

Accounts I o I Lisbilty I ki I g I Sales I Expense I Income I Expense
Account Mame Type Tax Linked Balance

= - -

= 3-1000 Owner's Equity Equity Rp0.00

=3 31100 Renata's Capital Equity MN-T Rp0,00

=3 31200  FAenata's Drawings Equity MN-T Rp0.00

o 38000  Retained Earnings Equity MN-T w Rp0,00

o 39000  CurertYear Eamings Equity B Rp0.00

0 389933 Historical Balancing Equity MN-T w Rp0,00

'bgp | ¥ Down | E8 Combine Accounts

Accounts List

&l iahili i 3 Cost of
Accnunls] Bgzet I Liability I Equity Iinl:ome, Sales ]EEDEHSE [

Other I Other ’
Income: Expense

Account Mame Type

Sales or Fees
Cansultation Fees
Freight Collected

Late Fees Collected
Miscellanenus Income

Tan Linked Balance

| E8 Combine Accounts

£ 0 | ¥ Down

7.

Help F1 Budgets

Gambar: 2. 27 Daftar akun kelompok Income
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Accounts List EIE

Al e o i Other Other
Accounls] Agset I Liabilty I Eguity - IEﬁpense I Income: Expense

Account Mame Tax Linked Balance
5-0000_ Cost of Sales
5-1000 Labour
51100 Subcontractar Labour
51200  Other Labour
52000  Freight Cost of Sales

bgp | b Down | Eﬁ Combine Accounts

7.

Help F1 Budgets

Gambar: 2. 28 Daftar akun kelompok Cost of Sales

Accounts List
Acc%ouunls I Asset I Liability I Equity I Income I %D;:ag' I
Account Mame Type Tax Linked B alance
=3
& B0200  Other Emplover Expenses Expense N-T ~ Rp0,00
o B-1000  Accounting Fees Expense N-T Fip0.00
& B1100  Advertising & Promotion Expense N-T Rp0,00
o 61200  Bad Debt/Callection Expense Expense M-T Rp0.00
& B1210  Bank Charges Expense MN-T Rp0,00
= B1300 Commissions Expense MN-T Rp0.00
= B1400  Depreciation Expense Expense MN-T Rp0,00
= B-1500 Discounts Expense Rp0.00
=3 B-1510  Discounts Given Expense MN-T Rp0,00
=3 61520  Discounts Taken Expense MN-T Rp0.00
= B1B00  Dues & Subscriptions Expense MN-T Rp0,00
= B1700  Equipment Rental Expense MN-T Rp0.00
o B1800  Inswance Expense N-T Fp0.00
= B-2000  Late Fees Paid Expense N-T Rp0,00
o B-2100  Laundiy Expense N-T Fp0.00
= B-2200  Legal Fees Expense N-T Rp0,00
o B-2300  License & Pemits Expense N-T Fp0.00
= B-2400  Maintenance & Cleaning Expense N-T Rp0,00
o B-2500  Office Supplies Expense N-T Fp0.00
& B-2600  Photography Supplies Expense N-T Rp0,00
o B-2700  Postage Expense N-T Fp0.00
= B2800  Rent Expense N-T Rp0,00
o B-2900  Repais Expense M-T Rp0.00
& B-2950  Shiinkage/Spoilage Expenze MN-T Rp0,00
o B-3010  Staff Amenities Expense MN-T Rp0.00
o B-3030  “Wages & Salaries Expenze MN-T w Rp0,00
o B3040 Workers' Compensation Expense MN-T Rp0.00
= B3100  Telephone Expenze MN-T Rp0,00
= B-3200  Travel & Entertainment Expense MN-T Rp0.00
o B-3300  Uniforms Expenze MN-T Rp0,00
= B-3410  Elechricity Expense MN-T Rp0.00
o B3420  Gas Expenze MN-T Rp0,00
o B3430  Water Expense N-T Rp0,00
| b Do | Ea Combine Accounts
Help F1

Gambar: 2. 29 Daftar akun kelompok Expense
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Accounts List EI

Al B . Cost of {Other} Other
Accuuntsl Agzet I Liability I E quity I Income I Gales I Expense Iiﬂ 4 IExpEnsE

Account Name Type Tax Linked Balance

48-0000  Other Income
= 81000 Interest Income Other Income

U ‘ ¥ Down | B3 Combine Accounts |

m

Gambar: 2. 30 Daftar akun kelompok Other Income

Accounts List

Al o nm . Cost of Other
Accnunls] Agzet I Liability I Equity I Income I C s ]Eﬁpense I Income

Tan Linked

Account Mame Type
[£39-0000  Other Expenses | Other Expense
& 91000  Interest Expense Other Expense

| Ea Combine Accounts |

| b Do

e

Budgets

Gambar: 2. 31 Daftar akun kelompok Other Expense
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[ c. Rangkuman ]

* Terdapat 8 kategori akun. Nomor 1 s.d. 6 meliputi: Asset, Liability, Equity,
Income, Cost of Sales, Expense, 7 tidak ada, 8 other income dan 9 other
expense.

*  Menu untuk mengimport daftar akun adalah:
File > Import Data > Accounts > Account Information.

* Untuk import daftar akun diperlukan satu text file yang berisi daftar akun
yang sudah diformat dengan delimeted tab.

*  MYOB akan memberi laporan tentang keberhasilan hasil import.

* Linked account pada akun-akun tertentu hasil import akan disesuaikan
diantaranya adalah linked account untuk banking, sales, purhase dan
payroll.

* Untuk sebagian akun yang tidak digunakan akan dihapus atau akan
diedit.

Direktorat Pembinaan SMK (2013)
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Tugas 1, mengimport Daftar Akun dari file Daftar Akun RID.txt

4. Tugas 2, menyesuaikan linked account untuk Account & Banking, Sales,
Purchases, dan Payroll.

5. Tugas 3, edit akun-akun yang diperlukan dan hapus akun-akun yang
tidak digunakan. Lihat Kasus 2.3

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:

. Test Pengetahuan dan
. Tes Keterampilan

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Akun-akun pada program MYOB dibedakan dalam:
. 6 kategori

. 7 kategori

. 8 kategori

. 9 kategori

. 10 kategori

O Q0O TO

2. Akun yang termasuk kategori 1 adalah:
Account Payable

Consultation Fee

Bank charge

Account Receivable

Retained Earning

P20 TO

3. Akun yang termasuk kategori 3 adalah:
Account Payable

Consultation Fee

Bank charge

Account Receivable

Retained Earning

®”P20TW

4. Akun yang termasuk kategori 6 adalah:
a. Account Payable
b. Consultation Fee
c. Bank charge
d. Account Receivable
e. Retained Earning

5. Akun yang termasuk kategori 8 adalah:
. Interest Revenue
b. Consultation Fee
c. Bank charge
d
e

O]

. Account Receivable
. Retained Earning

Direktorat Pembinaan SMK (2013)
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6. Rumus untuk mengimport daftar akun:
a. Account Information > File > Import Data > Accounts
b. Import Data > File > Accounts > Account Information
c. File > Accounts > Import Data > Account Information
d. File > Import Data > Accounts > Account Information
e. Accounts > File > Import Data > Account Information

7. Penyesuaian linked account untuk Account Payable dan BCA Account,

adalah proses linked account untuk:

a. Sales

b. Payroll
c. Purchase
d. Account and Banking Account
e. Liability

8. Penyesuaian linked account untuk Wages & Salaries dan BCA
Account, adalah proses linked account untuk:
a. Sales
b. Payroll
c. Purchase
d. Account and Banking Account
e. Liability

9. Penyesuaian linked account untuk Historical Balancing dan
Undeposited Funds, adalah proses linked account untuk:
a. Sales
b. Payroll
c. Purchase
d. Account and Banking Account
e. Liability

10. Penyesuaian linked account untuk Account Receivable dan BCA
Account, adalah proses linked account untuk:

Sales

Payroll

Purchase

Account and Banking Account

Liability

Bulan pergantian periode akuntansi

®O oo oW
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2. Tes Keterampilan.

Buatlah daftar akun untuk perusahaan jasa Rio Interior Design
(Lihat Kasus 2.4 di Lembar Kerja Peserta didik):

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan
oleh peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan
hasil pekerjaannya dalam bentuk file.

3. Tugas 1, mengimport file : Daftar Akun RID.txt

4. Tugas 2, menyesuaikan linked accounts.

5. Tugas 3, menghapus dan mengedit akun-akun. Lihat Kasus 2. 4

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
e Kunci Tes Keterampilan

Kunci Test Pengetahuan

1 c
2 d
3 e
4 c
5 a
6 d
7 c
8 b
9 d
10 a

Direktorat Pembinaan SMK (2013)
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2. Kunci Tes Keterampilan

Daftar Akun kelompok Asset:

(@ Accounts List = e

All L Other Other
Liability Expense Income B

Account Mame Tax Linked Balance
1-0000 Assets & Rp0,00 J
1-1000 Cumnent Assets Azzet
1-1100 Caszh On Hand Azzet
11110 BCA Account Bank
11120 Pawoll Cheque Account Bank
11130 Cash Drawer Bank
11140 Petty Cash Bank
11180 Undeposited Funds Bank
11190 Electronic Clearing Account Bank
1-1200 Account Receivables [Net] Aazet
11210 Account Receivable Accounts Receivable
11220 Allowance for Doubtful Debts Accounts Receivable
1-1300 Other Current Assets Azzet
11310 Dffice Supplies [nventary Other Current Azzet
11320 Photography Supplies [nventary Other Current Azzet
11330 Prepaid Insurance Other Current Aszet
11340 Prepaid Rent Other Current Azzet
1-2000 Fixed Assets Azset
1-2100 Professional Equipment Aazet
1-2110  Prof Equipment at Cost Fiwed Aszet
1-2120  Prof Equipment Accum Dep Fixed Aszet
1-2200 Furniture & Fixtures Azzet
1-2210  Fumiture & Fistures at Cost Firxed Azzat
12220 Furniture & Fistures Accum Dep Fixed Azzet
1-2300 Motor Vehicles Azzet
12310 Motor Wehicles at Cost Firmed Azzat
1-2320  Motor Wehicles Amoartisation Fired Aszet
1-2400 Computer Equipment Aazet
12010 Computer Eguipment at Cost Fined Azzet
1-2420  Computer Eguipment dccum Dep Fixed Aszet
1-3000 Other Azzets Azzet
1-3100  Goodwil Other Agzet

D433 0000000000000000000000000000

hgp | h Drowan | Ea Combine Accounts
’ =
7. | )
Help F1 Print

Gambar: 2. 32 Kelompok Asset
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Daftar Akun kelompok Liability:

[&] Accounts List E\ |

all
Accounts

Other Other
Ihcome Expense

Expense

Account Mame Tax Linked Balance
2-0000 Liabilities 0.00 J
2.0300  Payroll Accrual: Payable Othker Lisbility
2-1000 Current Liabilities Liability
2-1100 Credit Cards Liability
23110 Bankcard Credit Card
21120 Viza Credit Card
21200 Account Payable Account: Papable
2-1300 PPN Liabilities Liability
21310 PPN Collected Other Current Liability
21330 PPM Paid Otker Current Liahbility
21350 PPN Payable Other Current Liability
21400 Salary Payable Otker Current Liahbility
21600 Customer Deposite Other Current Liability
21700 Other Current Liabilities Otker Current Liahbility
2-2000 Long-Term Liabilities Liability
22100 BCA Loans Lang Terrn Liability
22200  Other Long-Term Liabilities Long Term Liability

2LoL0000000000000

| £ Down | £ Combine Accounts

7.

Help F'I F'nnt N Budgets

Gambar: 2. 33 Kelompok Liability

Daftar Akun kelompok Equity:

@ Accounts List E'

&l

Accounts

Other

Liahility ] Incame Expense

Account Hame

3-1000 Owner's Equity
31100 Renata's Capital
31200  Renata's Drawings

38000 Retained Earnings

38000  Current Year Eamings

399939 Historical Balancing

£ Up | ¥ Down | £& Combire Accounts

7.

Help F1 F'nnt il Budgets

Gambar: 2. 34 Kelompok Equity
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Daftar Akun kelompok Income:

@ Accounts List EI =,

All Other Other
Accounts Ihcome Expensze

Ciost of

Liability Gales Expenze

Account Mame Type Tax Linked Balance
4-0000_Income I ] - |
Sales or Fees
Consultation Fees
Freight Collected
Late Fees Collected
Mizcelaneous lncome

£ Up | ¥ Down | £& Combire Accounts

7 =
7. |
Help F1 Frint

Gambar: 2. 35 Kelompok Income

Daftar Akun kelompok Cost of Sales:

@ Accounts List IEI LT

All Other
Accounts Expense

Liability

Account Mame Tax Linked Balance
5-0000 Cost of Sales f
51000 Labour
51100 Subcontractor Labour Cost of Sales
51200  Other Labour Cost of Sales
5-2000  Freight Cost of Sales

£ | & Down | 8 Combine Accounts
;? - . '
7. )
Help F1 Frint Budgets

Gambar: 2. 36 Kelompok Cost of Sales

Direktorat Pembinaan SMK (2013) 51




Komputer Akuntansi Jilid 1

Daftar Akun kelompok Expense:

@ Accounts List EI X

All Cozt of ; Other Other
Accounts Sales Ihcome Expensze

Liability Inhcome

Type Tax Linked Balance
E:-: 13- :_.: :

Other Employer Expenses Expense J
Accounting Fees Expenze
Advertising & Promation Expense

Bad Debt/Collection Expense Expense

Bank Charges Expenze
Commizsions Expenze
Depreciation Expense Expense
Discounts Expenze

B-1510  Dizcounts Given Expenze
61520  Dizcounts Taken Expense
B-1600  Dues & Subszcriptions Expenze
B-1700  Equipment Rental Expenze
E-1800  Insurance Expenze
B-2000  Late Fees Paid Expenze
E-2100  Laundm Expenze
E-2200  Legal Fees Expenze
B-2300  Licensze & Permits Expenze
E-2400  Maintenance & Cleaning Expense
B-2500  Office Supplies Expenze
BE-2600  Phatography Supplies Expense
E-2700  Postage Expense
E-2800  Rent Expenze
E-2300  Repairs Expense
E-2350  Shinkage/Spoilage Expense
B-3010  Staff Amenities Expenze
B-3030 “Wages & Salaries Expenze
E-3040  “workers' Compensation Expense
B-3100  Telephone Expenze
B-3200  Travel & Entertainment Expenze
E-3300  Unifarms Expense
B-3410  Electricity Expenze
B-3420  Gas Expenze
E-3430  ‘Water Expenze

4430000033000 0000000303000000000000400

£ p | B Down | E& Combine Accounts
:.? - y e
'_)l)v EJ = =
Help F1 Frint Budgets

Gambar: 2. 37 Kelompok Expense
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@ Accounts List

Al
Accounts

Liahility

Ciost of

Income
- Sales

Account Mame
=3 8-0000 Other Income
o 81000 Interest Incomne

Type
| Dther |
Other Incaorme

hﬁp | ¥ Down

| 3 Combine Accounts |

9) =
7. |
Help F1 Frint

Budgets

Gambar: 2. 38 Kelompok Other Income

Daftar Akun kelompok Other Expense:

@ Accounts List

Accounts

= Liability

Ciost of

Income
- Salez

Other
Income

"fither
Expense

Account Mame

o 91000  Interest Expensze

Type
| Dther E:
Other Expense

Tax Linked

Balance

| ¥ Down

& Up

| £8 Combire Accounts |

7 =
7. | g
Help F1 Erint

Budgets

Gambar: 2. 39 Kelompok Other Expense
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 2.1

Daftar akun perusahaan jasa Renata Interior Designer
e Import Text file : Daftar Akun RID.txt

e Penyesuaian linked account

e Hapus dan edit akun-akun

Renata Interior Design.

Daftar Akun.
Account No. Account Name Header Account Type
10000 Assets H Asset
11000 Current Assets H Asset
11100 Cash On Hand H Asset
11110 BCA Account Bank
11120 Payroll Cheque Account Bank
11130 Cash Drawer Bank
11140 Petty Cash Bank
11180 Undeposited Funds Bank
11190 Electronic Clearing Account Bank
11200 Account Receivables (Net) H Asset
11210 Account Receivable Accounts Receivable
11220 Allowance for Doubtful Debts Accounts Receivable
11300 Other Current Assets H Asset
11310 Office Supplies Inventory Other Current Asset
11320 Photography Supplies Other Current Asset
Inventory
11330 Prepaid Insurance Other Current Asset
11340 Prepaid Rent Other Current Asset
12000 Fixed Assets H Asset
12100 Professional Equipment H Asset
12110 Prof Equipment at Cost Fixed Asset
12120 Prof Equipment Accum Dep Fixed Asset
12200 Furniture & Fixtures H Asset

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

Account No. Account Name Header Account Type
12210 Furniture & Fixtures at Cost Fixed Asset
12220 Furniture & Fixtures Accum Fixed Asset
Dep
12300 Motor Vehicles H Asset
12310 Motor Vehicles at Cost Fixed Asset
12320 Motor Vehicles Amortisation Fixed Asset
12400 Computer Equipment H Asset
12410 Computer Equipment at Cost Fixed Asset
12420 Computer Equipment Accum Fixed Asset
De
13000 Otr:)er Assets H Asset
13100 Goodwill Other Asset
20000 Liabilities H Liability
21000 Current Liabilities H Liability
21100 Credit Cards H Liability
21110 Bankcard Credit Card
21120 Visa Credit Card
21200 Account Payable Accounts Payable
21300 PPN Liabilities H Liability
21310 PPN Collected Other Current Liability
21330 PPN Paid Other Current Liability
21400 Salary Payable Other Current Liability
21600 Customer Deposits Other Current Liability
21700 Other Current Liabilities Other Current Liability
22000 Long-Term Liabilities H Liability
22100 BCA Loans Long Term Liability
22200 Other Long-Term Liabilities Long Term Liability
30000 Equity H Equity
31000 Owner's Equity H Equity
31100 Renata's Capital Equity
31200 Renata's Drawings Equity
38000 Retained Earnings Equity
39000 Current Year Earnings Equity
39999 Historical Balancing Equity
40000 Income H Income
41000 Sales or Fees Income
42000 Consultation Fees Income
43000 Freight Collected Income
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Account No. Account Name Header Account Type
44000 Late Fees Collected Income
45000 Miscellaneous Income Income
50000 Cost of Sales H Cost of Sales
51000 Labour H Cost of Sales
51100 Subcontractor Labour Cost of Sales
51200 Other Labour Cost of Sales
52000 Freight Cost of Sales
60000 Expenses H Expense
61000 Accounting Fees Expense
61100 Advertising & Promotion Expense
61200 Bad Debt/Collection Expense Expense
61210 Bank Charges Expense
61300 Commissions Expense
61400 Depreciation Expense Expense
61500 Discounts H Expense
61510 Discounts Given Expense
61520 Discounts Taken Expense
61600 Dues & Subscriptions Expense
61700 Equipment Rental Expense
61800 Insurance Expense
62000 Late Fees Paid Expense
62100 Laundry Expense
62200 Legal Fees Expense
62300 License & Permits Expense
62400 Maintenance & Cleaning Expense
62500 Office Supplies Expense
62600 Photography Supplies Expense
62700 Postage Expense
62800 Rent Expense
62900 Repairs Expense
62950 Shrinkage/Spoilage Expense
63010 Staff Amenities Expense
63030 Wages & Salaries Expense
63040 Workers' Compensation Expense
63100 Telephone Expense
63200 Travel & Entertainment Expense
63300 Uniforms Expense
63410 Electricity Expense
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Account No. Account Name Header Account Type
63420 Gas Expense
63430 Water Expense
80000 Other Income H Other Income
81000 Interest Income Other Income
90000 Other Expenses H Other Expense
91000 Interest Expense Other Expense

Tabel: 2- 2 Daftar Akun

Kasus 2.2

Daftar akun (hasil import) dari perusahaan Renata Interior Designer
Linked Accounts: SALES, PURCHASES, PAYROLLS

Kasus 2.3
Akun-akun yang perlu dihapus!

Kode Nama Akun Kode Nama Akun
1-0100  Cheque Account 2-0300 Payroll Accrual Payable
1-0150  Provision Account 3-0999 Historical Balancing
1-0160  Investment Account 3-8000 Retained Earnings
1-0180  Undeposited Funds 3-9000 Current Year Earning
1-0190  Electronic Clearing 6-0100 Wages and Salaries

Account
1-0200 Trade Debtors 6-0200 Other Employer Expense
2-0200 Trade Creditors
Akun-akun yang harus diedit
3-0800 Retained Earnings » 3-8000 Retained Earnings
3-0900 Current Year Earning » 3-9000 Current Year Earning

Tabel: 2- 3 Daftar Akun
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Kasus 2.4
Akun-akun yang perlu dihapus!

Kode Nama Akun Kode Nama Akun
1-0100  Cheque Account 2-0300 Payroll Accrual Payable
1-0150  Provision Account 3-0999 Historical Balancing
1-0160  Investment Account 3-8000 Retained Earnings
1-0180  Undeposited Funds 3-9000 Current Year Earning
1-0190  Electronic Clearing 6-0100 Wages and Salaries

Account
1-0200 Trade Debtors 6-0200 Other Employer Expense
2-0200 Trade Creditors
Akun-akun yang harus diedit
3-0800 Retained Earnings »  3-8000 Retained Earnings

3-0900

Current Year Earning  »  3-9000

Current Year Earning

Tabel: 2- 4 Daftar Akun
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KEGIATAN BELAJAR 3
MENYESUAIKAN PAJAK

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir sesi ini
diharapkan peserta didik dapat:

1. Mengidentifikasi karakteristik perusahaan jasa
Menjelaskan fungsi daftar akun
Menjelaskan klasifikasi akun

Menjelaskan sistem pengkodean akun

CIE

Menyusun daftar akun perusahaan jasa

{ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:
Karakteristik perusahaan jasa
Fungsi daftar akun

Klasifikasi akun

Sistem pengkodean akun

S

Penyusunan daftar akun perusahaan jasa
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1. Pajak Pertambahan Nilai

Yang dimaksudkan dengan pajak di sini adalah Pajak Pertambahan Nilai
(PPN). PPN adalah pajak yang dikenakan tidak hanya atas konsumsi barang
kena pajak tetapi juga jasa kena pajak. Jadi perusahaan yang menjual
layanan jasa kepada orang pribadi, perusahaan, maupun pemerintah harus
dikenakan PPN sebesar tarif PPN, yaitu 10% dari nilai jual jasa yang
dikonsumsi.

Program MYOB telah menyediakan fasilitas yang menghitung besarnya pajak
(PPN) secara otomatis setiap terjadi penjualan jasa, yaitu yang disingkat
dengan GST (Goods and Services Tax). Oleh sebab itu diperlukan adanya
penyesuaian terhadap pajak ini.

Disamping itu masih ada satu jenis pajak lagi yang disediakan oleh MYOB
yang bisa dimanfaatkan, yaitu N-T (Not Reportable). Jenis pajak ini akan
digunakan untuk menandai item-item atau transaksi-transaksi yang tidak
terkena pajak.

2. Menghapus Pajak yang Tidak Digunakan

Daftar pajak yang ditampilkan oleh program MYOB v18 (versi Australia)
adalah jenis-jenis pajak yang berlaku di Australia, oleh sebab itu jenis-
jenis pajak yang tidak digunakan di Indonesia perlu dihapus.

Kasus

Jenis-jenis pajak berikut ini tidak berlaku di Indonesia, oleh sebab itu
perlu dihapus.

Code Description Type Rate
EXP GST Free Exports Good & Services Tax 0%
FRE GST Free Good & Services Tax 0%
GCA  GST on Capital Aquisition Good & Services Tax 10%
INP Input Taxed Purchases Input Taxed 10%
ITS Input Taxed Sales Good & Services Tax 0%
NTD Non Tax Deductible Input Taxed 0%
PRI GST Private Use Good & Services Tax 10%

H Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

Langkah-langkah menghapus pajak yang tidak digunakan:

1 Klik List, dan Tax Codes untuk menampilkan daftar pajak

G5T on Capital Acquigitions Goods & Services Tax
Goods & Services Tax Goods & Services Tax
Input Taxed Purchases Input Taxed

Input Taxed Sales Goods & Services Tax
Mot Repartable Goods & Services Tax
Mon Tax Deductible Input T axed

GST Private Use Goods & Services Tax

? o

Help F1 Frint

Gambar: 2. 40 Daftar pajak di Australia

2 Hapus dengan memilih satu jenis pajak misalnya PRI (GST Private
Use) dan klik kanan-mouse, kemudian klik Delete.

--—--—_.~

‘l

Gambar: 2. 41 Menghapus jenis Pajak PRI.

4 Ulangi cara yang sama untuk menghapus jenis pajak yang lainnya
hingga tersisa dua jenis pajak: GST dan N-T.
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3. Mengedit Jenis Pajak yang Digunakan

Daftar pajak yang ditampilkan oleh program MYOB v18 (versi Australia) adalah
jenis-jenis pajak yang berlaku di Australia, oleh sebab itu perlu disesuaikan
dengan pajak-pajak yang berlaku di Indonesia.

Kasus

Jenis-jenis pajak berikut ini bisa digunakan di Indonesia, tetapi perlu
diedit.

Code Description Type Rate
GST Good & Services Tax Good & Services Tax 10%
N-T  Non Reportable Good & Services Tax 0%

Langkah-langkah mengedit pajak yang digunakan:

1 Klik GST dan Edit untuk mengedit jenis pajak GST diganti dengan
PPN
2 Pilih akun PPN Collected dan PPN paid untuk linked account
Gambar: 2. 42 Mengedit GST menjadi PPN
3 Klik OK untuk mengakhiri.
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[ c. Rangkuman ]

o Jenis pajak GST (Goods and Services Tax) yang disediakan MYOB dapat
diubah menjadi PPN (Pajak Pertambahan Nilai) karena kedua jenis pajak
ini sama yaitu sebesar 10% dihitung dari total penjualan jasa.

o Jenis pajak yang lainnya (pada MYOB) yaitu NT (Not Reportable) juga
dapat dimanfaatkan untuk item-item atau transaksi yang tidak terkena
pajak.

o Jenis-jenis yang lainnya yang tidak digunakan di Indonesia dapat dihapus
dari daftar pajak.

o MYOB menyediakan menu untuk menyesuaikan (edit) atau menambah
jenis pajak baru melalui:

List > Tax Codes.
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{ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Tugas 1, menghapus jenis-jenis pajak yang tidak digunakan (lihat
Kasus 3.1 di lembar kerja peserta didik)

4. Tugas 2, menyesuaikan GST menjadi PPN
5. Tugas 3, Menyesuaikan linked account untuk PPN
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:

. Test Pengetahuan dan
. Tes Keterampilan

1.Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. GST adalah singkatan dari:
a. Gross and Services Tax
b. Good and Services Tax
c. Goods and Services Tax
d
e

. Goods and Social Tax
. Goods and Sercives Type

2. Jenis pajak GST yang disediakan oleh program MYOB sama dengan :
PPh (Pajak Penghasilan)

PPh (Pajak Penghasilan)

PPN (Pajak Pertambahan Nilai)

PPN (Pajak Pertambahan Nilai)

PPn (Pajak penjualan)

3. Tarif GST atau PPN adalah:
a. 25%

b. 5%

c. 15%

d. 10%

e. 35%

PQO0T®

4. Jenis pajak N-T adalah singkatan dari:
No Tax

Not Tax

Not Reportable

No Reportable

Not Taxable

®o0TD

5. Jika total penjualan jasa sebesar Rp. 27.500.000,- (including Tax) maka
besarnya PPN adalah:

Rp. 2.750.000,-

Rp. 1.375.000,-

Rp. 2.500.000,-

Rp. 5.000.000,-

Rp. 1.250.000,-

P20 T®
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6. Jika total penjualan jasa sebesar Rp. 27.500.000,- (including Tax) maka
besarnya pendapatan dari penjualan jasa adalah:
a. Rp. 27.500.000,-
b. Rp. 25.375.000,-
c. Rp.22.500.000,-
d. Rp. 25.000.000,-
e. Rp. 21.250.000,-

7. Jika total penjualan jasa sebesar Rp. 27.500.000,- (excluding Tax) maka
besarnya PPN adalah:

. Rp. 2.750.000,-

b. Rp. 1.375.000,-

c. Rp. 2.500.000,-

d. Rp. 5.000.000,-

e. Rp. 1.250.000,-

8. Menu yang digunakan untuk mengedit atau menghapus jenis-jenis pajak
adalah:
a. Setup > List > Tax Codes
b. List > Setup > Tax Codes
c. Tax Codes > List
d. List > Tax Codes
e. Setup > Tax Codes > List

O]

9. Akun GST Collected sinonim dengan:
. PPN Outcome and Income

b. PPN Income
c. PPN Paid

d. GSTIn

e. PPN Keluaran

O]

10. Akun GST Paid sinonim dengan:
PPN Outcome and Income
PPN Masukan

GST Out

PPN Outcome

PPN Keluaran

®Pa0TO
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2.Tes Keterampilan.

Sesuaikan daftar pajak pada MYOB dengan Pajak yang berlaku di Indonesia
(Lihat Kasus 3.1 di lembar kerja peserta didik):

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, menghapus pajak-pajak yang tidak berlaku

4. Tugas 2, menyesuaikan pajak GST menjadi PPN.

5. Tugas 3, menyesuaikan linked accounts.
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

1 (o}
2 d
3 d
4 (o}
5 c
6 d
7 a
8 d
9 e
10 b
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2. Kunci Tes Keterampilan

P

(8] Tax Code List

Dezcription
Mot Bepaortable
o PPN Pajak Perttambahan Milai

Gambar: 2. 43 Daftar Pajak yang disesuaian

r-

(&] Tax Code Information EI X

T ax Code Infarmation

Enter the tax code [up to three characters), a brief description of the tax and the rate of tas.
Select an appropriate tax type and complete the links as necessany.

Tax Code: ||FEE

Deszcription: | Fajak Pertambahan Milai

Tax Tupe: | Goods & Services Tax -

Fate: 10%

Linked Account for Tax Collected =2: | 2-1310 = PPN Callected
Linked Account for Tax Paid == | 2-1330 = PPM Paid

Linked Card for Tax Authority |

Gambar: 2. 44 Penyesuaian PPN
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta
didik di komputer melalui program MYOB versi 18.

Kasus 3.1.

Jenis-jenis pajak berikut ini tidak berlaku di Indonesia, oleh sebab itu perlu
dihapus.

Code Description Type Rate
EXP  GST Free Exports Good & Services Tax 0%
FRE GST Free Good & Services Tax 0%
GCA GST on Capital Aquisition Good & Services Tax 10%
INP Input Taxed Purchases Input Taxed 10%
ITS Input Taxed Sales Good & Services Tax 0%
NTD Non Tax Deductible Input Taxed 0%
PRI GST Private Use Good & Services Tax 10%

Jenis-jenis pajak berikut ini bisa digunakan di Indonesia, tetapi perlu diedit.

Code Description Type Rate

GST Good & Services Tax Good & Services Tax 10%

N-T Non Reportable Good & Services Tax 0%
Catatan:

GST diubah menjadi PPN.
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KEGIATAN BELAJAR 4
MENGENTRI SALDO AWAL

{ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan
belajar ini diharap-kan peserta didik dapat:

1. Menjelaskan penentuan bulan konversi dan tanggal pencatatan bulan
konversi
Menyebutkan menu untuk pencatatan saldo awal

Mencatat saldo awal

{ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:
1. Bulan konversi dan tanggal entri saldo awal
2. Menu pencatatan saldo awal
3. Pencatatan saldo awal
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1. Penentuan Bulan Konversi dan Tanggal Entri Saldo Awal.

Pengisian bulan konversi yang dilakukan pada saat pembuatan file data baru
berpengaruh pada pengentrian saldo awal. Bila bulan konversi ditentukan
Januari maka secara otomatis MYOB mencatat tanggal pengentrian saldo awal
adalah 1 Januari. Bila bulan konversi diisi Desember maka ini berarti bahwa
saldo awal akan dientri pada tanggal 1 Desember.

Jika bulan konversi ditentukan pada bulan Juli atau Januari maka MYOB hanya
mencatat saldo akun-akun riil (akun neraca) dan tidak menerima akun-akun
nominal (akun laba-rugi). MYOB akan menerima saldo kelompok akun riil dan
nominal, hanya apabila bulan konversi ditentukan bukan bulan Januari atau
Juli.

Apabila ada kasus dimana saldo awal meliputi saldo dari akun-akun riil dan
nominal sedang bulan konversi ditentukan bulan Juli atau Januari, maka cara
pecatatannya adalah sebagai berikut:

a. Saldo akun-akun riil dientri melalui menu pencatatan saldo awal (Accounts
Opening Balances) yang disediakan oleh MYOB. Tentunya ini akan terjadi
ketidak-seimbangan dimana ditunjukkan pada saldo Akun Historical
Balancing sejumlah angka tertentu (bukan 0).

b. Saldo akun-akun nominal dientri melalui jurnal umum (Record Journal
Entry). Tentunya jumlah debet dan kreditnya akan terlihat tidak seimbang.
Sebagai penyeimbangnya adalah akun Historical Balancing, yaitu sejumlah
selisihnya.

2. Menu untuk Entri Saldo Awal

Menu yang digunakan untuk entri saldo awal adalah sebagai berikut:

Gambar: 2. 45 Menu Entri Saldo Awal
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3. Pencatatan Saldo Awal

Program MYOB memberi fasilitas Accounts Opening Balances untuk mengentri
saldo awal akun buku besar dan sekaligus mengecek kesamaan total debet
dan kreditnya.

Langkah-langkah mengentri saldo Neraca Awal:

1 Klik Setup, Balances, Accounts Opening Balances

Gambar: 2. 46 Setup Account Opening Balances

2 Ketik saldo untuk akun-akun. Caranya ketik saldo sesuai dengan
nama akun, misalnya akun BCA Account jumlah saldonya
45.000.000,- diketik 45000000 dan press Enter.

Untuk Cash Drawer ketik 10000000 dan press Enter. Untuk Petty
Cash ketik 5000000 dan press Enter. Dst

Account Opening Balances EI

Enter the balance of your accounts az of 01/01/2013 [Balance Sheet Only).

[Femember, enter all balances as positive numbers, unless the balance really was negative.)

Mame Opening Balance

BCA Account

Fayroll Cheque Account

Cazh Drawer Fip10.000.000.00
Fetty Cash Fip5.000.000.00
Undeposited Funds Rp0.00

Electronic Clearing Account Fp0,00
Account Becervable Fp0,00
Allowance for Doubtful Debts Rp.00

Gambar: 2. 47 Account Opening Balances
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4 Khusus untuk saldo akun-akun kotra diketik didahului dengan —
(minus) diikuti jumlah uangnya, contoh saldo akun Prof Equipment
Accum. Depre. diketik: —=7000000 (minus 7000000) atau saldo akun
Renata’s Drawings diketik -17500000 (minus 17500000).

@ Account Opening Balances EI x

Enter the balance of your accounts ag of 01,/01/2013 [Ealance Sheet Only).

[Remember. enter all balances as positive numbers, unless the balance really was negative.]

MHame Opening Balance
Electronic Clearing Account Rp0.00
Account Beceivable Fp0,00
Allowance for Doubtful Debts Fp0,00
Office Supplies Inventom Rp5.250.000,00
Fhatography Supplies [nventory Rp10.000.000,00
Prepaid Insurance Fp0.00
Frepaid Rent Fip0,00
Prof Equipment at Cost Fip35.000.000.00
Prof Equipment Accum Dep 7000000

Amount left to be allocated: Rp0,00
Thiz will be the Opening Balance of the Histarical Balancing Account.

Help F1

Gambar: 2. 48 Account Opening Balances

5 Jika semua saldo akun sudah dientri, maka catatan yang ada
dibawah : Amount left to be allocated sebanyak 0 (nol). Jika tidak
maka terjadi ketidak seimbangan saldo neraca

@ Account Opening Balances EIE

Enter the balance of your accounts ag of 01/01/2013 [Ealance Sheet Only).

[Remember, enter all balances as positive numbers, unless the balance really was negative.]

Acct # MName Opening Balance

21400 Salary Papable Rp5.050.000,00

21800 Customer Deposit Rp0,00

2-1700 Other Current Liabilties Rp0.00

total Dr = 2-2100 ECA Loans Rp50.000.000,00

otal Lr = 22200 Other Long-Tem Liabilties Fip0.00
total Cr Equity

31100 Fenata's Capita Fip100.000.000.00
31200 Fenata's Drawings [Rp17.500.000,00]

3-8000 R etained E arnings Rp0.00

Amount left to be allocated: Rp0,00
This will be the Opening Balance of the Hiztorical Balancing dccount.

1.

Help F1

Gambar: 2. 49 Neraca yang seimbang

6 Klik OK untuk mengakhiri
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[ c. Rangkuman ]

¢ Pada MYOB, pemilihan bulan konversi ditentukan oleh tanggal saldo awal.
Jika tanggal saldo awal 1 Januari 2013 maka bulan konversi hendaknya
dipilih Januari.

e Apabila bulan konversi ditentukan Januari atau Juli maka hanya saldo
akun-akun riil yang bisa dientri ke dalam “Account Opening Balances”.

o Jika dalam daftar saldo awal terdapat kelopok akun riil dan akun nominal
dan bulan konversi ditentukan bulan Januari atau Juli maka entri saldo
awal dilakukan melaui dua cara, pertama melalui “Account Opening
Balances” dan yang kedua melalui Record Journal Entry.

e Yang perlu diperhatikan dalam entri saldo awal adalah adanya akun-akun
kontra. Saldo akun kontra dientri dengan memberikan tanda — (minus) di
awal angka saldonya.

e Menu yang digunakan untuk entri saldo awal adalah:

Setup > Balances > Accounts Opening Balances.
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk menyelesaikan tugas berikut ini.

4. Tugas 1, mengentri saldo awal akun-akun asset

5. Tugas 2, mengentri saldo awal akun-akun liability

6. Tugas 3, mengentri saldo awal akun-akun equity

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:
. Test Pengetahuan dan
. Tes Keterampilan
1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Dalam pembuatan file data baru ditentukan, Tahun periode: 2013, bulan
konversi ditentukan bulan Desember, maka MYOB akan mencatat saldo
awal pada tanggal:

. 1 Januari 2013

. 1 Nopember 2013

. 1 Desember 2013

. 31 Desember 2013

. 1 Januari 2014

2. Dalam kasus ditunjukkan bahwa data saldo awal tercatat pada tanggal 30
Nopember 2013, maka sebaiknya bulan konversi yang dipilih adalah:
a. Oktober
b. Nopember
c. Desember
d. Januari
e. Pebruari

O Q0O TO

3. Jika bulan konversi ditentukan Desember, maka saldo-saldo akun yang
dapat dientri adalah:
a. Hanya saldo Nominal
b. Hanya saldo Rill
c. Saldo Nominal dan Saldo Riil
d. Tidak ada saldo yang dapat dientri
e. Saldo Neraca

4. Jika bulan konversi ditentukan Januari, maka saldo-saldo akun yang dapat
dientri adalah:

Hanya saldo Nominal

Hanya saldo Rill

Saldo Nominal dan Saldo Riil

Tidak ada saldo yang dapat dientri

Saldo Laba-Rugi

®20TY

Direktorat Pembinaan SMK (2013)
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5. Jika bulan konversi ditentukan Juli, maka saldo-saldo akun yang dapat
dientri adalah:

. Hanya saldo Nominal

b. Hanya saldo Rill

c. Saldo Nominal dan Saldo Riil

d. Tidak ada saldo yang dapat dientri

e. Saldo Laba-Rugi

6. Yang dimaksudkan dengan akun kontra
a. Akun-akun debet
b. Akun-akun kredit
c. Akun-akun Riil
d. Akun-akun Nominal
e. Akun lawan, sebagai pengurang.

O]

7. Yang termasuk akun kontra di bawah ini adalah:
Account Receivable

Account Payable

Provision on Doubtful Debt

Investment

Bank Loan

©a0TO

8. Cara pencatatan saldo akun kontra adalah
Dicatat di sebelah debet

Dicatat di sebelah kredit

Dicatat dengan angka plus

Dicatat dengan angka minus

Dicatat terbalik

P00 W

9. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing
terdapat saldo Rp. 550.000,- ini memberi tanda:
a. Terdapat kesalahan input sebesar Rp. 550.000,-
b. Jumlah debet lebih kecil sebesar Rp. 550.000,-
c. Jumlah debet lebih besar sebesar Rp. 550.000,-
d. Terdapat kelebihan kredit sebesar Rp. 550.000,-
e. Tidak bermasalah, karena itu adalah saldo akun tersebut.

10. Menu untuk entri saldo awal adalah:

Setup > Balances > Accounts Opening Balances
Setup > Accounts > Opening Balances Balances
Balances > Setup > Accounts Opening Balances
Accounts Opening Balances > Setup > Balances
Account > Balances > Accounts Opening Balances

U T

Direktorat Pembinaan SMK (2013)




2. Tes Keterampilan.

Komputer Akuntansi Jilid 1

Didasarkan pada kasus: Rio Interior Design, kerjakan tes ini dengan ketentuan
sebagai berikut:

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, mengentri saldo awal akun-akun asset

4. Tugas 2, mengentri saldo awal akun-akun liability

5. Tugas 3, mengentri saldo awal akun-akun equity

Direktorat Pembinaan SMK (2013)
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

Soal No. Jawaban

1 (o}
2 o]
3 c
4 b
5 b
6 e
7 c
8 d
9 o]
10 a

ﬂ Direktorat Pembinaan SMK (2013)




2. Kunci Tes Keterampilan

Acct #

@ Account Opening Balances

Mame

(o] & |

Enter the balance of vour accounts as of 01/01/2014 [Balance Sheet Only).

[Remember, enter all balances as positive numbers, unless the balance really was negative.]

Opening Balance

Asszet
11110
11120
11120
1-1140
1-1180
1-1190
11210
11220
11310
11320
11320
1-1340
1-2110
1-2120
1-2210
1-2220
1-2310
1-2320
1-2410
1-2420
1-3100

Liability
20300
21110
21120
21200
21310
21320
21350
2-1400
21600
21700
22100
2-2200

Equity
31100
31200
3-8000

Gambar: 2. 50 Neraca Saldo Rio Interior Design

BCA Account

Payroll Cheque Account

Cazh Drawer

Petty Cazh

Undeposited Funds

Electronic Clearnng Account
Account Receivable
Allowance for Doubtful Debts
Office Supplies Inventary
Phatography Supplies [nventary
Prepaid Insurance

Prepaid Rent

Prof Equipment at Cost

Prof Equipment Accum Dep
Furniture & Fistures at Cost
Furniture & Fistures Accum Dep
Motor Yehicles at Cost

Motor Yehicles Amortization
Computer Equipment at Cosgt
Computer Equipment Aaccum Dep
Goodwil

Payraoll Accruals Payable
Bankcard

Wiza

Account Payable

FPPM Collected

FPM Paid

PPM Papable

Salary Payable
Cuzstomer D eposits
Other Current Liabilities
BCA Loans

Other Long-Term Lisbilities

FRenata's Capital
Renata's Drawings
Retained E armings

R p45.000.000,00
Rp0,00
Rp10.000.000,00
Fip5.000.000,00
Fp0,00

Rp0,00

Rp0.00

Rp0.00
Fipb.250.000,00
Rp10.000.000,00
Rp0,00

Rp0,00

R p36.000.000,00
[Rp7.000.000,00)
Rp32.000.000,00
[Rp6.400.000,00)
Rp0.00

Rp0,00
Rp37.000.000,00
[Rp14.800.000.00]
Rp0,00

Rp0.00
Fipk.000.000,00
Rp0.00

Rp0.00

Rp0.00

Rp0,00
Fip7.500.000.00
Fip5.050.000.00
Rp0.00

Rp0.00
Rp&0.000.000,00
Rp0.00

Rp100.000.000,00
[Rp17.500.000.00]
Rp0.00

Amount left to be allocated: Rp0,00
Thiz will be the Opening Balance of the Historical B alancing Account.

Direktorat Pembinaan SMK (2013)
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 1.

Perusahaan jasa: Renata Interior Designer

Neraca Saldo per 1 Januari 2013

Nama Akun Debet (Rp.) Kredit (Rp.)

BCA Account 45.000.000

Cash Drawer 10.000.000

Petty Cash 5.000.000

Office Supplies Inventory 5.250.000

Photography Supplies Inventory 10.000.000

Prof Equipment at Cost 35.000.000

Prof Equipment Accum Dep 7.000.000

Furniture and Fixtures at Cost 32.000.000

Furniture and Fixtures Accum Dep 6.400.000

Computer Equipment at Cost 37.000.000

Computer Equipment Accum Dep 14.800.000

Bankcard 6.000.000

Wage/Salary Payable 5.050.000

PPN Payable 7.500.000

BCA Loans 50.000.000

Renata’s Drawings 17.500.000

Renata’s Capital 100.000.000
Total 196.750.000 196.750.000

Tabel: 2- 5 Neraca Saldo Renata Interior Designer

Direktorat Pembinaan SMK (2013)
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E] Account Opening Balances

oG]

Enter the balance of vour accounts az of 01/01/2013 [Balance Sheet Only).

[Remember, enter all balances as positive numbers, unless the balance really was negative. ]

Acct #

Mame

Opening Balance

Asselt
11110
11120
11130
1-1140
111380
1-1190
11210
11220
11310
11320
1-1330
1-1340
1-2110
1-2120
1-2210
1-2220
1-2310
1-2320
1-2410
1-2420
1-3100

Liability
21110
21120
21200
21310
21330
21350
21400
21600
21700
2-2100
2-2200

E quity
31100
31200
3-8000

BCA Account

Payroll Cheque Account

Cazh Drawer

Petty Cazh

IIndeposited Funds

Electronic Clearing Account
Account Receivable
Allowance for Doubtful Debts
Office Supplies [meentary
Phaotography Supplies [rventony
Frepaid Insurance

Prepaid Rent

Fraf Equipment at Cost

Praf Equipment Accum Dep
Furiture & Fiatures at Cost
Furniture & Fistures Accum Dep
Motor Yehicle: at Cost

kotor Yehicle: Amartization
Computer Equipment at Cost
Computer Equipment Accum Dep
Goodwill

Bankzard

Yiza

Account Payable

FPM Callected

FPM Paid

FPM Payable

Salary Payable
Customner Depogits
Other Current Liabilities
BCA Loans

Other Long-Term Liabilities

FRenata's Capital
Renata's Drawings
Hetained E arnings

Fip45.000.000,00
Rp0,00
Fip10.000.000,00
Rp5.000.000.00
Rp0.00

Rp0.00

Rp0.00

Fp0,00
Rp5.250.000,00
Fip10.000.000,00
Rp0,00

Rp0.00
Fip26.000.000,00
[Rp?.000.000,00)
Fip32.000.000,00
[FipE. 400.000,00)
Rp0.00

Rp0,00
Rp27.000.000,00
[Rp14.200.000,00)
Rp0.00

R pE.000.000,00
Rp0.00

Rp0,00

Rp0.00

Rp0.00
Rp?7.500.000,00
Rp5.050.000,00
Rp0,00

Rp0.00
Rp&0.000.000,00
Rp0.00

Fp100.000.000,00
[Fp17.500.000,00]
Fpl.00

Amaunt left to be alocated: Rp0,00
Thiz will be the Opening Balance of the Historical B alancing Account.

Gambar: 2. 51 Neraca Saldo Kasus 1 Renata Interior Designer

Direktorat Pembinaan SMK (2013)
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Kunci Jawaban Kasus 1 Renata Interior Designer
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Kasus 2.
Perusahaan jasa: Rio Interior Design

Neraca Saldo per 1 Januari 2014

Nama Akun Debet (Rp.) Kredit (Rp.)
BCA Account 45.000.000
Cash Drawer 10.000.000
Petty Cash 5.000.000
Office Supplies Inventory 5.250.000
Photography Supplies Inventory 10.000.000
Prof Equipment at Cost 35.000.000
Prof Equipment Accum Dep 7.000.000
Furniture and Fixtures at Cost 32.000.000
Furniture and Fixtures Accum Dep 6.400.000
Computer Equipment at Cost 37.000.000
Computer Equipment Accum Dep 14.800.000
Bankcard 6.000.000
Wage/Salary Payable 5.050.000
PPN Payable 7.500.000
BCA Loans 50.000.000
Renata’s Drawings 17.500.000
Renata’s Capital 100.000.000

Total 196.750.000 196.750.000

Tabel: 2- 6 Neraca Saldo Rio Interior Design

Direktorat Pembinaan SMK (2013)
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KEGIATAN BELAJAR 5
MENCATAT TRANSAKSI
PEMBAYARAN

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan
belajar ini diharap-kan peserta didik dapat:

Mendefinisikan transaksi pembayaran
. Menunjukan menu untuk mencatat transaksi pembayaran

. Mencatat pembayaran dengan cek

1.
2
3
4. Mencatat pembayaran dengan kas kecil
5. Mencatat pembayaran dengan bankcard
6

. Memeriksa jurnal transaksi pembayaran

[ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:

Pengertian transaksi pembayaran

Menu untuk mencatat transaksi pembayaran
Pencatatan pembayaran dengan cek
Pencatatan pembayaran dengan kas kecil

Pencatatan pembayaran dengan bankcard

o gk wbd =

Pemeriksaan Jurnal transaksi pembayaran

Direktorat Pembinaan SMK (2013)
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1. Pengertian Transaksi Pembayaran

Perusahaan jasa dalam operasinya, selalu melakukan transaksi pembayaran.
Yang dimaksud dengan transaksi pembayaran dalam hal ini adalah kegiatan
pengeluaran uang untuk Kkeperluan operasi perusahaan, misalnya untuk
pembelian supplies, pembayaran beban sewa, beban listrik, telepon, beban
iklan, beban gaji dsb.

Pada umumnya perusahaan menggunakan 3 (tiga) cara pembayaran yaitu:

a. Pembayaran dengan Cek (cash in Bank)
b. Pembayaran dengan Dana Kas Kecil (Petty cash)
c. Pembayaran dengan Kartu Kredit (Bankcard)

Dalam kegiatan belajar 5 ini akan dijelaskan bagaimana pencatatan
pembayaran dengan ketiga cara tersebut di atas bila dikerjakan dalam program
MYOB.

2. Menu untuk Mencatat Transaksi Pembayaran

MYOB menyediakan menu Command Centre Banking — Spend Money
untuk mencatat transaksi pengeluaran kas, baik melalui cek, dana kas
kecil atau bankcard.

[&] MYOB Accounti

File Edit Lists Command Centres Setup Reports Window Help
Renata Interior Designer - Command Centre EI (3]
 mvos) BANKING =]

) - |

W > g L i S

Accounts Banking Sales Time Biling Purchases Payrol Inventony Card File

@ Receive Money
é H H
.. Prepare Elecfranic Payments .. & &
: Reconcile Accounts FPrepare Bank Deposit
R Brint Cheques oo :
& & M-Pawered €1
PrinyEmail Remittance Advices ... @ Transaction Journal O 5&""‘1':‘5
nire
To Do List - Find Transactions w Reports w Analysis w

Gambar: 2. 52 Menu untuk mencatat transaksi pembayaran

Direktorat Pembinaan SMK (2013)
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3. Pencatatan Pembayaran Dengan Cek

Untuk mencatat pembayaran dengan cek dalam MYOB menggunakan menu
yang sama Command Centre Banking — Spend Money, untuk kolom Pay from
Account diisi dengan akun penyimpanan kas di bank, dalam kasus Renata
Interior Designer ini adalah BCA Account.

Langkah-langkah pembayaran dengan Cek (Kasus: Renata Interior Designer):

1 Klik Command Centre Banking, Spend Money.

Gambar: 2. 53 Menu Banking — Spend Money

2 Ketik data pengeluaran kas sebagai berikut.
Spend Money E@

* Pay from Account: | 1-1110 5| BCA Account Balance = Fip45.000.000,00
" Group with Electronic Payments: W Tas Inclusive

Card :‘ %l Cheque No.:| 230
Drate:| 1040142013
Amount:| Fp32 330.000,00

Thirty Twa Million Three Hundred and Thirty Thousand Dollars and 0 Cents
tema: | Pembayaran beban & Pembelian azst a3 ANy Dosizny

Name Amnount Mema
Salary Payable Fip5.500.000,00
Insurance Rp1.100.000,00
PPM Payable Fip7.500.000,00
Computer Equipment at Cost Fip7.300.000,00
Barkcard FipE.000.000,00
Advertising & Promation Rp2.430.000,00
Rent Rp2.500.000.00

Total Allocated: |F\932.33D.UUU,DD
Tax o Rp0.00 ™ Cheque Alieady Printed
Total Paid: | Rp32.330.000,00 Femittance Advice Delivery Status:
Out of Balance: | Rp0.00 | Ta be Printed =l

n Save as Recuring| () Use Aecuring

HE|D F1 F'nn Juumal Fiegister

Gambar: 2. 54 Pembayaran dengan Cek

Direktorat Pembinaan SMK (2013) 87
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3 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum
dicatat (record).

‘ Recap Transaction in Spend Money ‘

cD 1040172013 Pembayaran beban & Pembelian asst -
230 11110 BCA Account Rp32.330.000,00
210 21400 Salary Payable Rp5.500.000.00
230 E-1800  Insurance Fp1.100.000,00
210 21350 PPN Payable Rp7.500.000.00
230 1-2410  Computer Equipment at Cc - Rp7.300.000,00
210 21110 Bankeard Rpf.000.000.00
230 E-1100  Advertising & Promation Fp2.430.000,00
210 E-2800  Rent Rp2.500.000.00

7

Help F1

Gambar: 2. 55 Recap jurnal pembayaran dengan cek

Jika sudah benar klik OK kembali ke window spend money

Klik Record untuk memproses jurnal

Klik Cancel untuk kembali ke Menu Utama

88 Direktorat Pembinaan SMK (2013)
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4. Pencatatan Pembayaran dengan Dana Kas Kecil

Untuk mencatat pembayaran dengan Dana Kas Kecil dalam MYOB
menggunakan menu yang sama Command Centre Banking — Spend Money,
untuk kolom Pay from Account diisi dengan akun Petty Cash.

Langkah-langkah mencatat pembayaran dengan kas kecil (Kasus: Renata
Interior Designer)

1 Klik Command Centre Banking, Spend Money.

2 Mengganti BCA Account menjadi Petty Cash
Spend Money EI@

% Pay from Account:  |1-1110 & ||BC4 Account Balance &+ Rpl2.670.000.00
™ Group with Electronic Payment W TaxInclusive

Cad | =
e
Payee =] ]
Lock for: [1-1140

T1710  BCA Account Assel -
11120 Payroll Cheque Account Azzet
Mema: 11130 Cash Drawer Asset
Aool B Name 1180 Undeposited Funds Asset
11190 Electronic Clearing Account Azzet
21110 Bankcard Liability
21120 Visa Liability

Total Allocated:
Tax
Total Paid:

Out of Balance:

(B) Save a5 Fecuring (Q!] Use Recurin ?

?{v éi]' = | e

Help F1 Print Journal | Register arce]

Gambar: 2. 56 Seting Petty Cash

3 Ketik data pengeluaran kas seperti tampak pada gambar berikut
Spend Money E@

& Pay from Account: | 1-1140 F/|Petty Cash Balance o+ Rp5.000.000,00

" Gioup with Electionic Payments: W TaxInclusive

Cad | ® Cheque No:[v-017
Payes =] Drstes| 15/01/201 3

Amount:| Rp396.000,00

Three Hundred and Minety Six Thousand Dollars and O Cents

M emo: | Petty cash items Stz il Desigsy

Name Amount Memo Tan
Laundry Rp100.000,00
Postage Rp76.000,00
Stalf Amenities Rp220.000,00

Total Allocated: | Rp336.000.00
Tax o Rp0.00 ™ Cheque Already Printed

Tatal Paid: Rp396.000,00 Remittance Advice Delivery Status:
Out of Balance: | Fip0,00 [Tobe Printed =

(IJ Save a3 Recurring @ Use Recurring

Gambar: 2. 57 Pembayaran dengan petty cash

Direktorat Pembinaan SMK (2013)
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Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum di
record.

‘ Recap Transaction in Spend Money

cD 15/01/2013 Petty cash items -
V-7 11140 Petiy Cash Rp336.000,00
V17 E-2100  Laundiy Fip100.000.00
V-7 E-2700  Postage Rp76.000,00

V-my E-3010  Staff Amerities Rp220.000,00

7

Help F1

Gambar: 2. 58 Recap jurnal pembayaran dengan petty cash.

Jika sudah benar klik OK kembali ke window spend money

Klik Record untuk memproses jurnal

7 Klik Cancel untuk kembali ke Menu Utama

Direktorat Pembinaan SMK (2013)
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5. Pencatatan Pembayaran dengan BankCard

Untuk mencatat pembayaran dengan bankcard dalam MYOB menggunakan
menu yang sama Command Centre Banking — Spend Money, untuk kolom Pay
from Account diisi dengan akun BankCard.

Langkah-langkah pembayaran dengan bankcard (Kasus Renata Interior
Designer):

1 Klik Command Centre Banking, Spend Money

2 Mengganti BCA Account menjadi Bankcard

Renata Interior Designer - Command Centre [EE]=]
| ] @ spend Money [=[=]=]
& Payfom Account: [19110 lﬁﬁm,&ccnunl Balance = Rp12.670.000,00
© Group with Electronic Paymenté® ¥ TaxInclusive
Cad | = Cheque bo.[231
Payee v Date:[15/01/2013

e @
e D =

11110 BEA Account Agzet
Acct Narne 11120 Pawroll Cheque Account Agset

11130 Cash Drawer Asgsat
11140 Petty Cash Azset
11180 Undeposited Funds Agzet

1190 Electionic Clearing Account Asgset

Totsl Allocstect g 5200 yigs Lisbility

Tanw -

Total Paid:

Out of Balance:

(B) Save 2s Aecurning | () Use Recuring

———
7. |- 2
Help F1 Brint Joumal FRiegists jv

Help F1 Cancel

Gambar: 2. 59 Seting Bank card.

3 Ketik data pengeluaran kas seperti tampak pada gambar berikut

Spend Money = 5|

& PayfromAccount | 2-1110 = Barkcard Balance o Rp000

" Group with Electonic Payments W TaxInclusive

Cad | =] Cheque No:[B-023
Payee x| Date:[ 18/01/2013

Amount:| Rp1.006.000,00

One Milion Six Thousand Dallars and 0 Cents
Memo: | Rekening Telkam dan Listrik S iy Dasipaer

Mame Amount Mema

53100 | Telephone Fp5A5.000,00 NT -
Elechicily Fip4Z1.000,00 d

Total Allocated: | Rp1.006.000,00

Taw o Rp0,00 I™ Cheque Alieady Printed
Total Paid: | Rpl.006.000,00 Fiemittance Advice Delivery Status:
Qut of Balance: | Fipi,00 | o be Prined =

(1) Gave & Recuning @ Usze Recuning

Gambar: 2. 60 Pembayaran dengan BankCard

g~ .
Help F1 Jounal | Register
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6. Pemeriksaan Jurnal Transaksi Pembayaran

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu
Command Centre Banking — Transaction Journal. Kemudian tanggalnya di set

dari 1/1/2013 — 31/1/2013.
Langkah-langkah melihat jurnal pembayaran (Kasus: Renata Interior Designer):

Klik Command Centre Banking, Transaction Journal

Rio Interior Design - Command Centre

o= =d

Accounts Banking

BANKING «9

Sales Tlm-e Bllhn-g

8 =

Purchases Payrall Irwentany Card File

Spend Money & cooeeeeeeean Bank Register - & Receive Money
& : :
Prepare Electronic Payments .. & &
Reconcile Accounts Prepare Bank Deposit
........ Print Chegueg - :
5 . & . - € M-Powered o
Frinf/Email Remittance Advices ... g! Services
i 6 Centre
ToDoList - Find Transactions w Reports - Analysis w
Gambar: 2. 61 Menu melihat jurnal pembayaran
2 Klik Tab Disbursements dan tanggal diset dari 1/1/2013 s.d.
Transaction Journal EI@
Generdl Disbursements ' Rieceipts ' Sales ' Purchases ' Inwentony I Al -
ted F ‘ 01/01/2013 T /1,23
e | o |
Date ID# Account Dehit Credit Job
=3 10401/2013 Pembayaran beban & Pembelian aset ;I
230 1-1110  BCA Account Fip32.330.000,00
230 21400 Salary Payable Rp5.500.000,00
230 E-1800  Insurance Rp1.100.000.00
230 21350 PPN Payable Rp7.500.000,00
230 1-2410  Computer Equipment &t Co - Rp?.300.000,00
230 21110 Bankcard Rp&.000.000,00
230 E-1100  Advertising & Pramotion Rp2.430.000.00
230 E-2800 Rent Rp2.500.000,00
o 15/01/2013 Petty cash items
V-7 1-1140  Petty Cash Rp336.000,00
sk E-2100  Laundry Fp100.000,00
auk E-2700  Postage Rp76.000,00
Y-z E3010  Staff Amenities Rp220.000,00
[=3 18/01/2013 Pembayaran Rekening Telkom & Listrik
B-023 21110 Bankeard Rp1.006.000.00
B-025 E-3440  Telephone FRp5E6.000,00
EB-025 E-3410  Electricity Rp421.000,00
7. | &n
(]
Help F1 Print

Gambar: 2. 62 Melihat jurnal Pembayaran
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[ c. Rangkuman ]

o Yang dimaksud dengan transaksi pembayaran adalah transaksi
pengeluaran kas oleh perusahaan jasa untuk keperluan operasi, misalnya
pembelian supplies, pembayaran beban-beban operasi dan sebagainya.

o Minimal ada 3 (tiga) cara pembayaran yang dilakukan perusahaan yaitu
pembayaran dengan cek, dengan dana kas kecil atau dengan bankcard.

o Program MYOB menyediakan menu yang sama untuk ketiga cara
pembayaran tersebut yaitu:

Banking > Spend Money.

o Pembayaran dengan cek, kolom Pay from Account diisi dengan Cash in

Bank (BCA Account).

o Pembayaran dengan dana kas kecil, kolom Pay from Account diisi dengan
Petty Cash.

o Pembayaran dengan bankcard, kolom Pay from Account diisi dengan
Bankcard.

o Program MYOB menyediakan menu untuk melihat jurnal transaksi
pembayaran yaitu:

Banking > Transaction Journal > Tab Disbursement > Set Date
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang
per kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk menyelesaikan tugas berikut ini.

4. Tugas 1, mencatat pembayaran dengan cek.
5. Tugas 2, mencatat pembayaran dengan dana kas kecil.
6. Tugas 3, mencatat pembayaran dengan bankcard.
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:
. Test Pengetahuan dan
. Tes Keterampilan
1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
c, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Yang dimaksud dengan transaksi pembayaran bagi perusahaan jasa adalah:
a. Pembelian barang dagangan secara tunai
b. Pembayaran utang dari pembelian barang dagang secara kredit.
c. Pengeluaran kas untuk pembelian supplies secara tunai
d. Pengeluaran kas untuk pembelian bahan baku secara tunai
e. Pengeluaran kas untuk keperluan pribadi pemilik perusahaan.

2. Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB
adalah :

. Banking > Pay Bill

b. Banking > Spend Money

c. Banking > Money Out

d. Banking > Banking Register > Spend Money

e. Banking Register > Spend Money

V]

3. Menu untuk mengentri transaksi pembayaran dengan Cek:

. Banking > Pay Bill > Pay from Account: BCA Account

b. Banking > Spend Money > Pay from Account: BCA Account

c. Banking > Money Out > Pay from Account: BCA Account

d. Banking > Banking Register > Pay from Account: BCA Account
e. Banking Register > Pay Bill > Pay from Account: BCA Account

O]

4. Menu untuk mengentri transaksi pembayaran dengan Dana Kas Kecil:
. Banking > Pay Bill > Pay from Account: Petty Cash

b. Banking > Money Out > Pay from Account: Petty Cash

c. Banking > Banking Register > Pay from Account: Petty Cash

d. Banking > Spend Money > Pay from Account: Petty Cash

e. Banking Register > Pay Bill > Pay from Account: Petty Cash

O]

5. Menu untuk mengentri transaksi pembayaran dengan Bankcard:
. Banking > Pay Bill > Pay from Account: Bankcard

b. Banking > Money Out > Pay from Account: Bankcard

c. Banking > Banking Register > Pay from Account: Bankcard
d. Banking Register > Pay Bill > Pay from Account: Bankcard

e. Banking > Spend Money > Pay from Account: Bankcard

V]
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6. Jika ada transaksi pembayaran beban iklan dengan kas kecil sebesar
Rp. 300.000,- maka MYOB akan memproses jurnalnya:

10.

a.

Dr: Advertising Rp. 300.000,- Cr: Petty Cash Rp. 300.000,-

b. Dr: Petty Cah Rp. 300.000,- Cr: Advertising Rp. 300.000,-

c. Dr: BCA Account Rp. 300.000,- Cr: Petty Cash Rp. 300.000,-
d.

e. Dr: Advertising Rp. 300.000,- Cr: Bankcard Rp. 300.000,-

Dr: Advertising Rp. 300.000,- Cr: BCA Account Rp. 300.000,-

. Jika ada transaksi pembelian Supplies dengan cek sebesar Rp. 3.000.000,-

maka MYOB akan memproses jurnalnya:

o

Dr: Supplies Rp. 3.000.000,- Cr: Petty Cash Rp. 3.000.000,-

b. Dr: Petty Cah Rp. 3.000.000,- Cr: Supplies Rp. 3.000.000,-

c. Dr: BCA Account Rp. 3.000.000,- Cr: Supplies Rp. 3.000.000,-
d.

e. Dr: Supplies Rp. 3.000.000,- Cr: Bankcard Rp. 300.000,-

Dr: Supplies Rp. 3.000.000,- Cr: BCA Account Rp. 3.000.000,-

. Jika ada transaksi pembelian pulsa HP dengan bankcard sebesar Rp.

200.000,- maka MYOB akan memproses jurnalnya:

Pa0T O

Dr: Telephone Rp. 200.000,- Cr: Petty Cash Rp. 200.000,-
Dr: Petty Cah Rp. 200.000,- Cr: Telephone Rp. 200.000,-
Dr: BCA Account Rp. 200.000,- Cr: Telephone Rp. 200.000,-
Dr: Telephone Rp. 200.000,- Cr: BCA Account Rp. 200.000,-
Dr: Telephone Rp. 200.000,- Cr: Bankcard Rp. 200.000,-

. Sebelum me-record transaksi pembayaran, selalu dianjurkan untuk menekan

Ctrl-R. Tujuan langkah ini adalah untuk:

a. Menghindari kesalahan dalam pencatatan.

b. Membetulkan jika ada kesalahan dalam pencatatan.
C.
d
e

Mengeliminir kesalahan dalam jurnal

. Mengecek kebenaran jurnal sebelum diproses
. Mengecek kebenaran jurnal sesudah diproses

Dalam MYOB klik Record terhadap pencatatan transaksi berarti:

®Po0T®

Memerintahkan komputer untuk memperoses jurnalnya.

Memerintahkan komputer untuk menghapus jurnalnya.

Memerintahkan komputer untuk membatalkan jurnalnya.

Memerintahkan komputer untuk memproses ulang jurnalnya.
Memerintahkan komputer untuk memproses jurnal dan posting ke buku
besar serta buku pembantu.
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2. Tes Keterampilan.

Didasarkan pada kasus 2: Rio Interior Design, kerjakan tes ini dengan
ketentuan sebagai berikut:

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, mengentri transaksi pembayaran dengan cek.

4. Tugas 2, mengentri transaksi pembayaran dengan kas kecil

5. Tugas 3, mengentri transaksi pembayaran dengan bankcard
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

Soal No. Jawaban

1 o]
2 b
3 b
4 d
5 e
6 e
7 (o]
8 d
9 o]
10 a

E Direktorat Pembinaan SMK (2013)
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2. Kunci Tes Keterampilan

@ Transaction Journal EI@
| 4
General I Disbursements ' Feceipts ' Sales ' Purchases T Inyentory ' all -
Dated From: | 01/01/2014 To | 3140172014
ID Fram: Tao
Date 1D Account Debit Credit Job
=] 02/01/2014 Paid zalary payable J
320 1-1110  BCA Account Fp5.500.000,00
320 21400 Salary Payable Rp5.500.000,00
=3 0240142014 Paid Insurance
321 1-1110  BCA Account Rip1.100.000,00
321 E-1800  Insurance Fp1.100.000.00
o 03/01/2014 Paid PPN Payable
322 1-1110  BCA Account Rp?7.500.000,00
322 2-1350 PPN Payable Rp?.500.000,00
o 04/01/2014 Paid Phone Bil
323 1-1110  BCA Account Rp5a5.000,00
323 £-3100 Telephone Rp586.000,00
o 05/01/2014 Paid Bankcard bill
324 1-1110  BCA Account RpE.000.000,00
324 21110 Bankcard Fip6.000.000,00
o 06/01/2014 Paid Advertizsing
325 1-1110  BCA Account Rip2.4:30.000,00
325 B-1100  Advertizing & Promation Rpz.430.000,00
=] 07/01/2014 Paid monthiy rent
326 1-1110  BCA Account Rp2.500.000,00
326 B-2800 FRent Rp2.500.000,00
2.
Help F1 Print

Gambar: 2. 63 Jurnal pembayaran kasus 5.2
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 5.1. Perusahaan Jasa Renata Interior Designer
Transaksi penarikan Cek BCA no. Chq. 230 untuk pembayaran:

Date Transaction Amount (Rp). Tax

10/1/13 | Pembayaran gaji karyawan Des 2012 5.500.000,- N-T
Pembayaran premi asuransi 1.100.000,-
Pembayaran PPN Payable 7.500.000,-
Pembelian Komputer 7.300.000,-
Pembayaran Bankcard bill terutang 6.000.000,-
Pembayaran beban iklan 2.430.000,-
Pembayaran beban sewa 2.500.000,-
Total 32.330.000,-

Tabel: 2- 7 Transaksi pengeluaran kas dengan cek kasus 5.1

Date Transaction Tax Details

15/1/13 | Pembayaran beban: N-T PC Voucher V-017
Laundry Rp. 100.000,- N-T Memo: Petty cash
Postage Rp. 76.000,- N-T items

Staff amenitis Rp. 220.000,-

Tabel: 2- 8 Transaksi Pengeluaran Kas Kecil kasus 5.1

Transaksi pengeluaran kas dibayar dengan Bankcard:

18/1/13 | Pembayaran: N-T No B-029
Tagihan Telkom Rp. 585.000,- Memo: Computer
Tagihan Listrik Rp. 421.000,- purchase

Tabel: 2- 9 Transaksi Pembayaran dengan Bankcard kasus 5.1

Direktorat Pembinaan SMK (2013)
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Kasus 5.2 Perusahaan Jasa Rio Interior Design

Transaksi pembayaran dengan Cek BCA

Date Transaction Tax Details
2/1/114 Pembayaran gaji karyawan | N-T  Chq No 320
Des’13 sebesar Memo: Paid salaries payable
Rp. 5.500.000,-
2/1/14 Pembayaran premi asuransi N-T  Chqg No 321
sebesar Memo: Paid insurance
Rp. 1.100.000,-
3/1/14 Pembayaran PPN Payable | N-T  Chq No 322
sebesar Rp.7.500.000,- Memo: Paid PPN Payable
4/1/14 Pembelian peralatan komputer | N-T Chqg No 323
Rp. 7.300.000,- Memo: Paid for Computer
5/1/14 Pembayaran Bankcard bill N-T  Chqg No 324
terutang sebesar. Memo: Paid Bankcard bill
Rp. 6.000.000,-
6/1/14 Pembayaran beban iklan N-T Chqg No 325
sebesar Rp. 2,430.000,- Memo: Paid Advertising
711114 Pembayaran beban sewa N-T Chqg No 326
sebesar Rp.2.500.000,- Memo: Paid Monthly rent

Tabel: 2- 10 Transaksi Pengeluaran dengan Kas Kecil Kasus 5.2

Transaksi pengeluaran kas dibayar dengan Petty Cash:

8/1/14 Pembayaran beban: No. V-01
Laundry Rp. 100.000,- [ N-T  Memo: Petty cash items
Postage Rp. 76.000,- N-T

9/1/14 Pembayaran untuk staff N-T  No. V-02
amenities (teh, gula, kopi) Memo: Petty cash items
Rp. 220.000,-

Tabel: 2- 11 Transaksi Pengeluaran dengan Bankcard Kasus 5.2
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KEGIATAN BELAJAR 6
MENCATAT TRANSAKSI
PENERIMAAN

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir
kegiatan belajar ini diharap-kan peserta didik dapat:

1. Mendefinisikan transaksi penerimaan
Menunujukkan menu untuk mencatat transaksi penerimaan.
Mencatat penerimaan berupa uang tunai

Mencatat penerimaan berupa cek

o bk wDN

Memeriksa jurnal transaksi penerimaan

[ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:

Pengertian Transaksi Penerimaan
Menu untuk Mencatat Transaksi Penerimaan
Mencatat Penerimaan Berupa Uang Tunai

Mencatat Penerimaan Berupa Cek

o k0=

Jurnal Trasaksi Penerimaan
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1. Pengertian Transaksi Penerimaan

Pendapatan perusahaan jasa diperoleh dari hasil penjualan jasa atau
pelayanan jasa kepada pelanggan. Jadi yang dimaksud dengan transaksi
penerimaan disini adalah penerimaan pendapatan dari hasil pelayanan
jasa kepada pelanggan. Penerimaan pendapatan ini dapat berupa:

a. Uang tunai (disimpan di perusahaan)
b. Cek (disetor ke bank)

Dalam kegiatan belajar 6 ini akan dijelaskan bagaimana pencatatan
penerimaan dengan kedua cara tersebut di atas bila dikerjakan dalam
program MYOB.

2. Menu untuk Mencatat Transaksi Penerimaan

MYOB menyediakan menu Command Centre Banking — Receive Money
untuk mencatat transaksi penerimaan berupa kas atau berupa cek.

[&] MYOB Accounti
File Edit Lists Command Centres Setup Reports Window Help
Renata Interior Designer - Command Centre E'@
fmvos) BANKING =]
¥ -y
-m B, B 1 ¢
W™ g o |
b - —
Accounts Banking Sales Time: Billing Purchases Payrall Irvehiton Card File
Spend Money g oo Bank Register -««oooooeiaaa > F’\ec:eMeMDney
é N H
.. Prepare Electronic Payments .. & &
’ : Reconcile Accounts Prepare Bank Deposit
sererrarees Print Chagues «-+-+vv" :
. . p . & M-Powered {D
PrintEmail Remittance Advices ... @ Transaction Journal G S&Tt‘r?
ToDoList - Find Transactions w Reports w Analysis w

Gambar: 2. 64 Menu untuk mencatat transaksi penerimaan

3. Mencatat Penerimaan Berupa Uang Tunai

Untuk mencatat penerimaan berupa uang tunai MYOB menggunakan menu
yang Command Centre Banking — Receive Money, untuk kolom Deposit to
Account diisi dengan akun cash on hand atau dalam kasus Renata Interior
Designer ini adalah Cash Drawer.
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Langkah-langkah penerimaan berupa uang tunai (Kasus: Renata Interior
Designer):

Langkah-langkah Mencatat Penerimaan Kas berupa uang tunai (lihat Kasus 6.1
di Lembar Kerja Peserta Didik):

1 Klik Command Centre Banking, Receive Money.

Gambar: 2. 65 Menu transaksi penerimaan

2 Mengganti BCA Account menjadi Cash Drawer
( Receive Money EI@

* Depositto Account, | 1-111 W BCA Account Balance 5:: Rp12 670.000,00
™ Group with Undeposited Fund

¥ TaxInclusive

Payar | 1D #: [ CRODDOOT

Amount Received: Date: | 0770742014

Payment Method: |

11710 BCA Account =]
1-1120  Payroll Cheque Account

Cash Drawer

Petty Cazh

Undepasited Funds

Electronic Clearing Account

Bankecard Liahility

Wiza Liahility

Out of Balanc

(&) Use Recu

-

Usze Account I

Cancel

Gambar: 2. 66 Deposit to account Cash Drawer
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3 Ketik data penerimaan kas seperti tampak pada gambar berikut

Receive Money EI@

* DeposittoAccount: [1-1130 5| Cash Drawer Balance ©r: Rp10.000.000,00
" Group with Undeposited Funds: W Tax Inclusive

Payor | =l ID #: [CR-05
Amount Received: | Rp20.000.000,00 Date: | 204002013
Payment Method: | Cash Details... |

Mema: | Setoran Modal dari Pemilik.

Mame Armnount
Fienata's Capital Fip20.000.000,00

Total Allocated: | Fip20.000.000,00
Tax o Fip0,00
Total Received: | Rp20.000.000,00

Out of Balance: Rp0.00
(n Save as Recuning @ Use Recuring

Help F1 Journal Fiegister

Gambar: 2. 67 Data Transaksi Penerimaan tunai

4 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final.
ez

p Transactiol

Recap Tranzaction in Receive Money ‘

S Date ID# Account Dehit Credit Job

CR 2040/2013 Setoran Modal dari Pemilik ;I
CR-05 11130 Cash Drawer Fip20.000.000,00
CR-05 31100  Renata's Capital Rpz20.000.000,00

Help F1

Gambar: 2. 68 Recap jurnal penerimaan.

Jika sudah benar klik OK kembali ke windows receive money

Klik Record untuk memproses jurnal

7 Klik Cancel untuk kembali ke Menu Utama
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4. Mencatat Penerimaan Berupa Cek

Untuk mencatat penerimaan berupa uang tunai MYOB menggunakan menu
yang Command Centre Banking — Receive Money, untuk kolom Deposit to

Account diisi dengan akun cash in bank atau dalam kasus Renata Interior
Designer ini adalah BCA Account.

Langkah-langkah Mencatat Penerimaan Kas berupa cek:

1 Klik Command Centre Banking, Receive Money.
->
’f
z’,’ NN\‘s
’ Sso
/” SsQ
R “s~~~~
~‘~~~~~~ ’,,
Gambar: 2. 69 Menu Banking — Receive Money
2

Mengganti Cash Drawer menjadi BCA Account

7

Gambar: 2. 70 Deposit to account BCA Account
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3 Isi data penerimaan kas seperti tampak pada gambar berikut:
Receive Money EI@

* DeposittoAccount: | 11110 5 BCA Account Balance 5+ Rpl12.730.000,00
" Group with Undeposited Funds: W Tax Inclusive

Payor | E D #: [CR-05

Amount Received: | RpS1.700.000.00 Date: | 2940142013
Payment Method: | Cheque =l Details... |

M ema: | Penerimaan dari penjualan tunai

Aot # MName Amount
41000 Sales or Fees Fp42.350.000,00
4-2000 Conzultation Fees Fip9.350.000,00

=

Total Allocated: | Fip51.700.000,00
Tax or: | Rpd.700.000,00
Total Received: | RpS1.700.000,00

Out of Balance: Rp0.00
(n Save az Recuring @ Use Recuring

7. &G
Help F1 Journal Register

Gambar: 2. 71 Data transaksi penerimaan cek

4 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final

| ‘ Recap Trangaction in Receive Money ‘

S Date ID# Account Diehit Credit Job
CR 29/ /2013 Penerimaan dari penjualan tunai ;I
CR-08 11110 BCA Account Fip&1.700.000,00
CR-06 4-1000  Sales or Fees Fip38.500.000,00
CR-06 4-2000  Consultation Fees Fip8.500.000,00
CR-06 21310 PPN Collected Fipd.700.000,00

Help F1

Gambar: 2. 72 Recap jurnal penerimaan cek

5 Jika sudah benar klik OK kembali ke windows Rereive Money.

Klik Record untuk memproses jurnal

7 Klik Cancel untuk kembali ke Menu Utama
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5. Jurnal Transaksi Penerimaan

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu
Command Centre Banking — Transaction Journal. Kemudian tanggalnya di set
dari 1/1/2013 — 31/1/2013.

Langkah-langkah melihat jurnal penerimaan (Kasus: Renata Interior Designer):

1 Klik Command Centre Banking, Transaction Journal
Rio Interior Design - Command Centre EI
[mvos] BANKING ~?
o w AP E s
Ac:c:o-unts Banking Sales Tim-e Billiné Purchases Pagprol Irwentony E.I;:d File
Spend Money @ «---ceeeeeeeees Bank Register «««--xteeeeeees o Receive Maney
G: H H
.. Prepare Elecironic Payments .. & [
: Reconcile Accounts Prepare Bank Deposit
P ErintCthUES""""": N
L M-Powered O
Frint/Email Remitance Advices - Services
/- 6 Centre
ToDolList - Find Transactions Fepaorts w Analysis w
Gambar: 2. 73 Menu melihat jurnal penerimaan
2

Klik Tab Receipts dan tanggal diset 1/1/2013 s.d. 31/1/2013. Klik
Close untuk mengakhiri.

Transaction Journal EI@
General I Disbursements I Receipts I Sales I Purchases I Inventary I Al -
D ated From: | 01/01/2013 Tao: |31/01/2003
1D Fram: Tor
Date 1D# Account Debit Credit Job
o 2040142013 Setoran Modal dari Pemilik J
CR-05 11130 Cash Drawer Rp20.000.000,00
CR-05 31100 Renata's Capital Rp20.000.000,00
=] 29/01/2013 Penerimaan dari penjualan tunai
CR-06 11110 BCA Account Rp51.700.000,00
CR-06 41000  Sales or Fees Rp38.500.000,00
CR-06 4-2000  Consultation Fees Fip&.500.000.00
CR-06 21310 PPN Collected Fp4.700.000,00
7
Help F1

Gambar: 2. 74 Jurnal penerimaan dari kasus 1
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[ c. Rangkuman ]

e Yang dimaksud dengan transaksi penerimaan adalah transaksi
penerimaan pendapatan dari hasil pelayanan jasa kepada pelanggan.

e Penerimaan pendapatan dapat berupa uang tunai atau berupa cek.

e Program MYOB menyediakan menu untuk mencatat kedua penerimaan
yaitu:

Banking > Receive Money

e Penerimaan berupa uang tunai dicatat dengan menu Banking > Receive
Money dan kolom Deposit to Account diisi cash on hand atau Cash
Drawer.

¢ Penerimaan berupa cek dicatat dengan menu Banking > Receive Money
dan kolom Deposit to Account diisi cash on hand atau BCA Account.

e Program MYOB menyediakan menu untuk melihat jurnal transaksi
pembayaran yaitu:

Banking > Transaction Journal > Tab Receipts > Set Date
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{ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk menyelesaikan tugas berikut ini.

Tugas 1, mencatat penerimaan berupa uang tunai.

5. Tugas 2, mencatat penerimaan berupa cek.

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:

. Test Pengetahuan dan
. Tes Keterampilan

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Yang dimaksud dengan transaksi penerimaan bagi perusahaan jasa

a

®Po0TD

dalah:

Penjualan barang dagangan secara tunai

Penerimaan piutang dari penjualan barang secara kredit.
Penerimaan kas dari pemakaian supplies

Penerimaan kas dari hasil penjualan supplies.
Penerimaan pendapatan dari hasil penjualan jasa

2. Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB

a

O QO TO

dalah :

. Banking > Receive Payment

. Banking > Money In

. Banking > Receive Money

. Banking > Banking Register > Receive Money
. Banking Register > Receive Money

3. Menu untuk mengentri transaksi penerimaan berupa uang tunai:

a.

Banking > Receive Payment > Deposit to Account: Cash in Bank
. Banking > Receive Money > Deposit to Account: Cash Drawer

b
c. Banking > Money In > Deposit to Account: Cash Drawer
d.
e

Banking Register > Receive Money > Deposit to Account: Cash oh hand
. Banking Register > Receive Money > Deposit to Account: Cash on Hand

4. Menu untuk mengentri transaksi penerimaan berupa cek:

a.

b
c
d.
e

Banking > Receive Payment > Deposit to Account: BCA Account

. Banking > Money In > Deposit to Account: BCA Account

. Banking Register > Receive Money > Deposit to Account: BCA Account
Banking > Receive Money > Deposit to Account: BCA Account

. Banking Register > Receive Money > Deposit to Account: BCA Account

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

5.

10.

Jika ada transaksi penerimaan uang tunai hasil penjualan jasa sebesar Rp.
300.000,- maka MYOB akan memproses jurnalnya:

a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-
b. Dr: Petty Cash Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-
c. Dr: Sales or Fee Rp. 300.000,- Cr: Petty Cash Rp. 300.000,-
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

e. Dr: Cash Drawer Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

Jika ada transaksi penerimaan cek hasil penjualan jasa sebesar Rp.
300.000,- maka MYOB akan memproses jurnalnya:

a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

b. Dr: Petty Cash Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

c. Dr: Sales or Fee Rp. 300.000,- Cr: Petty Cash Rp. 300.000,-

d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

e. Dr: Cash Drawer Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

Jika ada transaksi penerimaan cek dari setoran pemilik untuk tambahan
investasi sebesar Rp. 300.000,- maka MYOB akan memproses jurnalnya:
a. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

b. Dr: Owner’s Capital Rp. 300.000,- Cr: BCA Account Rp. 300.000,-

c. Dr: BCA Account Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-

d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

e. Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-

Jika ada transaksi penerimaan uang tunai dari setoran pemilik untuk
tambahan investasi sebesar Rp. 300.000,- maka MYOB akan memproses
jurnalnya:

. Dr: BCA Account Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

. Dr: Owner’s Capital Rp. 300.000,- Cr: BCA Account Rp. 300.000,-
. Dr: BCA Account Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-
. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,-

. Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,-

Sebelum me-record transaksi penerimaan, selalu dianjurkan untuk
menekan Ctrl-R. Tujuan langkah ini adalah untuk:

O Q0O T

Menghindari kesalahan dalam pencatatan.
Membetulkan jika ada kesalahan dalam pencatatan.
Mengeliminir kesalahan dalam jurnal

Mengecek kebenaran jurnal sebelum diproses
Mengecek kebenaran jurnal sesudah diproses

©20TO

Dalam MYOB klik Record terhadap pencatatan transaksi berarti:

Memerintahkan komputer untuk memperoses jurnalnya.

Memerintahkan komputer untuk menghapus jurnalnya.

Memerintahkan komputer untuk membatalkan jurnalnya.

Memerintahkan komputer untuk memproses ulang jurnalnya.
Memerintahkan komputer untuk memproses jurnal dan posting ke buku
besar serta buku pembantu.

®P20TY
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2. Tes Keterampilan.

Didasarkan pada kasus 2: Rio Interior Design lihat di Lembar Kerja Peserta
Didik, kerjakan tes ini dengan ketentuan sebagai berikut:

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file.

3. Tugas 1, mengentri transaksi penerimaan berupa uang tunai.

4. Tugas 2, mengentri transaksi penerimaan berupa cek.
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

O oONoOOAWN -
DD |O|D|D|Q|T|IO |D

-
o

114 Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

2. Kunci Tes Keterampilan

@ Transaction Journal

=[5 |

| 4
General ' Dizbursements ' Receipts ' Sales ' Purchazes ' Inwentary ' All -
Drated From: | 07401/2014 Tor | 30142014
1D From: To
Date D Accaolnt Drebit Credit Jaob

=3 12/01/2014 Capital Contribution J

Cr-05 11110 BCA Account Rp10.000.000,00

Cr-05 31100 Renata's Capital Fp10.000.000,00
=3 15/01/2014 Project Sals

CR-01 11110 BCA Account Rp13.200.000,00

CR-01 41000 Sales or Fees Rp12000.000,00

CR-01 21310 PPN Collected Fip1.200.000,00
=3 17012014 Project Sals

CR-02 11110 BCA Account Rp18.150.000,00

CR-02 41000 Sales or Fees Rp16.500.000,00

CR-02 21310 PPN Collected Fipl1.650.000,00
=3 24/01/2014  Consultation

CR-03 11110 BCA Account Fip2 750.000,00

CR-03 4-2000  Consultation Fees Rp2 500.000,00

CR-03 21310 PPN Collected Rp250.000,00
=3 26/01/2014 Project Sals

CR-04 11110 BCA Account Rp11.000.000,00

CR-04 41000 Sales or Fees Rp10.000.000,00

CR-04 21310 PPN Collected Fip1.000.000,00
=3 28/01/2014  Consultation

CR-0& 11110 BCA Account Fip4.400.000,00

CR-0E 42000  Consultation Fees Rp4.000.000,00

CR-0& 21310 PPN Collected Fp400.000,00
=3 29/01/2014  Consultation

CR-07 11110 BCA Account Fip2.200.000,00

CR-07 42000  Consultation Fees Rp2 000.000,00

CR-07 21310 PPN Collected Rp200.000,00

Gambar: 2. 75 Jurnal penerimaan dari Kasus 2
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18

Kasus 6.1. Renata Interior Designer

Dengan menggunakan program MYOB versi18, catat transaksi berikut ini.

Transaksi penerimaan kas (dicatat sebagai Cash Drawer)

Date Transaction Tax Details
12/1/14 | Pemilik menyetorkan dana seb. N-T CR-05
Rp. 10.000.000,- ke kas Payment method:
perusahaan. cash
Memo: Capital
contribution

Tabel: 2- 12 Transaksi penerimaan kas dari kasus 1.

Transaksi penerimaan dari penjualan jasa (jumlah sudah termasuk PPN 10%).

Date Transaction Tax Details
29/1/13 | Project Sales Rp. 42.350.000,- PPN
Consultation Rp. 9.350.000,- PPN CR-01

Tabel: 2- 13 Transaksi penerimaan cek dari kasus 1.
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Kasus 6.2. Rio Interior Design
Dengan menggunakan program MYOB versi18, catat transaksi berikut ini.

Transaksi penerimaan kas (dicatat sebagai Cash Drawer)

Date Transaction Tax Details
12/1/14 | Pemilik menyetorkan dana seb. N-T CR-05
Rp. 10.000.000,- ke kas Payment method:
perusahaan. cash
Memo: Capital
contribution

Tabel: 2- 14 Transaksi penerimaan kas dari kasus 2.

Transaksi penerimaan penjualan jasa (jumlah sudah termasuk PPN 10%).

Date Transaction Tax Details
15/1/14 | Menerima Rp. 13.200.000,- dari PPN CR-01
hasil penjualan jasa Payment Method:
Cheque
Memo: Project sale
17/1/14 | Menerima Rp. 18.150.000,- dari PPN CR-02
hasil penjualan jasa Payment Method:
Cheque
Memo: Project sale
24/1/14 | Menerima Rp. 2.750.000,- dari PPN CR-03
hasil penjualan jasa konsultasi Payment method:
Cheque
Memo:
Consultation
26/1/14 | Menerima Rp. 11.000.000,- dari PPN CR-04
hasil penjualan jasa Payment method:
cheque
Memo: Project sale
28/1/14 | Menerima Rp. 4.400.000,- dari PPN CR-06
hasil penjualan jasa konsultasi Payment method:
cheque
Memo:
Consultation
29/1/14 | Menerima Rp. 2.200.000,- dari PPN CR-07
hasil penjualan jasa konsultasi Payment method:
cheque
Memo:
Consultation

Tabel: 2- 15 Transaksi penerimaan cek dari kasus 2.

Direktorat Pembinaan SMK (2013)




Komputer Akuntansi Jilid 1

KEGIATAN BELAJAR 7
MENCATAT ENTRI PENYESUAIAN

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan
belajar ini diharap-kan peserta didik dapat:

Menjelaskan pengertian jurnal penyesuaian
Menunjukkan menu untuk mencatat entri penyesuaian
Mencatat entri penyesuaian

Memeriksa entri penyesuaian

N

{ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:
1. Pengertian entri penyesuaian
2. Menu untuk Pencatatan entri penyesuaian
3. Pencatatan entri penyesuaian

4. Pemeriksaan jurnal penyesuaian
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1. Pengertian Entri Penyesuaian

Saldo-saldo akun pada akhir periode masih bersifat sementara belum
menunjukkan jumlah yang sesungguhnya, termasuk pada akun-akun
pendapatan dan beban. Hal ini terjadi karena selama berjalannya waktu telah
terjadi perubahan, tetapi perubahan itu belum dicatat.

Contoh:

a. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest
Income sejumlah tertentu dan Bank Charge yang harus dibayar sejumlah
tertentu pula dan ini belum ada pencatatannya.

b. Persediaan Office Supplies dan Photograph Supplies selama bulan januari
telah terjadi pemakaian tetapi transaksi ini belum dicatat.

c. Aset tetap, selama bulan Januari telah digunakan dan ini ada beban
depresiasi yang harus diperhitungkan dan ini akan menambah nilai
akumulasi depresiasinya.

d. Beban yang ditangguhkan, seperti beban gaji bulan Januari yang akan
dibayarkan pada tanggal awal Pebruari. Dan lain-lainnya.

Contoh catatan-catatan (a, b, ¢, d) tersebut di atas merupakan entri
penyesuaian yang akan dijadikan sebagai dasar pencatatan jurnal
penyesuaian. Jadi entri penyesuaian adalah catatan-catatan pada akhir
periode yang akan dijadikan dasar pembuatan jurnal penyesuaian agar
saldo akhir akun-akun sesuai dengan saldo yang sesungguhnya.

2. Menu untuk Pencatatan Entri Penyesuaian

MYOB menyediakan menu Command Centre Accounts — Record Journal Entry
untuk mencatat entri penyesuaian.

Renata Interior Designer - Command Centre EI@
[mvos] ACCOUNTS 2|
W > ‘W

Accounts Banking Sales Time Billing Purchaszes Pagrall Irventong Card Fil=

Send to Accountant & -eeeeveseees ACCOUNS Ligt +veversrsersnsriaes @ BASlink

.. MoneyCantraller ..

. Transfer Money o

: & M-powered )
BooooooneeerecccenRRREo: i Services
@ Transaction Journal O ot ey

To Do List - Find Transactions w Feports Analysis w

Gambar: 2. 76 Menu untuk pencatatan entri penyesuaian
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3. Pencatatan Entri Penyesuaian

Agar saldo-saldo akun pada akhir periode menunjukkan jumlah saldo yang
sesungguhnya, maka perlu inventarisasi entri penyesuaian pada setiap akhir
bulan/periode. Berdasarkan entri penyesuaian yang telah dikumpulkan maka
selanjutnya diadakan penyesuaian ke dalam jurnal umum.

Langkah-langkah mencatat entri penyesuaian.

1 Klik Command Centre Banking, Record Journal Entry.

Gambar: 2. 77 Langkah 1, klik account dan record Journal entry

2 Mencatat data penyesuaian ke dalam Jurnal Umum seperti tampak
pada gambar berikut ini.
Record Journal Entry E=n (B ==
e
Display in GST [BAS] reports a5 € Sale (Supply)
& Purchase [Acquisition) [~ TaxInclusive
General Joumal #: | GJ-112
Date: | 310172013
Memo: | Adistment
Acct i Name Debit Credit Job Mema Tax
11110 BCA Account RpE0.000,00 N-T -
E1210 Bank Charges RpE5.000,00 N-T
21000 Interest Income: Rp125.000.00] N-T
£-2500 Office Supplies Ap1.250.000,00 N-T
6-2600 Phatography Supplies Rp2.000.000,00 N-T
11310 Office Supplies Inventory Rp1.250.000,00 N-T
11320 Phatography Supplies Inventc, Rp2000.000,00 N-T
E-1400 Depreciation Expense Ap1.157.000,00 N-T
12120 Prof Equipment Accumn Dep Fip292.000.00] N-T
1-2220 Furmiture & Fistures Accum De| Fip265.000.00] N-T
1-2420 Computer Equipment Accum [ FipE00.000.00] N-T
63030 ‘wages & Salaries FipE.000.000,00 N-T
21400 |Sclaw Payable Rpk.000.000.00, T |
Total Debit: Rp10.532.000.00
Tatal Credit Rp10.532.000.00
Tax o Rp0.00
Out of Balance: Rp0.00
(8) Sawe asRecurng | (9) Use Aecuring |

Gambar: 2. 78 Pencatatan entri penyesuaian.
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3 Tekan Ctrl-R untuk mengecek kebenaran hasil jurnal sebelum final.
Recap Tra d ||

| Recap Transaction in Record Joumal Entry |

310172013 Adjustment -
G112 11110 BCA Account FipB0.000,00
G112 E1210  Bank Charges FpE5.000,00
GJ-112 81000  Interest Income Rp125.000,00
GJ-112 E-2600  Office Supplies Rp1.250.000,00
G112 E-2600  Phatography 5upplies Fp2000.000,00
GJ-112 11310 Dffice Supplies Inventary Fip1.250.000,00
G112 11320 Phatography Supplies Ire FRp2.000.000,00
GJ-112 E-1400  Depreciation Expense Rp1.157.000,00
GJ-112 1-2120  Prof Equipment Accum De Rp292.000,00
GJ-112 1-2220  Furniture & Fistures Aceur Rp265.000,00
GJ-112 1-2420  Computer Equipment Accl RpE00.000,00
GJ-112 B-3030 ‘wages & Salaries Fpk.000.000,00
G112 21400 Salary Payable FRp6.000.000,00
-

Help F1

Gambar: 2. 79 Recap Jurnal penyesuaian

Jika sudah benar klik OK kembali ke window Record Journal Entry.

Klik Record untuk memproses jurnal

Klik Cancel untuk kembali ke Menu Utama
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4. Pemeriksaan Jurnal Entri Penyesuaian

Untuk melihat jurnal yang telah diproses, MYOB menyediakan fasilitas menu
Command Centre Accounts — Transaction Journal. Kemudian tanggalnya di set
dari 1/1/2013 — 31/1/2013.

Langkah-langkah melihat jurnal penyesuaian (Kasus: Renata Interior Designer):

1 Klik Command Centre Account dan Transaction Journal.

Gambar: 2. 80 Menu memeriksa jurnal penyesuaian

2 Klik Tab General dan tanggal diset dari 1/1/2013 s.d. 31/1/2013

Transaction Journal E
General ' Disbursements ' Receipts ' Sales ' Purchases I Irwentan I All -
Daated From: [01/01/2013 To: [31/0172013
1D From: || To: |
Date ID# Account Dehit Credit Job
B F1/0172013 Adyustment -]
G112 11110 BCA Account Rp60.000,00
GJ-112 B1210 Bank Charges RpE5.000.00
GJ-112 81000  Interest Income Fip125.000,00
GJ-112 B-2500  Office Supplies Rp1.250.000,00
GJ-112 6-2600 Photography Supplies Fip2.000.000,00
G112 11310 Dffice Supplies Inventory Rip 250 000,00
GJ-112 11320 Photography Supplies Inve Fipz.000.000,00
GJ-112 B-1400  Depreciation Expense Rp1.157.000,00
GJ-112 1-2120  Prof Equipment &ccum De Fip292.000,00
GJ-112 1-2220  Fumiture & Fistures Accur FRp265.000.00
GJ-112 1-2420  Computer Equipment AccL Fip&00.000,00
GJ-112 6-3030 Wages & Salaries FRp6.000.000.,00
G-z 21400 Salary Payable FRp6.000.000,00
-
7 |
7. | =y
Help F1 Print

Gambar: 2. 81 Jurnal penyesuaian Kasus 1

3 Klik Close untuk menutup
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[ c. Rangkuman ]

e Entri penyesuaian adalah catatan-catatan pada akhir periode yang akan
dijadikan dasar pembuatan jurnal penyesuaian agar saldo akhir akun-
akun sesuai dengan saldo yang sesungguhnya.

e Akun-akun yang terkait dengan penyesuaian biasanya adalah:

o Cash in Bank, atas dasar laporan Rekening Koran

o Persediaan Supplies

o Depresiasi Aset tetap dan akumulasi depresiasinya
o Beban-beban yang masih harus dibayar atau telah dibayar di muka
o Pendapatan diterima di muka atau masih harus diterima.
¢ Menu untuk mencatat entri penyesuaian adalah:
Command Centre Account > Record Journal Entry
¢ Menu untuk memeriksa jurnal penyesuaian adalah:

Command Centre Accounts — Transaction Journal

Direktorat Pembinaan SMK (2013)
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk mencatat entri penyesuaian pada akhir periode
akuntansi.

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:
. Test Pengetahuan dan
. Tes Keterampilan
1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawabh ini:

1. Pencatatan entri penyesuaian diperlukan agar :
a. Saldo akun-akun menunjukkan jumlah yang sesuai.
b. Saldo akun-akun menunjukkan jumlah yang seimbang
c. Saldo akun-akun menunjukkan jumlah yang sama.
d. Saldo akun-akun menunjukkan jumlah yang sesungguhnya.
e. Saldo akun-akun menunjukkan jumlah yang setara.

2. Langkah untuk mengentri transaksi penyesuaian:
a. Account > Record Journal Entry
b. Account > Memorial Record Entry
c. Account > General Journal Entry
d. Account > Memorial Journal Entry
e. Account > Record Journal Memorial

3. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest
Income dan Bank Charge sejumlah tertentu. Transaksi ini akan berakibat
penyesuaian terhadap akun:

a. Bank Loan
b. Account Payable

c. Expense
d. Cash in Bank
e. Income

4. Selama periode akuntansi telah terjadi pemakaian supplies tetapi belum
diadakan pencatatan. Transaksi ini akan berakibat penyesuaian terhadap
akun-akun:

a. Dr: beban supplies dan Cr: Persediaan barang

b. Dr: Persediaan supplies dan Cr: Persediaan barang
c. Dr: Beban supplies dan Cr: Persediaan Supplies

d. Dr: Beban supplies dan Cr: Beban operasional

e. Dr: Beban operasional dan Cr: Persediaan supplies
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5.

10.

Penggunaan aset tetap dalam kegiatan operasi pada akhir periode akan
menyebabkan penyesuaian terhadap akun-akun:

Dr: Akun aset tetap dan Cr: Depresiasi aset tetap

Dr: Akun aset tetap dan Cr: Akum. depresiasi aset tetap

Dr: Depresiasi aset tetap dan Cr: beban operasi

Dr: Akum. depresiasi aset tetap dan Cr: beban operasi

Dr: Depresiasi aset tetap dan Cr: Akum. depresiasi aset tetap.

©CoooTw

Beban salary bulan Januari akan dibayarkan di awal Pebruari. Transaksi
ini akan berakibat penyesuaian terhadap akun-akun:

Dr: Beban salary dan Cr: Utang beban

Dr: Beban operasi dan Cr: Utang salary

Dr: Beban salary dan Cr: beban operasi

Dr: Beban salary dan Cr: Utang salary

Dr: Beban operasi dan Cr: Utang operasi

©oooTw

Pada bulan Agustus dibayar premi asuransi selama satu tahun dan dicacat
sebagai beban. Transaksi ini akan berakibat penyesuaian terhadap akun-
akun:

a. Dr: Insurance dan Cr: Prepaid Insurance

b. Dr: Insurance dan Cr: Prepaid expense

c. Dr: Prepaid Insurance dan Cr: Prepaid expense

d. Dr: Prepaid expense dan Cr: Insurance

e. Dr: Prepaid Insurance dan Cr: Insurance

Pada bulan September dibayar sewa toko selama satu tahun dan dicacat
sebagai aset. Transaksi ini akan berakibat penyesuaian terhadap akun-
akun:

Dr: Rent dan Cr: Prepaid Rent

Dr: Rent dan Cr: Prepaid expense

Dr: Prepaid Rent dan Cr: Prepaid expense

Dr: Prepaid expense dan Cr: Rent

Dr: Prepaid Rent dan Cr: Rent

Sebelum me-record entri penyesuaian, selalu dianjurkan untuk menekan
Ctrl-R. Tujuan langkah ini adalah untuk:

Menghindari kesalahan dalam pencatatan.

b. Membetulkan jika ada kesalahan dalam pencatatan.

c. Mengeliminir kesalahan dalam jurnal

d. Mengecek kebenaran jurnal sebelum diproses

e. Mengecek kebenaran jurnal sesudah diproses

P00 T O

o

Langkah untuk memeriksa jurnal penyesuaian:
a. Account > Journal Transaction

b. Account > Record Transaction

c. Account > General Transaction

d. Account > Memorial Transaction

e. Account > Transaction Journal
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2. Tes Keterampilan.

Kasus 2: Perusahaan jasa Rio Interior Design
(Lihat di Lembar Kerja Peserta Didik)

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan
oleh peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan
hasil pekerjaannya dalam bentuk file.

3. Tugas yang harus diselesaikan: mencatat entri penyesuaian
pada tanggal 31/1/2014.
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f. Kunci Jawaban Tes Formatif

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
e Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

OO N DA WN =

Dl ala|o|o|alo|a

-
o

2. Kunci Tes Keterampilan

Transaction Journal EI@
General I Disbursements I Receipts I Sales I Purchases I Inwentory I All -
Drated From: | 01/01/2014 To: | 3170172014
1D From: || To
Date 1D# Account Dekit Credit Job
[ 312014 Adjustment J
GJ-112 E-1210 Bank Charges F pE5.000,00
GJ-112 11110 BCA Account FpE0.000,00
GJ-112 81000 Interest Income Fp125.000,00
GJ-112 E-2500 Office Supplies Fp1.250.000,00
G112 E-2600  Photography Supplies Rp2.000.000,00
GJ-112 11310 Dffice Supplies Inventory Fip1.250.000,00
GJ-112 11320 Photography Supplies lrwve Fip2.000.000,00
GJ-112 E-1400 Depreciation Expenze Rp1.157.000,00
GJ-112 1-2120  Prof Equipment Accum De Rp292.000,00
G112 1-2220  Furniture & Fistures Accur Rp265.000,00
GJ-112 1-2420  Computer Equipment Acc, Fp&00.000,00
GJ-112 B-3030  ‘Wages & Salaries FipE.000.000.00
GJ-112 21400 Salary Payable Rp6.000.000,00

- T
7. ==
Help F1 FPrint

Gambar: 2. 82 Jurnal penyesuaian Kasus 2
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 7.1.

Perusahaan jasa Renata Interior Designer
Entri Penyesuaian per 31 Januari 2013

31/1/13 | Rekening Koran per 31 Jan. ‘13 N-T | GJ-112
Interest Revenue Rp. 125.000,- Memo:
Bank Charges Rp. 65.000,- Adjustment
Persediaan Supplies per 31 Jan. 2013 N-T
Office Supplies Rp. 4.000.000,-
Photograp. Supplies Rp. 8.000.000,-
Penyusutan Aset tetap untuk Jan. 2013: N-T
Prof. Equipment : Rp. 292.000,-
Furniture & Fixtures Rp. 265.000,-
Computer Equipment Rp. 600.000,-
Gaiji Karyawan bulan Jan’13 akan dibayar N-T
pada awal Pebruari’13 sebesar.
Rp. 6.000.000,-

Tabel: 2- 16 Entri Penyesuaian Kasus 1
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Kasus 7.2.

Perusahaan jasa Rio Interior Design
Entri Penyesuaian per 31 Januari 2014

‘Date  Descriptons Details

31/114 | Rekening Koran per 31 Januari ‘14 N-T | RK-112

- Interest Revenue Rp. 125.000,- Memo:

- Bank Charges Rp. 65.000,- Adjustment
311114 | Persediaan Supplies: N-T | GJ 01

-Office Supplies Rp. 4.000.000,- Memo:

-Photography Supplies Rp. 8.000.000,- Adjustment
31114 | Penyusutan Aset tetap untuk bulan Januari | N-T | GJ 02

2014: Memo:

Prof. Equipment : Rp. 292.000,- Adjustment

Furniture & Fixtures Rp. 265.000,-
Computer Equipment  Rp. 600.000,-
31114 | Gaji Karyawan bulan Jan’14 akan dibayar | N-T | GJ 03
pada awal Pebruari’14 Sebesar. Memo:
Rp. 6.000.000,- Adjustment

Tabel: 2- 17 Entri Penyesuaian Kasus 2
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KEGIATAN BELAJAR 8
MENAMPILKAN LAPORAN
KEUANGAN

[ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan
belajar ini diharap-kan peserta didik dapat:

1. Menjelaskan pengertian laporan keuangan.

Menguraikan jenis-jenis laporan keuangan.

Menunjukkan menu untuk penyusunan laporan keuangan
Menyiapkan laporan Laba-Rugi

Menyiapkan laporan Neraca

Menyiapkan Laporan Arus Kas

SoEp @ md g

Menyiapkan laporan Lainnya.

[ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:
Pengertian Laporan Keuangan

Jenis-jenis Laporan Keuangan

Menu untuk Penyusunan Laporan Keuangan
Penyusunan Laporan Laba-Rugi
Penyusunan Laporan Neraca

Penyusunan Laporan Arus Kas

SoE @ Y e =

Penyusunan Laporan Lainnya.
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1. Pengertian Laporan Keuangan

Laporan keuangan adalah informasi finansial tentang kegiatan perusahaan dan
hasil-hasilnya yang disusun berdasarkan standard akuntansi keuangan tertentu
untuk suatu saat atau periode tertentu.

Penyusunan laporan keuangan bertujuan untuk memberikan informasi tentang
posisi keungan, kinerja, dan arus kas perusahaan yang bermanfaat bagi
pengguna laporan, dalam rangka membuat keputusan ekonomi serta sebagai
pertanggung-jawaban manajemen atas penggunaan sumber daya yang
dipercayakan kepadanya.

Program MYOB memproses laporan keuangan berdasarkan data akuntansi
yang telah dientri ke dalam komputer, sepanjang data yang dientri adalah data
yang benar maka laporan keuangan yang akan dihasilkan juga akan benar.

2. Jenis-jenis Laporan Keuangan

Laporan keuangan yang biasa disusun oleh pihak manajemen perusahaan
adalah:

a. Laporan Laba-Rugi; adalah suatu ikhtisar pendapatan dan beban dari
sebuah perusahaan dalam satu periode akuntansi.

b. Neraca; merupakan daftar seluruh aset, utang, dan modal pemilik dari suatu
jangka waktu tertentu (satu periode akuntansi).

c. Laporan perubahan modal; adalah laporan yang menyajikan ikhtisar
perubahan yang terjadi dalam modal pemilik suatu jangka waktu tertentu

d. Laporan Arus Kas, merupakan laporan yang memperlihatkan pengaruh dan
aktifitas operasi, pendanaan, dan investasi perusahaan terhadap arus kas
selama periode akuntansi tertentu.

e. Catatan atas Laporan Keuangan, yaitu laporan lain sebagai bahan
pendukung laporan yang disebutkan di atas.
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3. Menu untuk Penyusunan Laporan Keuangan

MYOB menyediakan fasilitas menu yang berfungsi untuk menyusun berbagai
laporan yang diinginkan: Reports > Index to Reports

Gambar: 2. 83 Menu Report

MYOB menyediakan fasilitas menu yang berfungsi untuk menyusun laporan
Laba-Rugi, Neraca, dan Jurnal Umum:

Fasilitas menu yang berfungsi untuk menyusun laporan Arus kas, Jurnal
Penerimaan Kas dan Jurnal Pengeluaran Kas:

4. Penyusunan Laporan Laba-Rugi

Langkah-langkah Menampilkan Laporan Laba-Rugi

1 Klik Reports, kemudian Klik Index to Reports.
2

3

Klik Accounts, Profit and Loss [Accrual] dan Customise.

Tentukan periode transaksi dan kemudian klik Display.

Direktorat Pembinaan SMK (2013)
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Gambar: 2. 84 Langkah menyiapkan laporan Laba-Rugi

Laporan Laba-Rugi ditampilkan seperti berikut ini.

untuk mengakhiri.

Klik Close

Report Display

Drated From:

To: [31/01/2013

Redisplay

07i01/2014
11:04:08

Renata Interior Designer
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening - Pamulang
Tangerang Selatan

Profit & Loss Statement

January 2013

Income
Sales or Fees
Consultation Fees
Total Income

Costof Sales

Gross Profit

Expenses
Advertising & Promotion
Bank Charges
Depreciation Expense
Insurance
Laundry
Office Supplies
Photography Supplies
Postage
Rent

Staff Amenities
Wages & Salaries
Electricity
Telephone

Total Expenses

Operating Profit
Other Income
Interest Income
Total Other Income
Other Expenses

Met Profit/ (Loss)

[
7
Help F1 Frint Send To

Rp38.500.000,00
Rp8 500 000,00
Rp47.000.000,00

Rp47.000.000,00

Rp2 430 000,00
RpE5.000,00
Rp1.157.000,00
Rp1.100.000,00
Rp100 000,00
Rp1.250.000,00
Rp2.000.000,00
Rp76.000,00
Rp2 500 000,00
Rp220 000,00
RpE.000.000,00
Rp421.000,00
Rp585.000,00
Rp17.904.000,00

Rp29.096.000,00

Rp125.000,00
Rp125.000,00

Rp29.221.000,00

Gambar: 2. 85 Laporan Laba Rugi Kasus 1
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5. Penyusunan Laporan Neraca

Langkah-langkah Menampilkan Laporan Neraca

Klik Reports, kemudian Klik Index to Reports.

Klik Accounts, Standard Balance Sheet dan Customise.

Tentukan periode transaksi dan kemudian klik Display.

Bl WODN -

Laporan Neraca ditampilkan seperti berikut ini. Klik Close untuk
mengakhiri.

¥
/
4
4
1
\\ ‘——‘> ‘l
-
E ~. ~

S
-------__
-~

-

v

5 (5] Report Display =]
As of: [EIEIIENE Redisplay Wiew: | Print Preview

Renata Interior Designer
Pertokoan Pamulang Square Blok B1/17
JI_ Situ Bening - Pamulang
Tangerang Selatan

Balance Sheet

As of January 2013
07/01/2014
11:18:13

Assets
Current Assets

Cash On Hand
BCA Account Rp64.430.000,00
Cash Drawer Rp20.000.000,00
Petty Cash Rp4.604.000,00

Other Curent Assets
Gffice Supplies Inventory Rp4.000.000,00
Photography Supplies Inventory Rp8.000.000,00

Fixed Assets

Professional Equipment
Prof Equipment at Cost Rp35.000.000,00
Prof Equipment Accum Dep (Rp7.292.000,00)

Fumiture & Fitures
Fumniture & Fixtures at Cost Rp32.000.000,00
Fumiture & Fixtures Accum Dep (Rp6.665.000,00)

Camputer Equipment
Computer Equipment at Cost Rp44.300.000,00
Computer Equipment Accum Dep (Rp15.400.000,00)

Total Assets RP192.977.000,00

Liabilities
Current Liabilities
dit Cards
Bankcard Rp1.006.000,00
PPN Liabilities
PPN Collected Rp4.700.000,00
Salary Payable Rp5.550.000,00
Long-Term Liabilties
CA Loans Rp50.000.000,00
Total Liabilities Rp571.256.000,00

Net Assets Rp131.721.000,00

Equity
Owner's Equity
Renata’s Capital Rp120.000.000,00
Renata’s Drawings (Rp17.500.000,00)

Current Year Eamings Rp29.221.000,00
Total Equity

Rp131.721.000,00 -
K1 | _>|_I

5) = %
ACILE
Frint Send To

Help F1

Gambar: 2. 87 Laporan Neraca Kasus 1
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6. Penyusunan Laporan Arus Kas

Langkah-langkah Menampilkan Laporan Arus Kas

1 Klik Reports, kemudian Klik Index to Reports.
Klik Banking, Statement of Cash Flow dan Customise.
Tentukan periode transaksi dan kemudian klik Display.

N

___——,'/
’,
e
4
1
AN
SA ~
\ _-—‘" Y 4
-
\ o NI\ AN |
1
I ~
Vi ~~

--—--___-~
~
~,
N
\
1

Gambar: 2. 88 Langkah menyiapkan laporan Arus Kas.

4 Laporan Arus Kas ditampilkan seperti berikut ini. Klik Close untuk
mengakhiri.
(&) Report Display [E=N e ==

Redisplay

Dated From: [O1/07/2003 | To: [31/01/2013 View: | Print Preview

Renata Interior Designer
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening - Pamulang
Tangerang Selatan

Statement of Cash Flow

07i01/2014
11:20:34

January 2013

Cash Flow from Operating Activities
Net Income

Office Supplies Inventory
Photography Supplies Inventory
Bankcard
PPN Collected
PPN Payable
Salary Payable
Net Cash Flows from Operating Activities

Cash Flow from Investing Activities
Prof Equipment Accum Dep
Furniture & Fixtures Accum Dep
Computer Equipment at Cost
Computer Equipment Accum Dep
Net Cash Flows from Investing Activities

Cash Flow from Financing Activities
Renata's Capital
Net Cash Flows from Financing Activities

Net Increase/Decrease for the period

Cash atthe Beginning of the period
Cash atthe End ofthe period

K1
7. | W
HelpF1 | Pint | SendTo

$29.221.000,00

Rp1.250.000,00
Rp2.000.000,00
RP4.994.000,00)
Rp4.700.000,00
Rp7.500.000,00)
Rp500.000,00
— p25.177.000,00

Rp292.000,00

RP600.000.00
RpE.143.000,00)

£20.000.000,00
~ p20.000000,00

FITOIA 000,00
p50.000.000,00
599.034.000.00

;I_I

Gambar: 2. 89 Laporan Arus Kas Kasus 1
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7. Penyusunan Laporan Lainnya

Laporan lain yang akan diproses adalah:

Jurnal Pengeluaran Kas
Jurnal Penerimaan Kas
Jurnal Umum

[V]

. Langkah-langkah Menampilkan Jurnal Pengeluaran Kas

1 Klik Reports, kemudian Klik Index to Reports.

Gambar: 2. 90 Menu Report

Klik Banking, Cash Disbursment dan Customise.

3 Tentukan periode transaksi dan kemudian klik Display.
7’
__—:,"'
\
n ~
N~ =
\\ . - » N " '[
17 - \
4 Seo
': —————— -~
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\
1
v

Gambar: 2. 91 Langkah menyiapkan Jurnal Pengeluaran
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Jurnal Pengeluaran Kas ditampilkan seperti berikut ini. Klik Close
untuk mengakhiri.

Report Display = R 5|
Tor | 31/01/2013 Redisplay View: |Pﬂnt Preview =

Dated From:

Renata Interior Designer :1
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening - Pamulang
Tangerang Selatan

Cash Disbursements Journal

01/01/2013 To 31/01/2013

071012014
10:35:05
ID# Acct# Account Name Debit Credit
CcD 10/01/2013 beban & ian aset
230 1-1110 BCA Account p32.330.000,00
230 2-1400 Salary Payable p5.500.000,00
230 6-1800 Insurance p1.100.000,00
230 2-1350 PPM Payable p7.500.000,00
230 1-2410 Computer Equipment at Cost  p7.200.000,00
230 2-1110 Bankcard p6.000.000,00
230 6-1100 Advertising & Promotion p2.430.000,00
230 6-2800 Rent p2.500.000,00
CcD 15/01/2013  Petty cash items
V-017 1-1140 Petty Cash Rp396.000,00
V-017 6-2100 Laundry Rp100.000,00
V-017 6-2700 Postage Rp76.000,00
V-017 6-3010 Staff Amenities Rp220.000,00
CcD 18/01/2013  Rekening Telkom dan Listrik
B-029 2-1110 Bankcard p1.006.000,00
B-029 6-3100 Telephone Rp585.000,00
B-029 6-3410 Electricity Rp421.000,00

Grand Total: p33.732.000,00 p33.732.000,00

- - Ed
7. &=
Help F1 FErrint Send To

Gambar: 2. 92 Jurnal Pengeluaran Kasus 1
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b. Langkah-langkah Menampilkan Jurnal Penerimaan Kas

1 Klik Reports, kemudian Klik Index to Reports.
2 Klik Banking, Cash Receipt dan Customise.
3 Tentukan periode transaksi dan kemudian klik Display.
Renata Interior Designer - Command Centre [EI=r=]
ACDT—“ iﬂ‘i"ﬂl . ISE!ESI gi:h: i
~” Hame <€
\p HYDB M-Powered bank stalements «
4 Bank Statements -
U | Account Balances b
NG liensoctoelE o Advanced Fiters | Repofies | Finshing | 3
%SW‘S‘]“’SW&"{S Transaction Date: [ January =] To: [January = Session Date: [Date Range =] To [Date Range =] ¥
Recurting Transactiom w, e P13 ’Tu 3170172019 To -
Eheuuis S - - oD o 2 User IDs =l e
R S \‘, ArsitfEn ‘\'/' Te[ 1 SarEadich | (EEED =k
To Do List ,l A 3
Recuring Banking Transactions o8 | ~_____ K
o ViewSomple | [+ tonise Catagories ] e —— - ¢
Memo/Payee: So ¢
% = ~ S i
I 7. =y W 4 ¢
Help F1 Print | SendTo 2 — : -
‘JL" HepF1 | Pint | SendTo | Fomat :'
e e P A At e b b e i
4 Jurnal Penerimaan Kas ditampilkan seperti berikut ini. Klik Close
untuk mengakhiri.
Report Display EI@
Drated From: |D1x’D1 f2ms Ta |31/01/2013 R edisplay Wigar |F'rint Preview |
Renata Interior Designer :‘
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening - Pamulang
Tangerang Selatan
Cash Receipts Journal
01/01/2013 To 31/01/2013
0710172014
10:32:46
1D Acct# Account Name Debit Credit
CR 2000112013  Setoran Modal dari Pemilik
CR-05 1-1130 Cash Drawer p20.000.000,00
CR-05 3-1100 Renata's Capital p20.000.000,00
CR 29/01/2013 Penerimaan dari penjualan tunai
CR-06 1-1110 BCA Account p51.700.000,00
CR-06 4-1000 Sales or Fees p38.500.000,00
CR-06 4-2000 Consultation Fees p&.500.000,00
CR-06 2-1310 PPN Collected p4.700.000,00
Grand Total: p71.700.000,00 p71.700.000,00
<1 o ;l_‘
5) — ..
7. =
Help F1 Frint SendTo

Gambar: 2. 93 Jurnal Penerimaan Kas Kasus 1
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c. Langkah-langkah Menampilkan Jurnal Umum

Klik Reports, kemudian Klik Index to Reports.

Klik Accounts, General Journal dan Customise.

Tentukan periode transaksi dan kemudian klik Display.

LY

Renata Interior Designer - Command Centre [= ==

€ Brizrorerors B repereCurominion el | ==
" 8T/ i
'!Eﬂ'ﬂi Banking | gojes T | 59 | pilin]|

——
- [ Name:
L9 Transaction Joumals

Jobs
Activity Summary

~
> Advanced Filters r Repart Field: I Finizhing ]

A A A A A A

‘Activity Detail N
Budges Hisory [DffceLik] Yy Transaction Date:[Jaruay %] To:[Jaay %] Session Diate: [Date Range [+ To: [Date Range %]
Fistor [OffceLirk] T — ] —
Job Transactions 1 - ¥ @ M
Joh Esceptions [Cash Transactios] Fiom 1D % User IDs: = M
Job Exceplions (Imvoice Transacfons] " Amount From To \ Source Joumak | General -
Prafit & Loss H ~ 3
Fieimbursable Expenses I Sem.
Budget Analysis -‘——__. )
o View Sample i ustorke Categories = ~\\ j
temo/Payee: \
7. | | : 4
HepF1 | Pint | SendTo e o 3 <
HebF1 | Pint | SendTo | Fomat j
e e o L S PP S ROV S S SN S AP

Gambar: 2. 94 Langkah menyiapkan Jurnal Umum

Jurnal Umum ditampilkan seperti berikut ini. Klik Close untuk
mengakhiri.

(5] Report Display (=)= =
Dated From: [01/01/2013 | To: [31/01/2013 Redisplay View: | Piint Preview w|
Renata Interior Designer j

Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening - Pamulang
Tangerang Selatan

General Journal

01/01/2013 To 31/01/2013

07/01/2014
10:36:39
ID# Acct# Account Name Debit Credit

GJ 3110112013 Adjustment
GJ-112 1-1110 BCA Account Rp60.000,00
GJ-112 6-1210 Bank Charges Rp65.000,00
GJ-112 8-1000 Interest Income Rp125.000,00
GJ-112 6-2500 Office Supplies p1.250.000,00
GJ-112 £-2600 Photography Supplies p2.000.000,00
GJ-112 1-1310 Office Supplies Inventory p1.250.000,00
GJ-112 1-1320 Photography Supplies Inventor p2.000.000,00
GJ-112 £-1400 Depreciation Expense p1.157.000,00
GJ-112 1-2120 Prof Equipment Accum Dep Rp292.000,00
GJ-112 1-2220 Furniture & Fixtures Accum De Rp265.000,00
GJ-112 1-2420 Computer Equipment Accum D Rp600.000,00
GJ-112 6-3030 Wages & Salaries p6.000.000,00
GJ-112 2-1400 Salary Payable p6.000.000,00

Grand Total:  p10.532.000,00 p10.532.000,00

=l
¥/ = 3
7. | WD

Help F1 Frint Send To

Gambar: 2. 95 Jurnal Umum Kasus 1
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[ c. Rangkuman ]

» Laporan keuangan adalah informasi finansial tentang kegiatan perusahaan
dan hasil-hasilnya yang disusun berdasarkan standard akuntansi keuangan
tertentu untuk suatu saat atau periode tertentu.

* Tujuan Penyusunan laporan keuangan memberikan informasi tentang posisi
keuangan, kinerja, dan arus kas perusahaan yang bermanfaat bagi
pengguna.

» Laporan keuangan yang biasa diproses perusahaan antara lain Laporan
Laba-Rugi, Laporan Perubahan Modal, Neraca, Arus Kas dan Catatan atas
Laporan Keuangan.

* MYOB menyedia menu untuk menghasilkan berbagai jenis laporan
keuangan: Reports > Index to Reports.

» Laporan keuangan yang dapat diproses oleh MYOB antara lain Laporan
Laba-rugi, Neraca, Arus Kas dan Laporan lainnya.
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[ d. Tugas ]

Kerjakan tugas-tugas berikut ini !
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk menyiapkan laporan keuangan antara lain:

a. Laporan Laba-Rugi

b. Laporan Neraca

c. Laporan Arus Kas

d. Laporan lainnya, yaitu Jurnal Pengeluaran Kas, Jurnal Penerimaan
Kas dan Jurnal Umum.

Direktorat Pembinaan SMK (2013)
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:
. Test Pengetahuan dan
. Tes Keterampilan

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Laporan keuangan adalah laporan yang bersifat finansial. Pilih mana yang
tidak termasuk laporan keuangan di bawah ini:

Laporan pemakaian supplies tiap bulan.
Laporan depresiasi aset tetap perusahaan.
Laporan kerusakan mobil perusahaan.
Laporan bulanan penjualan jasa per wilayah.
Laporan pembayaran listrik bulanan.

I T i

2. Laporan yang menginformasikan posisi aset, kewajiban dan equitas
perusahaan pada periode tertentu adalah:

a. Laporan Laba-Rugi

b. Neraca

c. Laporan perubahan modal

d. Arus Kas

e. Catatan atas Laporan Keuangan

3. Laporan yang menginformasikan ikhtisar perubahan yang terjadi dalam
equitas pemilik suatu jangka waktu tertentu:

a. Laporan Laba-Rugi

b. Neraca
C. Laporan perubahan modal
d. Arus Kas

e. Catatan atas Laporan Keuangan

4. Laporan yang menginformasikan suatu ikhtisar pendapatan dan beban dari
sebuah perusahaan dalam satu periode akuntansi:

Laporan Laba-Rugi

Neraca

Laporan perubahan modal

Arus Kas

Catatan atas Laporan Keuangan

PaO0oTO
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5. Laporan yang memperlihatkan pengaruh dan aktivitas operasi, pendanaan,
dan investasi perusahaan terhadap arus kas selama periode akuntansi
tertentu:

a. Laporan Laba-Rugi

b. Neraca

C. Laporan perubahan modal

d. Arus Kas

e. Catatan atas Laporan Keuangan

6. Laporan yang memperlihatkan perincian persediaan supplies selama
periode akuntansi tertentu:

a. Laporan Laba-Rugi

b. Neraca
Cc. Laporan perubahan modal
d. Arus Kas

e. Catatan atas Laporan Keuangan
7. Langkah untuk menampilkan laporan Laba-Rugi:

Index to reports>Reports>Tab Account > Profit & Loss (Accrual)
. Account > Index to reports > Tab Account > Profit & Loss
Reports>Tab Account>Index to reports > Profit & Loss (Accrual)
Report > Account > Tab Account > Profit & Loss (Accrual)
Reports>Index to reports >Tab Account >Profit & Loss (Accrual)

Poo o

8. Langkah untuk menampilkan laporan Neraca:

Reports > Index to reports > Balance > Standard Balance Sheet
Account > Index to reports > Standard Balance Sheet
Reports > Index to reports > Standard Balance Sheet
Index to reports > Reports > Standard Balance Sheet
Reports>Index to reports>Tab Account>Standard Balance Sheet

©ooow

9. Langkah untuk menampilkan laporan Arus Kas:

a. Account >Index to reports>Tab Banking>Statement of Cash Flow
b. Banking > Index to reports > Statement of cash Flow

c. Banking > Reports > Statement of Cash Flow

d. Reports > Index to reports > Tab Banking > Statement of Cash Flow
e. Banking > Statement of cash Flow

10. Langkah untuk menampilkan Jurnal Umum:

a. Account > Index to reports > Tab Banking > General Journal
b. Reports > Index to reports > Tab Account > General Journal
c. Reports > Index to reports > General Journal

d. Reports > Reports > General Journal

e. Reports > General Journal
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2. Tes Keterampilan.

Kasus 2: Perusahaan jasa Rio Interior Design
(Lihat di Lembar Kerja Peserta Didik)

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada kahir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file (PDF).

3. Tugas yang harus diselesaikan: menyiapkan laporan keuangan per
31/1/2014 yang meliputi: Laporan Laba-Rugi, Neraca, Arus Kas,
Jurnal Pengeluaran Kas, Jurnal Penerimaan Kas dan Jurnal Umum.

Direktorat Pembinaan SMK (2013)
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

1 (o}
2 b
3 c
4 a
5 d
6 e
7 e
8 e
9 d
10 b
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2. Kunci Tes Keterampilan

& Report Dipiy eloEs
[ ated From: To | 31201/2014 Redizplay Wigw: | Pririt Preview hd
Rio Interior Design :‘

Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening, Pamulang
Tangerang Selatan

Profit & Loss Statement

January 2014

20/01/2014
83714

Income
Sales or Fees
Consultation Fees
Total Income
Cost of Sales
Gross Profit

Expenses

Advertising & Promotion

Bank Charges

Depreciation Expense

Insurance
Laundry
Office Supplies

Photography Supplies

Postage
Rent
Staff Amenities
Wages & Salaries
Telephone
Electricity

Total Expenses

Operating Profit

Other Income
Interest Income

Total Other Income

Other Expenses

Met Profit/ (Loss)

-

7. | ==

Help F1 Print

Rp38.500.000,00
Rp8.500.000,00
Rp47.000.000,00

Rp47.000.000,00

Rp2.430.000,00
Rp65.000,00
Rp1.157.000,00
Rp1.100.000,00
Rp100.000,00
Rp1.250.000,00
Rp2.000.000,00
Rp76.000,00
Rp2.500.000,00
Rp220.000,00
Rp6.000.000,00
Rp585.000,00
Rp421.000,00
Rp17.904.000,00

Rp29.096.000,00

Rp125.000,00
Rp125.000,00

Rp29.221.000,00

Gambar: 2. 96 Laporan Laba-Rugi Kasus 2
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= Repor Diplny ==
&g of: Redisplay Yiew: | Print Preview hd

Rio Interior Design :‘
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening, Pamulang
Tangerang Selatan

Balance Sheet

As of January 2014
20/01/2014

8:45:43

Assets
Current Assets
Cash On Hand

BCA Account Rp73.424.000,00

Cash Drawer Rp10.000.000,00

Petty Cash Rp4.604.000,00
Other Current Assets

Office Supplies Inventory Rp4.000.000,00

Photography Supplies Inventory Rp8.000.000,00

Fixed Assets
Professional Equipment

Prof Equipment at Cost Rp35.000.000,00
Prof Equipment Accum Dep (Rp7.292.000,00)
Furniture & Fixtures
Furniture & Fixtures at Cost Rp32.000.000,00
Furniture & Fixtures Accum Dep (Rp6.665.000,00)
Computer Equipment
Computer Equipment at Cost Rp44.300.000,00
Computer Equipment Accum Dep (Rp15.400.000,00)
Total Assets Rp181.971.000,00
Liabilities
Current Liabilities
PPN Liabilities
PPM Collected Rp4.700.000,00
Salary Payable Rp5.550.000,00
Long-Term Liabilities
BCA Loans Rp50.000.000,00
Total Liabilities Rp60.250.000,00
Met Assets Rp121.721.000,00
Equity
Owner's Equity
Renata's Capital Rp110.000.000,00
Renata's Drawings (Rp17.500.000,00)
Current Year Earnings Rp29.221.000,.00
Total Equity Rp121.721.000,00

7. | oy | B
Help F1 Print

Send To

Gambar: 2. 97 Laporan Neraca Kasus 2
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=N B =™

@ Report Display

Dated From: |01./071/52014 To: | 31401720014 Redisplay Views | Print Preview |
Rio Interior Design :‘
Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening, Pamulang
Tangerang Selatan
Statement of Cash Flow
January 2014
200012014
8:47:20

Cash Flow from Operating Activities
MNet Income

Office Supplies Inventory
Photography Supplies Inventory
Bankcard
PPM Collected
PPM Payable
Salary Payable
Met Cash Flows from Operating Activities

Cash Flow from Investing Activities
Prof Equipment Accum Dep
Furniture & Fixtures Accum Dep
Computer Equipment at Cost
Computer Equipment Accum Dep
Met Cash Flows from Investing Activities

Cash Flow from Financing Activities
Renata’s Capital
Met Cash Flows from Financing Activities

Met Increase/Decrease for the period

Cash atthe Beginning ofthe period
Cash atthe End of the period

_|

=

7. | =s

Help F1 Erint Send To

p29.221.000,00

Rp1.250.000,00
Rp2.000.000.00
Rp6.000.000,00)
Rp4.700.000,00
Rp7.500.000,00)
Rp500.000,00
—  p24.171.000,00

Rp292.000,00
Rp265.000,00

Rp7.200.000,00)
Rp600.000,00

T Rp6.142.000,00)

p10.000.000,00
— p10.000.000,00
"pZE.023.000,00

p60.000.000,00

f
3
Customise Save bz Cloze

Gambar: 2. 98 Laporan Arus Kas Kasus 2

Direktorat Pembinaan SMK (2013)

149




Komputer Akuntansi Jilid 1

(1 Repor: Display EEese
Dated From: To: |31 A01/2004 Redisplay Wiew: |F'rint Preview b
JIL Situ Bening, Hamulang ﬂ
Tangerang Selatan
Cash Disbursements Journal
01/01/2014 To 31/01/2014
20/01/2014
8:50:25
1D Acct# Account Name Debit Credit
cD 02/01/2014 Paid salary payable J
320 1-1110 BCA Account p5.500.000,00
320 2-1400 Salary Payable p5.500.000,00
CcD 02/01/2014  Paid Insurance
321 1-1110 BCA Account p1.100.000,00
321 G-1800 Insurance p1.100.000,00
CD 03/01/2014  Paid PPN Payable
322 1-1110 BCA Account p7.500.000,00
322 2-1350 PPN Payable p7.500.000,00
CD 04/01/2014  Paid Phone Bill
323 1-1110 BCA Account p7.300.000,00
323 1-2410 Computer Equipment at Cost  p7.300.000,00
CD 05/01/2014  Paid Bankcard bill
324 1-1110 BCA Account p6.000.000,00
324 2-1110 Bankcard p6.000.000,00
CD 06/01/2014  Paid Advertising
325 1-1110 BCA Account p2.430.000,00
325 6-1100 Adwvertising & Promotion p2.430.000,00
cD 07/01/2014  Paid monthly rent
326 1-1110 BCA Account p2.500.000,00
326 G-2800 Rent p2.500.000,00
CD 08/01/2014  Petty Cash items
W-01 1-1140 Petty Cash Rp176.000,00
W-01 G-2100 Laundry Rp100.000,00
W-01 G-2700 Postage Rp76.000,00
CD 09/01/2014  Petty Cash ltems
V-02 1-1140 Petty Cash Rp220.000,00
V-02 6-3010 Staff Amenities Rp220.000,00
CD 10/01/2014  Paid Telkom Bill
B-01 1-1110 BCA Account Rp585.000,00
B-01 6-3100 Telephone Rp585.000,00
CD 11/01/2014  Paid Electricity Bill
B-02 1-1110 BCA Account Rp421.000,00
B-02 G-3410 Electricity Rp421.000,00
Grand Total: p33.732.000,00 p33.732.000,00 -
3
7. |
Help F1 Print

Gambar: 2. 99 Jurnal Pengeluaran Kas Kasus 2
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(5] Report Display [E=8[E=R =
Dated From: To | 310142014 Redizplay Wi |F'rint Preview hd
Rio Interior Design =l
Pertokoan Pamulang Square Blok B1/A17
JI. Situ Bening, Pamulang J

Tangerang Selatan
Cash Receipts Journal

01/01/2014 To 31/01/2014

2010112014
8:51:27
D¢ Acct# Account Name Debit Credit

CR 12/01/2014  Capital Contribution

Cr-05 1-1110 BCA Account p10.000.000,00

Cr-05 31100 Renata's Capital p10.000.000,00
CR 15/01/2014  Project Sale

CR-01 1-1110 BCA Account p13.200.000,00

CR-01 4-1000 Sales or Fees p12.000.000,00

CR-01 2-1310 PPN Collected p1.200.000,00
CR 17/01/2014  Project Sale

CR-02 1-1110 BCA Account p18.150.000,00

CR-02 4-1000 Sales or Fees p16.500.000,00

CR-02 2-1310 PPN Collected p1.650.000,00
CR 24/01/2014  Consultation

CR-03 1-1110 BCA Account p2.750.000,00

CR-03 4-2000 Consultation Fees p2.500.000,00

CR-03 2-1310 PPN Collected Rp250.000,00
CR 26/01/2014  Project Sale

CR-04 1-1110 BCA Account p11.000.000,00

CR-04 4-1000 Sales or Fees p10.000.000,00

CR-04 2-1310 PPN Collected p1.000.000,00
CR 28/01/2014  Consultation

CR-06 1-1110 BCA Account p4.400.000,00

CR-06 4-2000 Consultation Fees p4.000.000,00

CR-06 2-1310 PPN Collected Rp400.000,00
CR 29/01/2014  Consultation

CR-07 1-1110 BCA Account p2.200.000,00

CR-07 4-2000 Consultation Fees p2.000.000,00

CR-07 2-1310 PPN Collected Rp200.000,00

Grand Total: p61.700.000.00  p61.700.000,00 -
»

_l
?. i W
Help F1 Brint

Send To

Gambar: 2. 100 Jurnal Penerimaan Kas Kasus 2
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(5] Repor Display (=)= )
Dated From: Tao: | 317012014 Fedisplay Wiew: | Print Presvigw hd
Rio Interior Design :‘

Pertokoan Pamulang Square Blok B1/17
JI. Situ Bening, Pamulang
Tangerang Selatan

General Journal

01/01/2014 To 31/01/2014

20/01/2014
8:52:37
[ Acct# Account Hame Debit Credit

GJ 31/01/2014  Adjustment
GJ-112 6-1210 Bank Charges Rp65.000,00
GJ-112 1-1110 BCA Account Rp60.000,00
GJ-112 8-1000 Interest Income Rp125.000,00
GJ-112 G-2500 Office Supplies p1.250.000,00
GJ-112 G-2600 Photography Supplies p2.000.000,00
GJ-112 1-1310 Office Supplies Inventory p1.250.000,00
GJ-112 1-1320 Photography Supplies Inventor p2.000.000,00
GJ-112 G-1400 Depreciation Expense p1.157.000,00
GJ-112 1-2120 Prof Equipment Accum Dep Rp282.000,00
GJ-112 1-2220 Furniture & Fixtures Accum De Rp265.000,00
GJ-112 1-2420 Computer Equipment Accum D Rp&00.000,00
GJ-112 6-3030 Wages & Salaries p6.000.000,00
GJ-112 2-1400 Salary Payable p6.000.000,00

Grand Total:  p10.532.000,00 p10.532.000,00

=
). | WD

Help F1 Brint SendTo

Gambar: 2. 101 Jurnal Umum Kasus 2
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 8.1.
Menyusun laporan keuangan untuk perusahaan jasa:

Renata Interior Designer

Laporan Keuangan:
e Laporan Laba-rugi
e Laporan Neraca
e Laporan Arus Kas

Jurnal Transaksi:
e Jurnal Pengeluaran Kas
e Jurnal Penerimaan Kas
e Jurnal Umum

Kasus 8.1.
Menyusun laporan keuangan untuk perusahaan jasa:

Renata Interior Designer

Laporan Keuangan:
e Laporan Laba-rugi
e Laporan Neraca
e Laporan Arus Kas

Jurnal Transaksi:
e Jurnal Pengeluaran Kas
e Jurnal Penerimaan Kas
e Jurnal Umum
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KEGIATAN BELAJAR 9
MEMBUAT FILE BACKUP

{ a. Tujuan Pembelajaran ]

Dengan diberikan kasus akuntansi perusahaan jasa, maka pada akhir kegiatan
belajar ini diharap-kan peserta didik dapat:

1.
2. Menunjukkan menu pembuatan File Backup
3.

4. Me-Restore File Backup

Menjelaskan pengertian File Backup

Membuat File Backup

{ b. Uraian Materi ]

Lingkup materi kegiatan belajar ini meliputi:

1
2
3.
4

Pengertian File Backup
Menu untuk Pembuatan File Backup
Pembuatan File Backup

Restore File Backup

154
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1. Pengertian File Backup

Backup adalah membuat salinan dari file-file penting. Tujuan pembuatan file
backup dilakukan untuk menjamin integritas atau keutuhan data ketika file
aslinya mengalami kerusakan karena terserang virus dsb.

Proses pembuatan file backup biasanya meminta tempat/media
penyimpanan yang berbeda dengan media penyimpanan file asli. Jadi
dengan adanya pembuatan file backup maka satu file yang sama
minimal disimpan di dua media yang berbeda.

Pada umumnya program komputer akuntansi melengkapi aplikasinya
dengan fasilitas untuk membuat backup file termasuk program MYOB.

2. Menu untuk Pembuatan File Backup

MYOB menyediakan fasilitas menu untuk membuat file backup:

_vosacccunins  RERERETTT R

Edit Lists Command Centres Setup Reports Window Help

New

| e s

Open File Ctrl+0 g
ACCOUNTS 9|

Clese Window Esc w |
Print... Ctrl+P T i ..*'7@
Print Setup... ;%
kot Time Billing Purchases Irweeritany Card File
Back Up...

Restore...

Ctrl+N

Verify Company File...
Optimise Company File

Purge Journal Entries

Start a New Year

Import Data M-Powered G
. i Saervices

Export Data @ Transaction Joumal ﬁ} it

Accountantlink

Bt actions w Feports w Analysis w

¢
Record Journal Entry

&

@ BASlink

Gambar: 2. 102 Menu membuat file backup
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3. Pembuatan File Backup
Hal-hal yang perlu diperhatikan dalam proses pembuatan file backup adalah:

e Siapkan media penyimpanan yang berbeda dengan media di mana file asli
disimpan.
e Nama file backup.
o File backup ini akan berbentuk ZIP file.
Langkah-langkah pembuatan file backup.

1 Klik File dan Backup.

Gambar: 2. 103 Memilih menu file > Backup

2 Menentukan pilihan Backup Company File
MYOE Accounti

MYOB can back up the folders and files that suppart your company file, including
customized templates | BASlink setup, and araphics. Alternatively, vou can
chooze to back up the company file and M-Powered Services Centre anly,

" Back up all data
¢ Backup Company File and M-Powered Services Centre only

You may check the data in your company file for ermors now, or check it later by
choozing Yerify Company File from the File menu. Depending on the size of your
compary file, the verification process may take a considerable amount of time.

" Check Company File far erars
{® Do not check Company File for errors

Help | Cancel | Continue I

Gambar: 2. 104 Penentuan pilihan file backup
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3 Menentukan media penyimpanan dan nama file backup.
3 ==
o=
Organize + New folder = - e
I Favorites — Documents library Arangeby: Folder =
B Desktop Backup
] Recent Places Name Date madified Type
18 Downloads
No items match your search.
7 Libraries L
| Documents 1
J‘ Music
& Pictures
i Videos

"% Computer —
a Windows7_05S (C

<} CD Drive (E)
a Lenovo Recover, ™ ¢ | ] '
[ZIELELEMIRID -Suyono Backyl -
Save as type: | MVOB Backup File [*21P) -

Gambar: 2. 105 Penentuan media penyimpanan dan nama file backup

4 Klik Save untuk menyimpan file backup
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4. Me-Restore File Backup
Hal-hal yang perlu diperhatikan dalam proses me-restore file backup adalah:
¢ Menentukan nama file backup yang akan di-restore.

¢ Siapkan media untuk me-restore file backup.

Langkah-langkah me-restore file backup.

1 Klik File dan Restore.

Gambar: 2. 106 Menu untuk me-restore backup file

2 Menentukan file yang akan di-restore dan klik Open.
(&] Select File to Restor: (e =)
<0 BT

Organize New folder =~ B8 ®
9t Favorites Documents library Arange by Folder =
B Desktop Backup
‘&l Recent Places Name Date modified
% Downloads
|2 RID-5uyono Backup 07/01/2014 11:25
79 Libraries No pqe‘l;'lew
avallable.
@ Documents
J}‘ Music
[&] Pictures
B videos
B Camnuter ad 9 i | E
File name: RID-Suyono Backup - [MVDB Data (*.ZIP) ']
[ Open |v] l Cancel I

Gambar: 2. 107 Pilih nama backup file yang di restore
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3 Klik Nama file yang akan di-restore dan klik Save.
(5] save s

. ‘ - _j,_.. < My Documents » Backup - Search Backup pel

Organize ~ New folder == - @
9 Favorites Documents library P oy Foier 1=
= Desktop Backup
2l Recent Places MNarne Date modified Type
4 Downloads
Mo iterns match your search,
4 Libraries
@ Documents
J\ Music
[ Pictures
B Videos = |5 L | ’
File name: =
Save as type: | MYOE Data (~MYO) -
‘% Hide Folders I Save I [ Cancel ]

Gambar: 2. 108 Beri Pilih nama file restore

4 Klik OK untuk menyimpan file yang telah di-restore.

The restored comparny file will be named

@ "RID-Supono kMY 0" and zaved in the directary
hamed
"CAlzerstLaB-Aak U TANSIOAD ocumentshB ackup'

Cancel |

Gambar: 2. 109 Konfirmasi nama file restore
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[ c. Rangkuman ]

» File backup adalah file cadangan untuk menjaga integritas data ketika file
asli mengalami kerusakan.

* File backup biasanya disimpan di media yang lain di luar tempat
penyimpanan file asli.

*  Menu untuk membuat file backup adalah:
File > Backup
» File backup ini berbentuk ZIP file.

* Restore adalah membuka kembali file backup ke dalam bentuk file aslinya.
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{ d. Tugas ]

Kerjakan tugas-tugas berikut ini !
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per
kelompok.

2. Setiap peserta didik mengerjakan tugas-tugas ini, tetapi proses
pemecahan kasus dapat dilakukan melalui diskusi kelompok.

3. Didasarkan pada Kasus Renata Interior Designer peserta didik
ditugaskan untuk membuat file backup yang diberi nama: RID-Suyono
Backup dan disimpan di My Document/Backup

4. Me-restore file backup yang telah dibuat.
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[ e. Tes Formatif ]

Tes Formatif meliputi dua kemampuan, yaitu:
. Test Pengetahuan dan
. Tes Keterampilan

1. Tes Pengetahuan.

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b,
¢, d atau e dari setiap item soal pilihan ganda di bawah ini:

1. Langkah untuk membuat backup file:
a. File > Backup > Klik opsi backup > Ketik nama file > Save
b. Backup > Klik opsi backup > Ketik nama file > Save
c. Backup > File > Klik opsi backup > Ketik nama file > Save
d. File > Klik opsi backup > Backup > Ketik nama file > Save
e. File > Backup > Ketik nama file > Save

2. Backup file merupakan ZIP file artinya:
a. Mempunyai size yang sama dengan file aslinya
b. Mempunyai size yang lebih besar dengan file aslinya
c. Mempunyai size yang lebih kecil dengan file aslinya
d. Mempunyai fungsi yang tidak sama dengan file aslinya
e. Tidak ada perbedaan dengan file aslinya

3. Alasan perlunya pembuatan backup file:
a. Kekuatan data
b. Kekurangan data
c. Kelebihan data
d. Integritas data
e. Kelemahan data

4. Langkah untuk me-restore backup fle:
a. File > Backup > Pilih Bacup file > Open > Ketik nama file > Save
b. File>Pilih Bakcup file> Restore > Open > Ketik nama file > Save
c. File > Restore > Open > Ketik nama file > Save
d. File >Restore > Pilih Bacup file > Save > Ketik nama file > Open
e. File >Restore > Pilih Bacup file > Open > Ketik nama file > Save

5. Dalam restore file, alasan dianjurkannya memberikan nama file yang lain
dari nama file aslinya:

Agar tidak terjadi file kembar

Agar nama file lebih bervariasi

Agar tidak terjadi tumpang-tindih (replace) file aslinya.

Agar tidak terjadi gabungan file

Agar tidak terjadi dua file yang berbeda nama tetapi isinya sama.

®o00TD
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2. Tes Keterampilan.

Kasus 2: Perusahaan jasa Rio Interior Design
(Lihat di Lembar Kerja Peserta Didik)

Instruksi:

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh
peserta didik secara berkelompok.

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil
pekerjaannya dalam bentuk file (PDF).

3. Tugas yang harus diselesaikan adalah membuat backup file untuk hasil
pemecahan kasus 2 dan kemudian me-restore kembali backup file
tersebut di folder tertentu.
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[ f. Kunci Jawaban Tes Formatif ]

Kunci Jawaban Tes Formatif ini meliputi:

e Kunci Test Pengetahuan dan
o Kunci Tes Keterampilan

1. Kunci Tes Pengetahuan

GBI WOIN -
oD |Q|l0|D

2. Kunci Tes Keterampilan

.+ Libraries » Documents » Backup »

QOrganize = g QOpen « Share with « E-mail Burn Mew folder
7t Favorites Documents library
.4 Desktop Backup
‘5! Recent Places e
4 Downloads
@ RID-Suyono Backup
= Libraries |g RIOD-Suyono-Backup

@ Documents
7| My Documents
. Public Documents
J' Music
[& Pictures
¥ Videos

Gambar: 2. 110 File backup Kasus 2
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. . | | « Documents » Backup » Search Backup pel

Organize + New folder E~- O ®
7t Favorites Documents library Amangeby: Folder
B Desktop Backup
‘1= Recent Places Name Date modified
I Downloads
@ RID-Suyono Backup 07/01/2014 11:25
B Libraries |§ RIOD-Suyono-Backup 20/01/20141515  No preview
available.
@ Documents
J‘ Music
[&=] Pictures
EE Videos
ﬂ-;‘ Comnuter | < | U ‘ 1
File name: RIOD-Suyono-Backup - [MVDB Data (~.ZIP) ']
[ open |+] [ cone |

Gambar: 2. 111 File Restore Kasus 2
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[ g. Lembar Kerja Peserta Didik ]

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta didik di
komputer melalui program MYOB versi 18.

Kasus 8.1.

Membuat File Backup dan Restore:

Renata Interior Designer

File Backup:
RID-Suyono Backup

Restore File:
RID-Suyono

Kasus 8.2.
Membuat File Backup dan Restore:
Rio Interior Design

File Backup:
RIOD-Suyono Backup

Restore File:
RIOD-Suyono
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BAB il

EVALUASI

™) A. Attitude Skills

1. Teknik : observasi
2. Bentuk instrumen : lembar observasi
3. Aspek-aspek : Motivasi Internal, Kejujuran, Disiplin, Tanggung

jawab, Santun, Responsif, Proaktif.
4. Instrumen :

LEMBAR OBSERVASI
Mata Pelajaran : Komputer Akuntansi
Kelas/ Semester : XI /1
Materi Pokok : Membuat file data bisnis.

Tanggal R,

Aspek penilaian

No. | Nama Peserta Didik

Motivasi
Kejujuran
Disiplin
Tanggungjawa
Santun
Responsif
Proaktif
Kepedulian
Nilai Rerata

0NN WN =

@)
@l

Petunjuk pensekoran:

Skor4 = selalu, apabila selalu melakukan sesuai pernyataan

Skor3 = sering, apabila sering melakukan sesuai pernyataan dan
kadang-kadang tidak melakukan

Skor2 = kadang-kadang, apabila kadang-kadang melakukan dan
sering tidak melakukan

Skor1 = tidak pernah, apabila tidak pernah melakukan
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®) B. Koghnitif Skills

Evaluasi terhadap kemampuan kognitif.

1. Teknik : Tes;

2. Bentuk instrumen : Uraian.

3. Kisi-kisi :
No. Indikator Nomor soal
1.  Menyiapkan data awal 1,2
2. Membuat daftar akun 3
3. Menyesuaikan pajak 4
4. Meng-entry saldo awal 5
5. Mencatat Kas Keluar 6
6. Mencatat Kas Masuk 7
7. Mencatat entri penyesuaian 8
8. Menampilkan laporan keuangan 9
9. Membuat backup file 10

4. Soal-soal

Soal 1.

Sebutkan minimal 3 (tiga) keuntungan yang bisa diperoleh dengan
adanya komputerisasi data akuntansi menggunakan MYOB Accounting?

Soal 2.

Data apa saja yang perlu diisi dalam menentukan periode akuntansi pada
pembuatan data akuntansi baru pada MYOB Accounting?
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Soal 3

Tentukan nomor kategori akun-akun berikut pada MYOB Accounting?

Expense ...
CostofSales ...
Liability ...
Asset L
Other Income ...
Equity
Ihcome L
Other Expense ............

Soal 4.

Jenis pajak yang mana yang identik dengan PPN (Pajak Pertambahan
Nilai) pada MYOB Accounting?

Soal 5.

Dalam proses pencatatan saldo awal akun pada MYOB Accounting,
terjadi kondisi dimana Amount left to be allocated menunjukkan angka
(minus) — Rp. 550.000 atau (Rp.550.000,-) ? Apa artinya kondisi ini:

Soal 6.

Jelaskan fungsi modul Banking > Spend Money  pada MYOB
Accounting?
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Soal 7.

Jelaskan fungsi modul Banking > Receive Money pada MYOB
Accounting?

Soal 8.

Jelaskan modul yang digunakan untuk mencatat jurnal penyesuaian pada
MYOB Accounting dan data apa sajakah yang harus dipersiapkan?

Soal 9.

Jelaskan menu yang digunakan untuk menampilkan laporan laba-rugi
pada MYOB Accounting dan data apa sajakah yang harus dientri ?

Soal 10.

Jelaskan mengapa perlu dibuat backup file dalam komputerisasi
akuntansi ?
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™) C. Psikomotorik Skills

Evaluasi terhadap kemampuan psikomotorik.

1. Teknik : Tes Praktek
2. Bentuk instrumen : Studi Kasus.
3. Kisi-kisi :

Menyiapkan data awal
Membuat daftar akun
Menyesuaikan pajak
Meng-entry saldo awal
Mencatat Kas Keluar

Mencatat Kas Masuk

Mencatat entri penyesuaian
Menampilkan laporan keuangan
Membuat backup file

PN O AIWIN=
o lo|~N|o|o|s|wind=

4. Soal-soal

Informasi Umum Perusahaan

1. Miss Lisa mendirikan sebuah usaha salon. Salon tersebut diberi nama
“‘LISA BEAUTY SALON” pada tanggal 01 Desember 2010. Salon itu
berada di Pertokoan Blok M Lt.3 A-4, Jakarta Selatan, telepon/fax 021
222 3344.

2. Miss Lisa memutuskan agar setiap penerimaan uang akan disetor ke
bank pada hari yang sama, dan setiap pengeluaran di atas Rp.
1.000.000,- menggunakan cek atas rekening perusahaan pada Bank
BCA.

3. Miss Lisa memutuskan mulai 1 Januari 2013 digunakan komputer
akuntansi menggunakan MYOB Accounting v.18 dan periode akuntansi 1
Januari - 31 Desember yang dibagi dalam 12 periode bulanan.

4. Anda ditunjuk sebagai petugas yang bertanggung jawab di bagian
akuntansi. Tugas anda yaitu :

e Menyiapkan file data bisnis yang diperlukan.

¢ Mengentri data transaksi keuangan setiap harinya

e Menyiapkan laporan keuangan yang diperlukan untuk kepentingan
manajemen
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5. Jasa yang ditawarkan adalah sebagai berikut :

1. | Paket 1 Potong rambut+cuci+blow 200.000,-
2. | Paket2 Potong rambut+cuci+blow+pewarnaan 300.000,-
3. | Paket3 Potong rambut+creambath+blow+vitamin 500.000,-
4. | Paket4 Potong rambut+keriting+pewarnaan 700.000,-
5. | Paket5 Potong rambut+rebounding+pewarnaan 800.000,-
6. | Paket6 Perawatan kulit dan rambut Silver 1.000.000,-
7. Paket 7 Perawatan kulit dan rambut Gold 1.500.000,-
6. Neraca Saldo per 1 Januari 2013
Nama Akun Debet (Rp.) Kredit (Rp.)
BCA Account 60.000.000,-
Petty Cash 5.000.000,-
Office Supplies Inventory 1.250.000,-
Salon Supplies Inventory 10.000.000,-
Prepaid Rent 6.000.000,-
Salon Equipment at Cost 50.000.000,-
SalonEquipment Accum Dep 14.400.000,-
Furniture and Fixtures at Cost 40.000.000,-
Furniture and Fixtures Accum Dep 10.800.000,-
Cash Register at Cost 14.000.000,-
Cash Register Accum Dep 7.200.000,-
Bankcard 5.600.000,-
PPN Collected 5.500.000,-
BCA Loans 10.000.000,-
Lisa’s Capital 132.750.000,-

Total 186.250.000,- 186.250.000,-
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7. Transaksi yang terjadi selama bulan Desember 2013 yaitu :

Tgl No bukti Transaksi
Jan 3 KM-001 Menerima setoran Nona Lisa sebesar Rp
Cash 20.000.000,- sebagai tambahan modal.
Jan 3 KK-001 Pembelian peralatan salon untuk perawatan

Cek-001 rambut sebesar Rp 6.500.000,-

Jan 4 KK-002 Pembelian perlengkapan salon sebesar Rp
Cek-002 4.250.000,- tunai dari Wella

Jan 4 KK-003 Pelunasan BCA Loan sebesar Rp 10.000.000,-
Cek-003 plus bunga 2% Rp. 200.000,-

Jan 5 KM-002 Penerimaan BCA Loan yang baru sebesar Rp
Transfer 50.000.000,-

Jan 5 KM-003 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 6 untuk 3 orang Rp 3.000.000,- plus PPN

10% sebesar Rp. 300.000,-
Jan 6 KM-004 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 7 untuk 2 orang Rp 3.000.000,- plus PPN

10% sebesar Rp. 300.000,-

Jan7 PC-001 Pembayaran petty cash kepada majalah Nova
untuk pemasangan iklan mini selama 20 hari
sebesar Rp 800.000,-

Jan 8 KM-005 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 3 untuk 3 orang Rp 1.500.000,- plus PPN

10% sebesar Rp. 150.000,-
Jan 10 KM-006 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 6 untuk 5 orang Rp 5.000.000,- plus PPN

10% sebesar Rp. 500.000,-
Jan 12 KM-007 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 1 untuk 10 orang Rp 2.000.000,- plus PPN

10% sebesar Rp. 200.000,-

Jan 13 KK-004 Pembayaran PPN Collected ke kantor Pajak
Cek-004 sebesar Rp. 5.500.000,-

Jan 15 KK-005 Pembelian Laptop (Salon Equipment) sebesar Rp.
Cek-005 3.500.000,-
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Tgl No bukti Transaksi

Jan 15 KK-006 Nona Lisa mengambil kas perusahaan untuk
Cek-006 keperluan pribadi Rp 2.000.000,-

Jan 15 KM-008 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 4 untuk 15 orang Rp 10.500.000,- plus PPN

10% sebesar Rp. 1.050.000,-
Jan 15 KM-009 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 7 untuk 1 orang Rp 1.500.000,- plus PPN

10% sebesar Rp. 150.000,-

Jan 16 KK-007 Membayar gaji karyawan untuk periode 2-15
Cek-007 Januari 2013 Rp 1.500.000,00.

Jan 18 KM-010 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 2 untuk 5 orang Rp 1.500.000,- plus PPN
10% sebesar Rp. 150.000,-

Jan 19 KK-008 Pembelian perlengkapan salon sebesar Rp
Cek-008 5.000.000,-

Jan 20 PC-002 Pembayaran petty cash untuk biaya perawatan dan
kebersihan lingkungan seb. Rp 200.000,-

Jan 20 PC-003 Pembayaran petty cash untuk beban:
- Listrik Rp. 500.000,-
- Air Rp. 300.000,-
- Telepon Rp. 800.000,-
- Laundry Rp. 200.000,-

Jan 24 KM-011 Penerimaan pendapatan jasa dari pelanggan:
Cash - Paket 2 untuk 5 orang Rp. 1.500.000,-
- paket 4 untuk 2 orang Rp. 1.400.000,-
- paket 5 untuk 3 orang Rp. 2.400.000,-
- plus PPN 10% sebesar Rp. 530.000,-
Jan 28 KM-012 Penerimaan pendapatan jasa dari pelanggan yaitu
Cash paket 7 untuk 1 orang Rp 1.500.000,- plus PPN

10% sebesar Rp. 150.000,-

Jan 30 KK-009 Pembayaran utang credit card (Bankcard) Des.
Cek-009 2012 sebesar Rp 5.600.000,00.

Jan 31 KK-010 Pembayaran beban gaji karyawan periode 16-31
Cek-010 Januari 2013 sebesar Rp 1.500.000,00.

Jan 31 MM-001 Sisa perlengkapan salon seb. Rp 10.200.000,- Sisa
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Tgl No bukti Transaksi
perlengkapan kantor seb Rp. 500.000,-

Jan 31 MM-002 Sewa dibayar dimuka yang telah menjadi beban
pada bulan ini sebesar Rp 500.000,-

Jan 31 MM-003 Penyusutan aset tetap bulan Januari 2013:

- Salon Equipment sebesar Rp. 400.000,-
- Furniture and Fixtures sebesar Rp. 300.000,-
- Cash Register sebesar Rp. 200.000,-

Jan 31 MM-004 Rekening Koran Bank BCA:

Pembayaran administrasi bank Rp 300.000,00.
Penerimaan bunga bank Rp 700.000,00.
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Lisa Beauty Salon.

Daftar Akun.
Account No. Account Name Header Account Type
10000 Assets H Asset
11000 Current Assets H Asset
11100 Cash On Hand H Asset
11110 BCA Account Bank
11120 Petty Cash Bank
11180 Undeposited Funds Bank
11190 Electronic Clearing Account Bank
11200 Account Receivables (Net) H Asset
11210 Account Receivable Accounts Receivable
11220 Allowance for Doubtful Debts Accounts Receivable
11300 Other Current Assets H Asset
11310 Office Supplies Inventory Other Current Asset
11320 Salon Supplies Inventory Other Current Asset
11330 Prepaid Insurance Other Current Asset
11340 Prepaid Rent Other Current Asset
12000 Fixed Assets H Asset
12100 Salon Equipment H Asset
12110 Salon Equipment at Cost Fixed Asset
12120 Salon Equipment Accum Dep Fixed Asset
12200 Furniture & Fixtures H Asset
12210 Furniture & Fixtures at Cost Fixed Asset
12220 Furniture & Fixtures Accum Fixed Asset
De
12300 Cagh Register H Asset
12310 Cash Register at Cost Fixed Asset
12320 Cash Register Accum Dep Fixed Asset
13000 Other Assets H Asset
13100 Goodwill Other Asset
20000 Liabilities H Liability
21000 Current Liabilities H Liability
21100 Credit Cards H Liability
21110 Bankcard Credit Card
21200 Account Payable Accounts Payable
21310 PPN Collected Other Current Liability
21330 PPN Paid Other Current Liability
21400 Salary Payable Other Current Liability
21600 Customer Deposits Other Current Liability
21700 Other Current Liabilities Other Current Liability
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22000 Long-Term Liabilities H Liability
22100 BCA Loans Long Term Liability
22200 Other Long-Term Liabilities Long Term Liability
30000 Equity H Equity

31100 Lisa's Capital Equity

31200 Lisa 's Drawings Equity

38000 Retained Earnings Equity

39000 Current Year Earnings Equity

39999 Historical Balancing Equity

40000 Income H Income
41000 Service Income Income
45000 Miscellaneous Income Income
50000 Cost of Sales H Cost of Sales
51000 Labour Cost of Sales
60000 Expenses H Expense
61100 Advertising & Promotion Expense
61210 Bank Charges Expense
61400 Depreciation Expense Expense
61500 Discounts H Expense
61510 Discounts Given Expense
61520 Discounts Taken Expense
61600 Dues & Subscriptions Expense
61700 Equipment Rental Expense
61800 Insurance Expense
62100 Laundry Expense
62400 Maintenance & Cleaning Expense
62500 Office Supplies Expense
62600 Salon Supplies Expense
62800 Rent Expense
62900 Repairs Expense
62950 Shrinkage/Spoilage Expense
63010 Staff Amenities Expense
63030 Wages & Salaries Expense
63100 Telephone Expense
63300 Uniforms Expense
63410 Electricity Expense
63430 Water Expense
80000 Other Income H Other Income
81000 Interest Income Other Income
90000 Other Expenses H Other Expense
91000 Interest Expense Other Expense
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“a D. Produk/Benda Kerja Sesuai Kriteria Standa

Kriteria Laporan keuangan yang dihasilkan hendaknya meliputi:
1. Laporan Laba-Rugi (Accrual) untuk periode 2013 yang disusun secara
rinci dengan format multi steps.

2. Laporan Neraca (Standard) per 31 Januari 2013 yang disusun secara
rinci dengan format staffel.

3. Laporan Arus kas untuk periode 1/1/2013 s.d. 31/1/2013 yang disusun
dengan metode tidak langsung

‘a E. Batasan Waktu Yang Telah Ditetapkan

1. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan kognitif
yaitu 2 x Jam Pelajaran @ 45 menit.

2. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan
psikomotor yaitu 4 x Jam Pelajaran @ 45 menit.
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™) F. Kunci Jawaban Koghnitif Skill

1. Jawaban soal untuk kemampuan kognitif:
Jawaban Soal 1

Proses kerja cepat.

Pencegahan kesalahan

Posting jurnal ke buku besar/buku pembantu secara otomatis.
Volume kerja lebih besar

Pencetakan laporan bisa berkali-kali.

Jawaban Soal 2

Current financial year (tahun periode akuntansi).

Last month of financial year (bulan terakhir dari tahun periode).
Conversion month (Bulan konversi)

Number of accounting period (Jumlah periode akuntansi)

Jawaban Soal 3

Expense

Cost of Sales
Liability

Asset

Other Income
Equity

Income

Other Expense

O R~ WO-2DNOILO®

Jawaban Soal 4

Jenis pajak yang identik dengan PPN pada MYOB Accounting:
e GST (Goods and Services Tax) atau
o VAT (Value Added Tax)

Jawaban Soal 5

Amount left to be allocated: - Rp. 550.000,- atau (Rp. 550.000) artinya
bahwa jumlah debet Ilebih kecil Rp. 550.000,- dari jumlah kredit atau
jumlah kredit lebih besar Rp. 550.000,- dari jumlah debet.

Jawaban Soal 6

Modul Banking > Spend Money memberikan fasilitas untuk mencatat
transaksi pembayaran uang tunai melalui akun-akun Cash in Bank/ Petty
Cash/ Bankcard yang tidak ada kaitannya dengan pembelian barang
dagangan.

Jawaban Soal 7

Modul Banking > Receive Money memberikan fasilitas untuk mencatat
transaksi penerimaan uang tunai melalui akun-akun Cash in Bank/ Cash
on Hand yang tidak ada kaitannya dengan penjualan barang dagangan.
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Jawaban Soal 8

Modul yang digunakan untuk mencatat jurnal penyesuaian adalah Account
> Record Journal Entry.

Data yang perlu dipersiapkan adalah nomor dan nama akun-akun yang
didebet beserta jumlahnya dan nomor dan nama akun-akun di kredit
beserta jumlanya.

Jawaban Soal 9

Menu yang digunakan untuk menampilkan laporan Lab-rugi adalah Report
> Index to Report > Tab Account > Profit and Loss [Accrual] atau
menggunakan menu yang ada di bawah Report > Account > Profit and
Loss [Accruall.

Data yang perlu dientri adalah periode akuntansi dari tanggal awal s.d.
tanggal akhir.

Jawaban Soal 10

Backup file dalam komputer akuntansi perlu dibuat untuk menjaga
keutuhan dan integritas data, apabila terjadi kerusakan pada file asli yang
ada di komputer karena akibat terkena virus atau sebab lainnya.
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2. Jawaban soal untuk kemampuan psikomotor
a. Laporan Laba-Rugi:

] report Disply =
To | 3/001/2013 Redisplay Wigwe |F'rint Presview hd

Lisa Salon :‘

Pertokoan Blok M
Lantai 3 A/d Jakarta Selatan

Drated Framm:

Profit & Loss Statement

January 2013

10/02/2014
11:46:00
Income
Semice Income Rp34.800.000,00
Total Income Rp34.800.000,00

Cost of Sales

Gross Profit Rp34.800.000,00
Expenses

Advertising & Promotion Rp&00.000,00

Bank Charges Rp300.000,00

Depreciation Expense Rpa00.000,00

Laundry Rp200.000,00

Maintenance & Cleaning Rp200.000,00

Office Supplies Rp750.000,00

Salon Supplies Rp9.050.000,00

Rent Rp500.000,00

Wages & Salaries Rp3.000.000,00

Telephone Rp&00.000,00

Electricity Rp500.000,00

Water Rp300.000,00
Total Expenses Rp17.300.000,00
Operating Profit Rp17.500.000,00
Other Income

Interest Income Rp700.000,00
Total Other Income Rp700.000,00
Other Expenses

Interest Expense Rp200.000,00
Total Other Expenses Rp200.000,00
Net Profit/ (Loss) Rp18.000.000,00 -

»

7. | |
Print

Help F1 Send To

Gambar: 3. 1 Laporan Laba-rugi
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b. Laporan Neraca

@ Report Display

Az of:

“igw: | Print Preview |

Fedizplay

10/02/2014
11:49:57

Lisa Salon
Pertokoan Blok M
Lantai 3 A/ Jakarta Selatan

Balance Sheet

As of January 2013

Assets
Current Assets

Cash On Hand
BCA Account
Petty Cash

Other Current Assets
Office Supplies Inventory
Salon Supplies Inventary
Prepaid Rent

Fixed Assets

Salon Equipment
Salon Equipment at Cost
Salon Equipment Accum Dep

Furniture & Fixtures
Furniture & Fixtures at Cost
Furniture & Fixtures Accum Dep

Cash Register
Cash Register at Cost
Cash Register Accum Dep

Total Assets

Liabilities
Current Liabilities
PPN Collected
Long-Term Liabilities
BCA Loans
Total Liabilities

Met Assets

Equity
Lisa's Capital
Lisa's Drawings
Current Year Earnings
Total Equity

.
Frrint

7.

Help F1

=3

Send To

Rp123.130.000,00
Rp2.200.000,00

R.p500.000,00
Rp10.200.000,00
Rp5.500.000,00

Rp60.000.000,00
(Rp14.800.000,00)

Rp40.000.000,00
(Rp11.100.000,00)

Rp14.000.000,00

(Rp7.400.000,00)
Rp222.230.000,00

Rp3.480.000,00

Rp50.000.000,00
Rp53.420.000,00

Rp168.750.000,00

Rp152.750.000,00
(Rp2.000.000,00)

Rp18.000.000,00
Rp168.750.000,00

Gambar: 3. 2 Laporan Neraca
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c. Laporan Arus Kas

Report Display EI@
To: | 31/01/2013 Redizplay Wiew: | Print Preview =

Lisa Salon :‘

Pertokoan Blok M
Lantai 3 A/4 Jakarta Selatan

Dated From:

Statement of Cash Flow

January 2013
1010212014
11:51:08

Cash Flow from Operating Activities

MetIncome p18.000.000,00

Office Supplies Inventory Rp750.000,00

Salon Supplies Inventory (Rp200.000,00)

Prepaid Rent Rp500.000,00

Bankcard Rp5.600.000,00)

PPN Collected Rp2.020.000,00)
Met Cash Flows from Operating Activities p11.430.000,00
Cash Flow from Investing Activities

Salon Equipment at Cost p10.000.000,00)

Salon Equipment Accum Dep Rp400.000,00

Furniture & Fixtures Accum Dep Rp300.000,00

Cash Register Accum Dep Rp200.000,00
Met Cash Flows from Investing Activities Rp9.100.000,00)
Cash Flow from Financing Activities

BCALoans p40.000.000,00

Lisa's Capital p20.000.000,00

Lisa’s Drawings Rp2.000.000,00)
Met Cash Flows from Financing Activities p58.000.000,00
Met Increase/Decrease for the period p60.330.000,00
Cash at the Beginning of the period p65.000.000,00
Cash at the End of the period 125.330.000,00

.
K _J >

7. oy W
Help F1 Frrint Send To

Gambar: 3. 3 Laporan Arus Kas
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BAB IV

PENUTUP

Setelah Laporan Keuangan pada akhir Januari diselesaikan dan sudah dibuat
backup file, maka proses akuntansi berikutnya akan diteruskan ke bulan
Februari. Tugas selajutnya adalah melaksanakan pencatatan transaksi bulan
Februari. Untuk itu tidak diperlukan lagi mengentri saldo-saldo awal akun buku
besar atau buku pembantu secara manual seperti yang dilakukan di awal bulan
Januari. Program MYOB akan secara otomatis mengakumulasi jumlah saldo
dengan jumlah penambahan/ pengurangan sebagai akibat dari transaksi bulan
Pebruari. Laporan keuangan yang nantinya akan ditampilkan di akhir Pebruari
adalah hasil akumulasi transaksi dalam dua bulan yaitu transaksi Januari dan
Pebruari. Demikian seterusnya sampai dengan akhir bulan Desember 2013.

Pada akhir bulan Desember 2013 (akhir periode akuntansi) Program MYOB
menyediakan menu untuk menutup semua akun-akun nominal (akun Laba-rugi)
dan akan memulai dengan akun-akun riil atau neraca awal Januari 2014. Menu
ini adalah File > Start a New Year > Start a New Financial Year .

Gambar: 4. 1 Start a New Financial Year
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